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Introduction
Introduction

Welcome to Pacific Timesheet , the premier web timesheet. Pacific Timesheet  allows your
employees to track their time and attendance from a web browser, time clock or cell phone. 
Pacific Timesheet  is available as an online service, or can be hosted on your own server.
Click here for a list of supported browsers and platforms.

Note: This help document is context-sensitive. When you select a page in Pacific
Timesheet and click the Help link at the top of that page, the appropriate help topic will
load.

Click here for a PDF version of this documentation.

Related Topics

 Setup Quick Start
 System Requirements

-o-
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System Requirements
Browser Requirements

Pacific Timesheet is a web-based application and supports the following web browsers:

Supported Browsers

Apple Safari 4.0 or later

Google Chrome 3.0 or later

Microsoft Internet Explorer 7.0 or later

Mozilla Firefox 3.0 or later

Note: This application tries to minimize the use of popup windows as much as possible.
However, there are some areas of the application that by necessity require a popup
window. You therefore may need to unblock popups for this application under certain
circumstances.

Server Requirements

If you are hosting the software yourself, here are the server requirements:

Supported Hardware

Computer and processor PC or Macintosh with Intel Pentium 4-compatible 2 GHz
processor

Memory 2 GB of RAM

Disk space 250 MB of available hard disk space for the program files.
Additional space is needed to store timesheets and other
employee data (see below).

Supported Operating Systems

Microsoft Windows Server 2003, Server 2008, Vista, 7

Linux SUSE, RedHat or any other Linux distribution capable of
running Java 1.5 or later.

Apple Macintosh OS X, any version capable of running Java 1.5 or later.

Supported Databases

Microsoft SQL Server SQL Server 2005, 2008 with Mixed Mode Authentication
(Windows Authentication and SQL Server Authentication)
enabled.

MySQL Version 5.0.22 or later.

Oracle Oracle 9i or later.

In general, hard disk space is related to the number of timesheets written annually. A
timesheet typically requires about 150K of storage. Based on this value the following table
will help you determine the amount of hard disk usage you can expect annually:

Hard Disk Usage

Timesheets Per Year Hard Disk Allocation Per Year

500 75 MB
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5,000 750 MB

10,000 1.5 GB

20,000 3 GB

You can optionally integrate with access devices to record employee time and attendance.
The following devices are supported:

Manufacturer Model

ACTAtek
www.actatek.com

 PIN
 Smart Card
 Fingerprint
 Combination

-o-
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Setup Quick Start
Setup Quick Start

If you are an administrator setting up Pacific Timesheet for the first time you will want to
read this page to familiarize yourself with some basic concepts, and learn how to get
up-and-running quickly. Please note that you can always get detailed information for each
page of the application by clicking the context-sensitive Help link in the upper-right corner.

Step 1. Configure System Settings

The first steps you should take to set up your system are to configure the following global or
system-wide settings:

 Set the default time zone for your employees on the System > General page.
 Specify your work break down structure (WBS) on the System > Work Breakdown

Structure page. For example, one business might track time against customers, projects
and tasks. Another business might track time against clients and jobs.

 Configure timesheet periods appropriate for your payroll or other reporting cycles from
the System > Time Periods page.

Note that you can change the above settings at any time, but doing so after employees start
entering time might be disruptive. 

You may optionally want to do the following before rolling the system out to your
employees:

 Set your list of company holidays from the System > Holidays page.
 Change the wording or terminology used for some labels from the System > Terminology

page.
 Upload your company logo and make other branding changes from the System >

Branding page.
 Configure bill and pay rates from the System > Bill Rates and System > Pay Rates

pages.

Step 2. Configure Timesheet Templates

The System > Templates page is where you configure the data fields that are displayed on
timesheets. You can create any number of different timesheet templates for different needs.
Two sample timesheet templates are provided:

1. The "Attendance Timesheet" template is for attendance-oriented time entry, and
captures daily in/out times and pay codes (e.g. Regular Time, Over Time, etc.).

2. The "Project Timesheet" template is for project or job-oriented time entry, and captures
hours against customers, projects and tasks.

You can use and modify these templates, or create any number of new ones to suit your
needs. When adding employees (described below), you will specify the timesheet template
as part of their profile.

Step 3. Configure Employee Policies

Employee policies allow you to control a variety of timesheet options, such as rounding
rules, leave accruals and over time calculations. You should review the "Standard Policy"
settings on the System > Policies page, then make changes or create new policies as
desired. You can have any number of different employee policies, such as separate policies
for exempt and hourly employees. When adding employees (described below), you will

/timesheet/system/system-edit.do
/timesheet/system/taskoptions-edit.do
/timesheet/system/taskoptions-edit.do
/timesheet/system/timeperiod-list.do
/timesheet/calendar/holiday-list.do
/timesheet/system/terminology-edit.do
/timesheet/system/branding-edit.do
/timesheet/system/branding-edit.do
/timesheet/rate/rateoptions-show.do?type=Bill
/timesheet/rate/rateoptions-show.do?type=Pay
/timesheet/timesheet/template-list.do
/timesheet/policy/policy-list.do
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specify the policy as part of their profile.

Step 4. Configure Pay Codes

The System > Pay Codes page lists the available pay codes. Pay codes are customizable
values that you can use to track different types of work and leave hours. Work pay codes
can include regular time, over time, etc. Leave pay codes can include sick, vacation, etc. 

Work pay codes are often used for tracking overtime. With Pacific Timesheet you have two
choices about how overtime is handled: 

1. You can have your employees select whether their hours are regular time, overtime, etc.
on their timesheet via a pull down menu. To do this you add the Pay Code field to your
timesheet template(s). 

2. You can have overtime be computed automatically by enabling overtime rules for the
employee policy. If you do this you will generally want to remove the Pay Code field
from the timesheet template, as you don't want the employee to enter their overtime
values. You will still be able to report on overtime hours even if there is no Pay Code
field on the timesheet.

Leave pay codes, such as sick and vacation, can have an associated balance. Any hours an
employee enters on their timesheet for these pay codes will automatically have an
equivalent amount deducted from their balance. Rules for whether balances are allowed to
go negative, as well as automatic accruals, are configured by editing the balance rules on
the appropriate employee policies.

Step 5. Add Projects/Tasks

Depending upon your work breakdown structure, you may need to visit the Tasks page and
create lists of customers, projects, tasks, jobs, etc. 

Note that you can also import tasks, etc. in bulk from an external system via import files.
The Importing/Exporting help topic has more details.

Step 6. Add Employees

The Employees page is where you add and edit your list of employees. Make sure the
appropriate policy and timesheet template is selected for each employee. 

You will also want to select the appropriate permission level for each employee, for example
"Employee" or "Manager". Permission levels control what access to the timesheet system
the employee will have, as well as giving fine-grained control over some aspects of time
entry. You can modify the permissions from the System > Security page, as well as create
entirely new permission levels.

Note that you can also import employees in bulk from an external system via import files.
The Importing/Exporting help topic has more details.

Employee groups can be created from the Employees > Group page. Employee groups can
represent a variety of different logical entities, such as cost centers, permission groups and
construction crews.

Step 7. Miscellaneous

Here are a few other topics worth being aware of:

 A variety of reports are available, and can be customized for your requirements. Pacific
Timesheet allows you to publish your custom reports and make them available to any

/timesheet/paycode/paycode-list.do
/timesheet/task/task-list.do
/timesheet/user/user-list.do
/timesheet/system/security-show.do
/timesheet/user/group-list.do
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suitable permission level. For instance, you can make a customized billing report
available only to managers, or an hours summary report available to employees.

 You may want to modify the audit level if you have stringent auditing requirements,
such as DCAA. You can do this from the System > General page.

 Most objects can be customized to add additional data fields. For instance, you might
want to add an employee photograph to the employee object, or a location pick list to
the timesheet template. Choose the "Manage Custom Fields" menu option in the pop-up
options menu in the upper-right corner of most lists of objects. 

Please let us know if we can help you by contacting your sales representative or visiting our
support site at https://www.pacifictimesheet.com/. Thank you for using Pacific Timesheet!

-o-

 

/timesheet/system/system-edit.do
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Home
Home

The Home page is where you manage your employee account and preferences. It also
provides a "dashboard" where you can quickly view your balances, leave requests, company
announcements and other information.

The Calendar shows recent and upcoming holidays and leave requests.

Related Topics

 Change Password
 My Account
 Preferences
 Leave Requests
 Holidays
 Announcements

-o-
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Change Password
Change Password

You can change your password at any time from this page. For security reasons you will
need to provide your old password.

Note: Passwords are case-sensitive, and can never be the same as your login name. There
may be other constraints, such as being a minimum number of characters in length,
depending upon how your application administrator has configured the password security
settings.

-o-
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My Account
My Account

The My Account page lets you view and change your employee profile. Your employee profile
has the following properties:

Property Description

Login Name Your login name, which can only be changed by an employee
manager or administrator.

First Name Your first name, up to 80 characters.

Last Name Your last name. This field is required and can be up to 80 characters.

ID Your employee ID, which can only be changed by an employee
manager or administrator.

Status Your account status, either Active, Inactive or Locked. Accounts can
become locked after too many unsuccessful login attempts. This can
only be changed by an employee manager or administrator.

Job Title Your job title, which can only be changed by an employee manager or
administrator.

Reporting Group Your primary or reporting group. This property may be renamed by
your application administrator to something more appropriate for your
organization, such as Division, Cost Center or Charge Code. This can
only be changed by an employee manager or administrator.

Email Your email address, up to 80 characters.

Phone Your phone number, up to 40 characters.

Mobile Your mobile phone number, up to 40 characters.

Fax Your fax number, up to 40 characters.

-o-

 



p14

© 2000-2023, Pacific Timesheet

Preferences
Preferences

The Preferences page lets you view and change your application preferences. This includes
the following properties:

Property Description

Timesheet Memory Allows you to specify whether rows and hours are carried forward
from the previous timesheet when a new timesheet is created.
Options include:
None New timesheets will have no rows or hours carried

forward from the previous time period.

Rows New timesheets will have the same rows as the
timesheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours New timesheets will have the same rows and hours
as the timesheet for the previous period. Only work
hours are carried forward - leave (or paid time off)
rows will carry forward, but not the hours.

Note that you can hide this option from employees
by turning off the "Can copy previous timesheet
hours" timesheet permission for the employee's
permission level. See the Permission Levels topic
for more information.

Hours Format The choice of how you enter hours on your timesheet, either decimal
format (for example 3.5) or hours:minutes (for example 3:30).

Tab Direction The direction the selection moves when you type the tab key on your
timesheet, either vertical or horizontal.

Remember Last The number of most recently used clients, projects, etc. to remember
(25 max). To erase the list of most recently used items click the 
Clear List button.

Locale Your locale determines the following:
 The language displayed, e.g. English, French, Chinese, etc.
 The formatting of dates and numbers. If you choose a locale that

has AM/PM as part of its time format, you have the option of
overriding that by choosing the 24 hour time format (sometimes
called military time).

 The list of company holidays for the selected location

Time Zone Your time zone.

Search Results The number of rows to return per page of results, such as when
searching for employees, timesheets, etc.

Default Tab The tab to select upon logging into the application.

Export Format The file format for exporting timesheet data, employee lists, etc.
 CSV is a text format compatible with most systems (including

Microsoft Excel), and is the default value for employees.
 MS Excel is the Microsoft Excel format, a binary format generally

only compatible with Microsoft Excel. 
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Announcements
Announcements

Announcements are messages displayed to every employee who logs into the application.
You can use this feature to alert your employees of special events, such as maintenance
down time, or to company policies such as when timesheets are due.

Note: Text formatting is standard HTML. If your browser supports it, you will see a
WYSIWYG editor when editing the announcement text. You can click the "Source" button
on the editor tool bar to view and edit the HTML source. The maximum length of the HTML
is limited to 4000 characters (2000 characters if using Oracle for the database), and if you
exceed this amount the text will be truncated.

-o-
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My Timesheet
My Timesheet

The My Timesheet page is where you enter hours into your timesheet. By default you will be
taken to the timesheet for the current time period. You can change the time period by
clicking the Time Period link or clicking the next/previous buttons beside the Time Period
link. Time periods are determined by your application administrator, and usually correspond
to payroll or other company time periods.

A timesheet has a status, which can be Open, Submitted, Approved or Rejected. The
Open status means you can enter hours and make other edits to your timesheet. When you
have finished filling out your timesheet you should click the Submit button, which changes
your timesheet status to Submitted. Submitted timesheets cannot be edited.

Submitted timesheets can be reviewed and approved by an employee manager. If the
manager finds a problem with the timesheet they might reject it, which will revert the
timesheet back to its Open status, allowing you to correct any problem.

If your timesheet status is Open you can delete it and start over with a new one by clicking
the Delete button.

Timesheet Views

You can view your time entries using a Day View, Week View, Summary View or
Printable View. You can switch between views at any time, and changing your view will
save any changes you have made to your timesheet automatically. The Day View allows you
to view and enter time on a day-by-day basis. The Week View allows you to view and enter
time on a weekly basis (this view is not available if you are entering start times with your
time entries). The Summary View is a read-only view that lists all of the time entries for the
entire time period. The Printable View will generate a PDF version of the Summary View,
which is suitable for printing and signing by your manager.

Timesheet Rows

There are two types of time entries you can add to your timesheet: Work and Leave (note
that the terminology for these two types might have been changed by your application
administrator). Work time entries are added by clicking the Add Work button. Work time
entries generally require entering a Task or other description of the work done.

Leave time entries are added by clicking the Add Leave button. Leave time entries
generally require you select the type of leave, for example Vacation.

You can delete one or more rows at a time by checking the desired rows on your timesheet
and then clicking the Delete Row button.

If you are entering start times then rows will be ordered from earliest to latest. If you are
not entering start times then you can order the rows as you like by checking the desired
rows and then clicking the Move Up or Move Down buttons.

Choosing Tasks

Your timesheet may be configured for you to choose a Task, Project or other additional
properties for each time entry. The exact set of properties you need to choose will depend
on how your application administrator has set up the work breakdown structure (WBS) for
your organization. Choosing a Task, Project, etc. will pop up the Task browser, which allows
you to choose any level of the WBS.

You may narrow down the list of tasks shown in the browser by entering a query and
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clicking the Search button. You can refine your query using the '*' character. For instance,
to return all tasks starting with the letter 't' enter the query 't*'. To find all tasks ending
with the letter 't' enter '*t'. Searching for '*t*' is the same as just searching for 't' - it will
return any task with the letter 't' in it.

Timesheet Notes

The Notes field at the bottom of the timesheet allows you to enter notes or comments
about the timesheet. This is commonly used to inform your manager or approver about
anything special regarding your timesheet. The maximum size of a note is 4000 characters.

Other Timesheet Commands

There is a popup menu of additional Timesheet commands in the upper-right corner of the
timesheet. These commands include:

Copy Previous Timesheet will copy the rows and hours entered on the previous
timesheet. This command will only be available if the current timesheet has not been
submitted and has no hours, to avoid inadvertently overwriting your timesheet.

Copy Previous Rows will copy the rows (but not the hours) from the previous timesheet.
This command will only be available if the current timesheet has not been submitted and
has no hours, to avoid inadvertently overwriting your timesheet.

Copy Previous Day will copy the time entries for the previous day to the current day. This
command will only be available when in the Day View and if the current timesheet has not
been submitted and the day has no hours. If you choose this command for a Monday it will
move back to Friday to look for previous time entries if none are found on the weekend.

Delete Timesheet will delete the current timesheet. This command is only available if the
current timesheet has not been submitted.

-o-
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My Expense Sheets
My Expense Sheets

The My Expenses – Expense Sheets page is where you enter expense items into your
Expense Sheets. To navigate to expense sheets submitted within defined date ranges by
selecting a time period in the Time Period pick list, or clicking the next/previous buttons
when on the details page of any expense sheet. You can also select a start and finish date
when searching for expense sheets.

An Expense Sheet has a status, which can be Open, Submitted, Approved or Rejected.
The Open status means you can enter expense items and make other edits to your Expense
Sheets. When you have finished filling out your Expense Sheets you should click the Submit
button, which changes your Expense Sheets status to Submitted. Submitted Expense
Sheets cannot be edited.

Submitted Expense Sheets can be reviewed and approved by an employee manager. If the
manager finds a problem with an Expense Sheet they might reject it, which will revert the
Expense Sheet back to its Open status, allowing you to correct any problem.

If your Expense Sheet status is Open you can delete it and start over with a new one by
clicking the Delete button.

Expense Sheet Views

You can view your expense entries in an expense sheet which lists each expense in the
expense sheet vertically. There is also a Printable View that can be found using the tools
button which can be suitable for printing and signing by your manager if a hardcopy
expense sheet is required.

Expense Sheet Rows

Expense entries are added by clicking the Add Expense button. You might be required to
enter certain required fields such as client or project within the expense entry.

You can delete one or more rows at a time by checking the desired rows on your Expense
Sheets and then clicking the minus or Delete Row button found on the far right of each
expense entry row. You can also reorder expense entries by clicking the handles on the far left of each
row and dragging it into a different position on the expense sheet.

Choosing Tasks

Your Expense Sheets may be configured for you to choose a Task, Project or other
additional properties for each time entry. The exact set of properties you need to choose will
depend on how your application administrator has set up the work breakdown structure
(WBS) for your organization. Choosing a Task, Project, etc. will pop up the Task browser,
which allows you to choose any level of the WBS.

You may narrow down the list of tasks shown in the browser by entering a query and
clicking the Search button. You can refine your query using the '*' character. For instance,
to return all tasks starting with the letter 't' enter the query 't*'. To find all tasks ending
with the letter 't' enter '*t'. Searching for '*t*' is the same as just searching for 't' - it will
return any task with the letter 't' in it.

Expense Sheet Summary Fields

Expense Sheet: Employee Name

Each expense sheet will have a link to the employee’s mini-profile that contains key setup
information about that employee.
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Sheet Description

The Sheet Description field, a required field, is entered at the top of the Expense Sheet,
allows you to provide a useful description for the expense sheet that will distinguish it from
other expense sheets.

Total Reimbursement

The Total Reimbursement field is a required field when multicurrency is enabled. Below
the Total Reimbursement heading is a total reimbursement value. This value is link with the
format of CURRENCY value. For example, $1,500.00 in Canadian Dollars will appear as
CAD1,500.00. You can select a different reimbursement currency by clicking on this link and
selecting a different currency from the currency pick list.  This list of currencies is managed
by your system administrator. If a reimbursement currency, that you need, is missing,
contact your system administrator for help. 

Notes

The Notes field is where you complete a detailed note for approvers regarding the expense
sheet.  

ID

The ID field is a read-only system-generated unique expense sheet ID used to track your
expense sheet from creation through to final approval.  

Sheet Status

The Sheet Status shows the current state of the expense sheet. If the expense is
unsubmitted, an unlocked icon will appear next to Unsubmitted. When the expense is
submitted there will be locked icon next to Submitted. As managers with different approval
levels approve the expense sheet, check marks will appear to the right of the lock icon.  

Expense Sheet Row Fields

Row Number (#)

The Row Number column indicates the row number for each entry. Approvers can refer
specifically to these row numbers when rejecting expense sheets.
  
Date

The Date field, a required field, refers to the date during which the expense was incurred.  

Sheet

The Sheet field, a required field, refers to the date during which the expense was incurred.
 

Expense

The Expense field, which is a required field, is a pick list where you select the expense type
for the expense entry. The expense lookup dialog allows you to search by typing in a search
box which will automatically return matching expense types by name, ID or description.
Expense types will be memorized in your expense field pick list for future use.
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Description

The Description field is to provide a detailed description of the expense entry.

Quantity

The Quantity field is meant for expense types, such as miles, that require a quantity value.
For miles expense type, a set unit amount will calculate the total amount as follows:
Quantity X Unit Amount = Amount. Where the quantity is empty, the system will assume a
quantity of 1.0, and will allow you to enter and save the full amount in the Amount field.    
  
Unit Amount

The Unit Amount field is meant for expense types, such as miles, that require a unit
amount value that is multiplied times a quantity value. The unit amount is set in the
expense type profile under unit amount.

Expense Item Currency

The Expense Item Currency field is selected from a pick list of currency values. The
expense item currency value will be used to convert the expense item amount to the
reimbursement currency amount. 

Amount

The Amount field is the amount of the expense entry. The amount is entered in the
expense currency.

Receipt Image

The Receipt Image allows you to attach an image of the receipt for the expense entry.

Reimbursable

The reimbursable field is a check box that flags the expense entry as reimbursable.

Payment Method

The Payment Method field is a pick list of payment method values such as
“Out-of-Pocket,” Visa or American Express.

ID

The ID field is a read-only system-generated unique expense entry ID used to track your
expense entry.

Reimburse Amount

The Reimburse Amount field shows the system-calculated reimbursement amount for this
expense entry.  You can override this amount by selecting the Override check box.

Exchange Rate

The Exchange Rate field shows the system-calculated exchange rate for this expense
entry.  You can override this amount by selecting the Override check box.

Billable
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The Billable field is check box that flags an expense entry as billable.

Other Expense Sheet Commands

There is a popup menu of additional Expense Sheets commands in the upper-right corner of
the Expense Sheets. These commands include:

Copy Previous Expense Sheets will copy the rows and expense items entered on the
previous Expense Sheets. This command will only be available if the current Expense Sheets
has not been submitted and has no expense items, to avoid inadvertently overwriting your
Expense Sheets.

Copy Previous Rows will copy the rows (but not the expense items) from the previous
Expense Sheets. This command will only be available if the current Expense Sheets has not
been submitted and has no expense items, to avoid inadvertently overwriting your Expense
Sheets.

Copy Previous Day will copy the time entries for the previous day to the current day. This
command will only be available when in the Day View and if the current Expense Sheets has
not been submitted and the day has no expense items. If you choose this command for a
Monday it will move back to Friday to look for previous time entries if none are found on the
weekend.

Delete Expense Sheets will delete the current Expense Sheets. This command is only
available if the current Expense Sheets has not been submitted.

-o-
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My Assets
My Assets

The "My Assets" page allows you to record non-labor types of data such as materials,
equipment and other types of assets you use as part of your project or job work. As Pacific
Timesheet allows asset tracking to be configured in many different ways (for example you
may be recording materials, equipment and expenses) the specifics of the "My Assets" page
will depend upon your organization's configuration of Pacific Timesheet.

Note that the types of assets that can be entered on the "My Assets" page is controlled in
part by the timesheet template that is assigned to you by your application administrator.
For instance, your system may be configured for both Materials and Equipment, but if your
timesheet template only has Materials enabled then the "My Assets" page would instead be
"My Materials", and you would only be able to enter the materials you used.

-o-
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Crew Timesheet
Crew Timesheet

Crew timesheets allow the daily entry of time for groups (crews) of employees. Crew
timesheets are a convenient and efficient way to enter time for crews of employees that do
not record their own time, such as field workers on construction sites.

Note: You can change the terminology for 'Crew' to suit your organization's needs. The 
Terminology topic has more information.

Crew timesheets are accessed from the "Crew Timesheet" tab. To access this tab crew
timesheets they must first be enabled from the System > General > System Options page.
In addition, you must be a timesheet manager or approver for at least one group, and have
the 'Can View Crew Timesheet' option enabled in your employee permission level.

Configuring Crew Timesheets

The fields that appear on the crew timesheet (e.g. Hours, Project, Task, etc.) come from the
timesheet template of the employee that appears first in the crew. To add employees to the
crew simply click the "Add Employee" link at the bottom of the list of employees, then
choose the appropriate employee(s) to add. You can also add employees to the crew by
going to the Employees > Groups page and configuring the list of employees for each crew
(group).

If you are an administrator (that is, you can edit timesheet templates on the System >
Templates page), then you will be able to alter they layout of the crew timesheet. To do
this, click the "More" menu button (the triangle icon in the upper-right corner of the crew
timesheet) on the Crew Timesheet page, then click the "Timesheet Options" link. You will
have access to the following layout settings:

Property Description

Day Fields Choose which fields from the timesheet template should appear at the
top of the crew timesheet. Day fields values apply to every row and
column of the crew timesheet for the selected date.

Column Fields Choose which fields from the timesheet template should appear above
each column where the hours are entered. Column field values apply
to every row in the column.

Row Fields Any remaining fields that are not selected as day or column fields are
considered row fields, and will show up on each row for each
employee.

Show Employee ID Check this option if you want to display the Employee ID column next
to the Employee column in the layout. Note that even if not checked,
the user can always view an employee's ID and other properties by
clicking the employee's name in the crew timesheet.

Employee Grouping Use this option to group certain types of employees at the top of the
list of employees on the crew timesheet. For instance, you might want
employees with the Permission Level of 'Manager' to always be at the
top of the list. Another example is to group employees with the Policy
'Full Time' at the top of the list, so that 'Part Time' employees sort
below them (note that these policy names are not built into the
product and are just examples).
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Blank Rows If you have one or more asset types enabled for this crew timesheet
template then you can specify whether a blank row is shown for each
employee in the crew if no data has been entered.  For instance, a
Materials tab might not associate entries with employees and would
not want a blank row for each employee.  However, an Equipment tab
might want a row for each employee in the crew as equipment usage
would be associated with a crew member.

Tab Direction You can choose whether the tab key will take you to the next column
(horizontal) or to the next row (vertical).

Remember Last This option will determine how many previously selected projects,
tasks, etc. will be remembered for easy access.

Crew Parent Field If you have a lot of crews you may want to organize them into
different categories or types. For instance, you might create a group
custom field named "Region" and specify a geographic region for each
crew. Specify the "Region" field in this example for the crew parent
field in order to make browsing for crews more convenient.

Crew Approval Kiosk

You can access a special "kiosk" version of the Pacific Timesheet web interface that provides
a streamlined or simplified crew timesheet approval page. From the Crew Timesheet click
the "more" menu (the triangle in the upper-right corner of the page) and select the "Crew
Approval Kiosk" option. The Crew Approval Kiosk gives you a "read-only" report of the crew
timesheet data in either weekly or daily format, and allows you to submit, approve or reject
the data, depending upon your permissions.

You can provide your clients with the link to this page (e.g.
http://someco.pacifictimesheet.com/timesheet/kiosk/crew-approval.do) to allow them to
review and approve timesheet data. You will need to provide them with a Pacific Timesheet
employee account so that they can log in. This account should have very limited
permissions, e.g. only the ability to approve timesheets, and no timesheet template. Your
application specialist can assist you with setting up such client access accounts.

-o-
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Crew Dashboard
Crew Dashboard

The Crew Dashboard page gives you a summary of the status of all crews (groups) you are
permitted to access, showing such information as the number of hours entered for each
crew, along with their submission and approval status. You can select a Day view or a
Week view, and any time period. You can also filter the dashboard to only show crews with
particular names or IDs by clicking on the Filter button (note that if you have additional
text custom fields defined for groups those will show in the filter dialog, too).

Each row on the dashboard shows configurable (see below) status information, along with
the ability to click on the row and jump directly to the crew timesheet data entry page. 

Note: If you jump to a crew timesheet (by clicking a crew's hours or status on the
dashboard) and make changes to the crew, then click back to the dashboard, you may
need to refresh the dashboard in order for the changes to be shown. This can be done
either by the Tools > Refresh link or the Refresh button on the right of each dashboard
row (preferred, as this updates just the one row).

Crew Dashboard Options

Clicking the Options link under the Tools menu allows you to control the following
properties of the dashboard (some of these settings are only available to system
administrators, as noted in the descriptions below):

Property Description

Week Start You can select which day of the week is considered the first day, e.g.
Monday. This is used for the Week View only. This property only
applies to your account - it will not affect other users accessing the
dashboard.

Search Results You can adjust the maximum number of crews/rows to display on one
page of the dashboard. This property only applies to your account - it
will not affect other users accessing the dashboard.

Crew Fields You can specify which crew/group fields are displayed in the
dashboard. For example, you may want to show the ID of the crew
along with its name. Any text custom fields created for groups will
also be available to show. 

This is a global setting and affects all users who access the dashboard.
As such, this property is only available to administrators.

There are 2 special fields that bear describing. The 
Manager/Approver field will provide a popup link on the dashboard
that shows the list of users that are assigned as editors/approvers for
each crew. This is useful if you need to contact someone regarding the
status of a crew's time entry. The Employees field gives a count of
the number of employees assigned to the crew. As crew membership
changes over time, it will take into account the actual employees with
time when showing past timesheets.

Hours Format You can specify the type of hours that are displayed on the dashboard.
For instance, you may want to break out leave hours from work hours,
thus you would choose "Work Hours / Leave Hours". 

This is a global setting and affects all users who access the dashboard.
As such, this property is only available to administrators.
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Managing Timesheets
Managing Timesheets

Employees can be given permission to manage other employee's timesheets. A timesheet
manager can view, edit and even delete timesheets, depending upon their permission level.
Any employee whose Permission Level allows timesheet management (for example
Administrator or Manager) can manage timesheets and will see the  Timesheets tab. If you
do not see the Timesheets tab then you have not been given a Permission Level with
timesheet management permissions. You can check an employee's Permission Level from
the Employees tab.

If the employee's permission level allows only limited timesheet management then the
employee will need to be added to the permission list for one or more employee groups.
This can be done by clicking the Groups link under the Employees tab, then clicking one of
the groups in the list. In the Permissions section for the group click the Edit button and
add the employee to the permission list with the appropriate permission level. The Groups
topic has more information.

Note: You can use timesheet management permissions to create "time keepers" -
employees with the ability to enter time for other employees. This avoids the need to log
in as another user in order to fill out their timesheet. If implementing time keepers it is
recommended that you create a new Permission Level with only the minimum required
timesheet permissions such as manage, edit and create. The Permission Levels topic has
more information.

Timesheet Lookup

To list employee timesheets click the Timesheets tab, enter an appropriate Start date,
then click the Search button. You can optionally enter a Finish date and Status in order to
narrow down the list of returned timesheets. 

If you do not find any timesheets then you may have only limited timesheet management
permissions. As mentioned above, you may need to be added to the permission list for one
or more employee groups.

Clicking a Time Period link in the list will load that employee's timesheet. Depending upon
your permission level, you may be able to edit or even delete this timesheet.

Exporting Timesheets

If your permission level allows it you can export the list of timesheets by clicking the popup
menu in the upper right of the list and then clicking the Export List link. This will export
the timesheet status information as displayed in the list to your local computer, in
comma-separated value (CSV) format. This file can then be opened in Microsoft Excel or
other applications that support the CSV format. You can optionally change this to Microsoft
Excel's native format (XLS) by clicking the Preferences link on the Home tab.

Clicking the Export Timesheet Data link will download the time entries for each timesheet
in the list as a file that you can save on your local computer. This is useful for exporting
time entries to external systems such as Payroll processing applications. You can optionally 
mark time entries as being exported, so that you can avoid re-exporting the same data.
Once a timesheet has been marked as exported it cannot be unsubmitted (unlocked) for
re-editing. You will need to make corrections to the timesheet by clicking the "Add
Correction" button. This is a safeguard to avoid modifying previously exported time entries.
Note that administrators (those with the "Can Manage All" timesheet permission) can
bypass this restriction and still unsubmit a previously exported timesheet, if the need
arises.
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Note that only submitted (locked) timesheets can be marked as exported.

Another option for getting access to timesheet data is to run a Timesheet Details report.
This report can be customized to only output the fields you require, and can be downloaded
in a number of formats, including Microsoft Excel. The Reports topic has more information.

Importing Timesheets

If your permission level allows it you can import timesheet data by clicking the popup menu
in the upper right of the list and then clicking the Import Timesheet Data link. The
Importing/Exporting topic has more information.

Printing Timesheets

The 'Print Timesheet' option in the popup menu in the upper right corner of the timesheet
list allows you to download a PDF hard copy of all of the timesheets in the list. This is useful
if you need to print out multiple timesheets for signing, for instance. Note that, rather than
printing the entire list, you can print selected timesheets by clicking the checkbox on each
row before selecting the 'Print Timesheets' option.

You can also print individual timesheets by clicking the time period link in the timesheet list,
then clicking the 'Print' view button in the upper-right corner of the timesheet. This will
download a PDF version of the timesheet suitable for printing.

-o-
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Time Entry Corrections
Time Entry Corrections

Administrators and managers with the ability to edit timesheets may add corrective or
adjustment time entries to a timesheet that has been previously submitted or approved.
Once a timesheet has been submitted (locked) an "Add Correction" button will appear on
the timesheet. This allows you to make a change to the timesheet without unsubmitting it
first. This is necessary in instances where you only want to resend correction time entries
(either with negative or positive hours) to your payroll or billing systems.

To make a correction, locate the submitted or approved timesheet, switch to either the Day,
Week or Summary view, then click the "Add Correction" button. You will be presented with a
dialog in which you can enter properties for the corrective time entry, such as the pay code,
project, task and hours. If you want to make a change to an existing time entry, select the
time entry row before clicking the "Add Correction" button, and all of the fields will be
pre-filled. 

You can enter negative hours in a correction time entry in order to subtract hours from a
previous entry. For instance, in order to subtract 2 hours from a previous time entry, you
would select the previous time entry, click the "Add Correction" button, then enter -2 in the
hours field. When you click OK you will see the new negative time entry on the timesheet.

After adding correction time entries to a timesheet, any export flags for the timesheet will
be cleared. In this way you will be able to re-export the timesheet and send the correction
time entries to your payroll system. Adding a time entry correction to a timesheet will not
affect other time entries on that timesheet, making it easy to export only the corrections to
your payroll or billing systems.

-o-
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Approvals
Approvals

Pacific Timesheet has several flexible options for approving your employee's time. In
addition to allowing multiple approval levels, you can approve employee time in several
different formats.

Note: Leave requests are approved from the Leave Requests tab. See the Leave Requests
topic for more information.

Timesheet Approval

Timesheet approval is the most commonly used type of approval, and is especially useful for
payroll and human resources applications. With timesheet approval you can review and
approve employee time for entire time periods. You can also review and approve (or reject)
individual line items or entries within a period. Refer to the Approving Timesheets topic for
more information.

Project Time Approval

Project time approval allows project managers to review and approve (or reject) employee
time recorded for specific projects. Refer to the Approving Project Time topic for more
information.

Crew Time Approval

Crew time approval allows job supervisors and managers to review and approve (or reject)
time entered for crews of workers. Refer to the Approving Crew Time topic for more
information.

-o-
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Approving Timesheets
Approving Timesheets

Submitted timesheets can be electronically signed by an employee's approver. An employee
can have a Primary Approver and a Backup Approver. Approvers are assigned to an
employee from the Employee Details page. Note that to be an approver the employee must
have a Permission Level such as Administrator or Manager with the "approve" timesheet
permission checked. If you do not see the Approval tab then your permission level does not
have the "approve" timesheet permission checked.

A backup approver has the same permissions as a primary approver, but will not be sent
any approval-related email notices. The Notices topic has more information.

Timesheet Lookup

To list employee timesheets click the Approval tab, enter an appropriate Start date, then
click the Search button. You can optionally enter a Finish date and Status in order to
narrow down the list of returned timesheets. If you do not find any timesheets no matter
what search criteria you use then you may not be assigned to any employees as an
approver.

Administrators (or anyone with "Can Approve All" timesheet permission) can view and
approve all timesheets. Managers with limited permissions ("Can Approve Limited"
timesheet permission) will have a restricted list where they can only see timesheets for 1)
employees that they are a primary or backup approver for, or 2) employees in groups they
are assigned to with a permission level that allows timesheet approval.

Timesheet Approval/Rejection

Timesheets in the list that are submitted (pending approval) can be approved by checking
the checkbox in the Approved column. Then click the Save button to save the approval
change. 

You can approve individual time entries (line items) by clicking the Time Period link in the
timesheet list. This allows you to view the timesheet details and approve each row
individually. When all time entries are approved then the entire timesheet is considered
approved.

When viewing the individual time entries you have the option of rejecting any of them, and
thereby rejecting the timesheet. To reject a time entry check the Rejected checkbox for
the appropriate time entry, enter a Reject Reason at the bottom of the page, then click
the OK button to save the changes. A rejected timesheet is un-submitted and sent back to
the employee for correction.

Approval Options

You can customize which time entry fields are displayed in the timesheet details page by
clicking the popup menu in the upper-right corner and choosing Options. The Timesheet
Approval Options page lets you customize which timesheet fields are displayed in the
timesheet approval page. For a detailed description of the various timesheet fields refer to
the Templates topic.

Approval Levels

Your system can be configured to have mulitple approval levels (including zero levels, for
organizations that don't need timesheet approval). This is covered more fully in the 
Approval Levels topic.
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Crew Time Approval

An alternative to approving timesheets is to use the Crew Time Approval page. This is more
appropriate for construction and field service applications where you are doing daily time
approval.

Exporting Timesheets

If your permission level allows it you can export the list of timesheets by clicking the popup
menu in the upper right of the list and then clicking the Export List link. This will export
the timesheet status information as displayed in the list to your local computer, in
comma-separated value (CSV) format. This file can then be opened in Microsoft Excel or
other applications that support the CSV format. You can optionally change this to Microsoft
Excel's native format (XLS) by clicking the Preferences link on the Home tab.

Clicking the Export Timesheet Data link will download the time entries for each timesheet
in the list as a file that you can save on your local computer. This is useful for exporting
time entries to external systems such as Payroll processing applications. You can optionally 
mark time entries as being exported, so that you can avoid re-exporting the same data.
Once a timesheet has been marked as exported it cannot be unsubmitted (unlocked) for
re-editing. You will need to make corrections to the timesheet by clicking the "Add
Correction" button. This is a safeguard to avoid modifying previously exported time entries.
Note that administrators (those with the "Can Manage All" timesheet permission) can
bypass this restriction and still unsubmit a previously exported timesheet, if the need
arises.

Note that only submitted (locked) timesheets can be marked as exported.

Another option for getting access to timesheet data is to run a Timesheet Details report.
This report can be customized to only output the fields you require, and can be downloaded
in a number of formats, including Microsoft Excel. The Reports topic has more information.

Importing Timesheets

If your permission level allows it you can import timesheet data by clicking the popup menu
in the upper right of the list and then clicking the Import Timesheet Data link. The
Importing/Exporting topic has more information.

Printing Timesheets

The 'Print Timesheet' option in the popup menu in the upper right corner of the timesheet
list allows you to download a PDF hard copy of all of the timesheets in the list. This is useful
if you need to print out multiple timesheets for signing, for instance. Note that, rather than
printing the entire list, you can print selected timesheets by clicking the checkbox on each
row before selecting the 'Print Timesheets' option.

You can also print individual timesheets by clicking the time period link in the timesheet list,
then clicking the 'Print' view button in the upper-right corner of the timesheet. This will
download a PDF version of the timesheet suitable for printing.

-o-
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Approving Project Time
Approving Project Time

Project time approval allows project managers to review and approve employee time by
project rather than by timesheet. You can set up permissions such that project approvers
only see projects they are allowed to approve.

Enabling Project Time Approval

You enable project time approval from the System > Approval Levels page. On each
approval level check the "Project" checkbox if that level is applicable for project approval in
your organization.  If at least one "Project" checkbox is checked then you will be able to
access the Approvals > Project Time Approvals page.

Enabling project time approval will not automatically grant employees permission to approve
projects. You still need to go to the System > Security page and modify or add permission
levels to enable the "Can approve" project permission. You can specify either "Can approve
all" or "Can approve limited" project permission. Any project approver with the "Can approve
limited" project permission will need to be assigned permission to each appropriate project.
This is done by going to the Tasks > Projects > Permissions page and adding the
employee to each appropriate project.

Project Time Approval Process

Click the Approvals tab. If you have "Can approve" permission on both Timesheets and
Projects you will see two links in the area below the Approvals tab: "Timesheet Approvals"
and "Project Time Approvals". Click the "Project Time Approvals" link. If you only have "Can
approve" permission for Projects (that is, you don't have the "Can approve" permission for
timesheets) then you will be taken directly to the Project Time Approvals page when clicking
the Approvals tab.

The Project Time Approvals page will list summary project time data, organized by
project and employee. This gives you a dashboard overview of project time. You can narrow
or filter the project time shown by adjusting the following project lookup options:

Property Description

Time Period The time period for reviewing and approving project time data.
Generally you will choose a prior timesheet period, e.g. "Previous
Week" if using weekly timesheet periods. For convenience, the last
value selected will be recalled the next time this page is accessed.

Time Entry Status The approval status filter for the data being reviewed. Possible
values are:
 Any: No filtering applied.
 Open: Only show unsubmitted project time.
 Pending Approval: Only show submitted project time that is not

approved.
 Approved: Only show project time that is approved.
 Rejected: Only show project time that is rejected.

Project If a project is selected then the data will be limited to the specified
project.
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Employee Enter an employee name, ID or login to limit the project time to a
specific employee. The search will do a partial match, e.g. "ob" will
match both "Robert" and "Bob". You can use the wildcard "*" for a
more specific match. For example, to find an employees whose
name ends with "bert" you would enter "*bert". To find an employee
whose name starts with "an" you would enter "an*".

Employee Type You can select one or more employee types to limit the data to just
those employees of the selected type.

Time Entry Notes You can limit or search for data that contains a specific comment in
the time entry notes field.

Reporting Group You can limit the data to a specific reporting group. Note that
"reporting group" is a terminology item, and could have been
renamed (e.g. "Cost Center" or "Department").

To review and approve (or reject) the displayed project time click the Details button on the
right side of each row. This will bring you to the Project Approval Details page. On the
details page you will see the individual time entries for the specified project and employee.
To approve the entries you select one or more rows and click the Approve button (or the
Reject button if rejecting the entries). When you have finished your review you can click
the Next/Previous buttons in the upper-right corner of the list to navigate to the next details
page. This makes it easy to quickly step through each set of project time entries (you don't
need to go back to the summary screen for each employee).

You can undo an approval or rejection by clicking the "More" popup menu to the right of
the Approve and Reject buttons. Simply select the appropriate entries from the list, then
select "Undo Approve" or "Undo Reject".

When reviewing the project time you may want to see different entry fields (e.g. Pay
Amount, or Overtime). Administrators can define which time entry fields are displayed on
the Project Approval Details page. See the Project Time Approval Options below for more
information.

Since project approvals can be done for any arbitrary time period (daily, weekly, etc.), it is
important to understand when a timesheet is considered entirely project approved. When all
of an employee's project time in a timesheet period is project approved, then the entire
timesheet will be considered project approved, even if that timesheet has non-project time
(e.g. vacation or sick leave). Automatically marking the timesheet as project approved is
useful when you have multiple approval levels: a payroll or HR approver can quickly see
that a timesheet has been project approved when they are looking at timesheets on the
Timesheet Approvals page.

Project Time Approval Options

If you are logged in as an administrator (that is, your permissions allow you to manage
system settings and you can see the System tab), you will see an Options item in the
"More" popup menu to the right of the Approve and Reject buttons on the Project
Approval Details page. Selecting the Options item will load the Project Time Approvals
Options page. You can change the following options:

Property Description

Time Entry Details The list of time entry fields that are displayed on the project time
approval details page. You can add additional fields (for example, Bill
Amount), or remove fields that are not relevant.

-o-
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Approving Crew Time
Crew Approval

The Crew Approval page allows you or your clients to review and approve entries on a
weekly or daily basis. The Crew Approval page is accessed as a stand-alone (or kiosk) web
page:

http://hostname/timesheet/kiosk/home.do

Where the "http://hostname" portion should be replaced with the appropriate value for
your Pacific Timesheet installation, for example "https://myco.pacifictimesheet.com".

Once you log into this page you will be able to view and approve/reject entries on a weekly
or daily basis for employee groups or crews. To be able to do this you must have the
following configuration:

 Your employee profile's permission level must allow you to approve. You can check your
permission level from the Employees page, and the permission level can be checked
from the System > Security page. You can be set to "Approve All" or "Approve Limited".

 If your approval permission is "Approve Limited" you must next be assigned to one or
more employee groups. For every group you are assigned to that you want to be able to
approve make sure the permission level is appropriate. For example, if your permission
level is "Manager" you must be assigned to one or more groups with the permission level
of "Manager".

Note: The system administrator may want to log into the kiosk and configure some of the
Crew Approval options first. The online help link in the kiosk provides further information.

-o-
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Leave Requests
Leave Requests

Leave requests facilitate the scheduling of employee time off. New leave requests are
submitted from the Home page by clicking the New Request link. Depending upon your
policy settings, your leave requests will automatically show up on your timesheet for the
requested days when the request is approved. Note that the term "Leave" may have been
renamed by an administrator to "Time Off" or some other terminology. The Terminology
topic has more information.

Leave requests have the following properties:

Property Description

Request Type The type of leave request, for example 'Vacation'. The request type is
a pay code, and if you are a manager you can configure these from
the System > Pay Codes page.

Start Date The first day of the leave.

End Date The last day of the leave.

Partial Day If you are not taking a full day you can check this option to allow you
to enter the start time and finish time. Note that you may not see
this option if you are not allowed to take partial days of leave for the
selected request type. This is controlled by the Time Entry Rules
minimum/maximum leave hours setting - see the Time Entry Rules
topic for more information.

Requested Leave The number of leave days/hours to be taken. This will default to the
number of  days in the selected date range, excluding any weekend
days or holidays.

Description A description of this leave request, up to 255 characters. You might
use this to provide additional information to your approver, such as a
phone number where you can be reached in an emergency, etc.

Once you have submitted a leave request you can monitor its approval status from the
Home page. If your administrator has configured email notifications you will be sent an
email when a request is approved or rejected.

Approving Leave Requests

Leave requests require at least one approval level be enabled. You can configure approval
levels from the System > General > Approval Levels page - the Approval Levels topic has
more information. In addition, you need to be assigned as an approver to one or more
employees to be able to approve leave requests. The Managing Employees topic has more
information.

To list Leave Requests click the Leave Requests tab. By default you will see a list of all
future requests. You can narrow or refine the list using the search properties on the page.
To approve or reject leave requests simply click the appropriate checkbox in the list and
click the Save button. If notices are enabled the employees will automatically receive an
email indicating whether their request was approved or rejected. Clicking the Date hyperlink
in the list will show more details about the request. You can also approve or reject the
request from the details page.

To configure email notices for leave requests go to the System > Notices page. The Notices
topic has more information.
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Note: You can change the terminology for Leave to suit your organization's needs. The 
Terminology topic has more information.

Leave Request Policy Rules

Administrators can configure policy rules for leave requests from the System > Policies >
Schedule Rules page. The Schedule Rules topic has more information.

Leave Request Permissions

There are several leave request permissions (configured from the System > Security page):

Permission Description

Can create my leave
requests

Employees with this permission enabled (meaning they have
this permission enabled for the permission level in their
employee profile) will be able to create new leave requests for
pay codes they are allowed to access (based on their pay code
'Can view' permission). They will also be able to delete leave
requests they created as long as they have not been marked
as approved. To delete an approved leave request it must first
be unapproved by an approver.

Manage Employees with this permission (meaning they have this
permission enabled for the permission level in their employee
profile) can manage all or a limited subset of the employee
leave requests. If set to limited then the employee (or an
employee group they are in) must be assigned to individual
employee groups for which you wish them to manage leave
requests. Enabling this permission for an employee means
they will have access to the 'Leave Requests' tab of the
application.

Note that Leave Requests do not have any sub-permissions
for Manage, unlike many other objects in the system. The
'Can manage' permission effectively gives the user the ability
to view leave requests in a read-only format on the Leave
Requests tab. You might use this permission if you want to
allow some employees to see leave requests for planning
purposes, but prefer other employees approve/reject the
requests.

Approve Employees with this permission (meaning they have this
permission enabled for the permission level in their employee
profile) can approve all or a limited subset of the employee
leave requests. If set to limited then the employee (or an
employee group they are in) must be assigned to individual
employee groups for which you wish them to approve leave
requests. Enabling this permission for an employee means
they will have access to the 'Leave Requests' tab of the
application.
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Can create for approvees Employees with this permission enabled (meaning they have
this permission enabled for the permission level in their
employee profile) will be able to create (and delete) leave
requests for employees. The list of employees they can do this
for depends on their 'Can approve' leave request permission,
as well as whether they are assigned as approvers to any
employees in their employee profiles.

Note that this permission requires the 'Can approve'
permission be enabled as a pre-requisite.
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Leave Request Options
Leave Request Options

The following leave request options can be set:

Property Description

Default Approval
Start Date

When listing requests for approval, look back this many days by
default. This setting is available to administrators only and will affect
all approvers.
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Managing Tasks
Managing Tasks

Normally time is recorded against a Work Breakdown Structure (WBS). A set of pre-defined
levels are provided: Project Groups, Projects, Task Groups and Tasks. Each level can be
renamed as appropriate for your organization, for example Project Groups may be more
appropriately called Clients, or Task Groups called Phases or Cost Centers. Also, not all
levels need to be used and can be disabled. The Work Breakdown Structure topic has more
information.

Levels may or may not have a hierarchical relationship, for example a Project may belong to
a Client, whereas a Cost Center could be used across all Projects.

Related Topics

 Customers
 Project Groups
 Projects
 Task Groups
 Tasks
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Customers
Customers

Customers have the following properties:

Property Description

Name The customer name, up to 80 characters. A value is required and
must be unique for all customers.

Description A description for the customer, up to 255 characters.

ID The customer ID, up to 80 characters. This value is not required, but
if a value is entered it must be unique for all customers. This is
commonly used for synchronizing with external systems, such as
billing or accounting.

Status The customer status, either Active or Inactive. You cannot delete
customers that have been used on timesheets. Setting the status to
inactive will prevent any further use of the customer.

Notes Notes about this customer, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which customers employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access customers for which they have been
added to the permission list.
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Project Groups
Project Groups

Project Groups have the following properties:

Property Description

Name The project group name, up to 80 characters. A value is required and
must be unique for all project groups.

Description A description for the project group, up to 255 characters.

ID The project group ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all project groups. This
is commonly used for synchronizing with external systems, such as
billing or accounting.

Status The project group status, either Active or Inactive. You cannot delete
project groups that have been used on timesheets. Setting the status
to inactive will prevent any further use of the project group.

Notes Notes about this project group, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which project groups employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access project groups for which they have been
added to the permission list.
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Projects
Projects

Projects are objects that can be associated with time and asset entries recorded by your
employees. As projects are full system objects they can be extended by adding custom
fields: see the Custom Fields help topic for more information.

Note: You can change the terminology for the Project object to suit your organization's
needs. For instance you may prefer "Job" instead of "Project". The Terminology topic has
more information.

Projects have the following properties:

Property Description

Name The project name, up to 80 characters. A value is required and must
be unique for all projects.

Description A description for the project, up to 255 characters.

ID The project ID, up to 80 characters. This value is not required, but if
a value is entered it must be unique for all projects. This is commonly
used for synchronizing with external systems, such as billing or
accounting.

Status The project status, either Active or Inactive. You cannot delete
projects that have been used on timesheets, but setting the status to
inactive will prevent any further use of the project.

Planned Start Date The planned project start date.

Planned Finish Date The planned project finish or end date.

Planned Work The planned total number of days or hours to complete this project. 

Administrators can configure the units (days or hours) from the
Projects > Project Options page: see the Project Options help topic for
more information.

Actual Start Date The actual project start date.

Note that if a value is specified here it will be used by the Time Entry
Rule "Don't allow submitting time for inactive Projects, Tasks etc.". If
this rule is enabled then employees will be prevented from recording
any time entries with dates prior to the Actual Start Date. See the 
Time Entry Rules help topic for more information.

Actual Finish Date The actual project finish or end date.

Note that if a value is specified here it will be used by the Time Entry
Rule "Don't allow submitting time for inactive Projects, Tasks etc." If
this rule is enabled then employees will be prevented from recording
any time entries with dates after the Actual Finish Date. See the Time
Entry Rules help topic for more information.

If you specify the Actual Finish Date you can also have the project be
inactivated automatically a specified number of days afterwards. See
the Project Options help topic for more information.
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Actual Work The actual total number of days or hours spent on this project. This
value is computed by totalling ALL hours recorded against this project
on employee timesheets, from the very earliest date. This value is
updated every 15 minutes, but you can click the "Refresh" button to
update the value immediately.

Note that this value can be potentially time consuming to compute,
so it is only computed if a non-blank Planned Work value is
specified. You can, however, enter a zero for Planned Work if you
don't know the actual value, in order to get the Actual Work to be
computed.

Administrators can configure the units (days or hours) from the
System > General > Project Options page: see the Project Options
help topic for more information.

Notes Notes about this project, up to 2000 characters.

Project Permissions

Permissions allow you to restrict which projects employees can access on their timesheets.
Employees with a Permission Level that gives them only limited viewing permission, for
instance, will only be able to access projects for which they have been added to the
permission list.

Project Dashboard

The Project Dashboard allows you to track the breakdown of Project hours by Task and Task
Group (e.g. "Phase"). In addition to reviewing hours spent on various project tasks, you can
compare planned vs actual start and finish dates, as well as planned vs actual hours or days
worked. See the Project Dashboard help topic for more information.
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Project Options
Project Options

The Project Options page lets you configure global project settings, such as whether project
work is displayed in units of hours or days, etc. 

Note: Project options are global settings that will affect all users. Only administrators will
have access to the Project Options page.

Note: The terminology of projects, tasks and other objects can be changed via the System
> General > Terminology page.

The following project options can be configured:

Property Description

Default Work Units This setting determines whether planned and actual work for
projects, etc. is entered/displayed in hours or days.  Data internally
is stored in hours, so when Day is chosen for work units the value
will be computed by dividing the hours by the default hours per
day, as configured on the System > General page.

Automatic Inactivation If enabled then projects and tasks will be automatically inactivated
the specified number of days after their Actual Finish Date value.
Inactive projects and tasks will not be shown in pick lists on
employee timesheets, etc.

The appropriate number of days after the last day for inactivating
the item will depend on your requirements. Typically a value of 7
days is used in order to give employees enough time to add the
item to their timesheet, especially if they save their time some
days after the actual date of the work.

Note that if no Actual Finish Date value is specified then the project
or task cannot be inactivated automatically.

Required Fields You can specify which fields are required when adding or editing
projects.  By default the project name is required, but for your use
you may need additional fields marked as required, such as the
project ID.
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Project Dashboard
Project Dashboard

The Project Dashboard allows you to track the breakdown of Project hours by Task and Task
Group (or "Phase").  In addition to reviewing hours spent on various project tasks, you can
compare planned vs actual start and finish dates, as well as planned vs actual hours or days
worked. 

To configure your dashboard click the "Edit" button and add the appropriate tasks (and
phases) to the dashboard.  You can click the Refresh link to automatically build this list, too.
The Refresh link will add any tasks that have newly added hours, as well as update the
actual hours for all of tasks in the dashboard.  The system will also automatically update the
actual hours for dashboard items every night - if you need to update the dashboard
immediately you can click the Refresh link, too.

You can configure the planned start dates and planned work for each task in the dashboard
by clicking the Edit button, or by clicking the task name link in each row of the dashboard
and entering the appropriate values.  Once you configure the planned values you will see
percentage complete and other statistics in the dashboard.

Note: Dashboard statistics such as Percent Complete are updated nightly. Clicking the
"Refresh" link will update the statistics immediately.

The following project dashboard columns can be displayed:

Column Description

Position The position of each task in the list, starting from 1.

Task Group The Task Group or Phase level of the work-breakdown-structure
(WBS), if enabled.  Note that Task Group can be renamed when
configuring the WBS on the System > General page.

Task The Task level of the work-breakdown-structure (WBS), if enabled. 
Note that Task can be renamed when configuring the WBS on the
System > General page.

Status The task status, such as "In Progress", etc.  This list can be
configured by clicking the Edit button on any project dashboard,
then clicking the "Options" link in the lower-right corner.

Planned Start Date The planned or estimated start date for the phase or task.

Planned Finish Date The planned or estimated finish date for the phase or task.

Planned Work The planned or estimated work for the phase or task, in hours or
days.  You can specify whether the units are hours or days from
the Project Options page.

Actual Start Date The actual start date for the phase or task.

Actual Finish Date The actual finish date for the phase or task.

Actual Work The actual start work recorded for the phase or task.  This value is
updated automatically by the system every night (or you can
update it immediately from the dashboard by clicking the Refresh
link).

Percent Complete This value is computed by the system.  If planned work is specified
and non-zero then the percent complete will be:

100 * (actual work) / (planned work)
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Notes User-entered notes for this task entry in the dashboard.

To configure which of these columns are displayed click the Options link on the Edit
Dashboard page to view the Project Dashboard Options page.

Project Dashboard Options

When editing the project dashboard, you can click the Options link in the lower right corner
to go to the Project Dashboard Options page.  This page lets you configure global project
dashboard settings, such as the list of task states, etc.

Note: Project dashboard options are global settings that will affect all users. Only
administrators will have access to the Project Dashboard Options page.

The following dashboard options can be configured:

Property Description

List Columns Choose which columns to display in the dashboard.  You can specify
the order of the columns by dragging and dropping the column
names. 

Task States This setting lets you control the list of task states, such as "In
Progress", "Completed", etc. as suits your organizational needs.
Task states are used on the Project Dashboard to track the status
of the tasks needed to complete a project.

Importing/Exporting Dashboards

You can use the tools menu on the project dashboard to import or export the dashboard
configuration. See the Project Dashboard CSV Format topic for more information.

Refreshing Dashboards

You can use the tools menu to 'refresh' the actual hours recorded against each project
dashboard item. The system automatically updates these values nightly, but you can use
the tools menu refresh option to get the most recent value in cases where users are actively
entering data.
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Task Groups
Task Groups

Task Groups have the following properties:

Property Description

Name The task group name, up to 80 characters. A value is required and
must be unique for all task groups.

Description A description for the task group, up to 255 characters.

ID The task group ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all task groups. This is
commonly used for synchronizing with external systems, such as
billing or accounting.

Status The task group status, either Active or Inactive. You cannot delete
task groups that have been used on timesheets. Setting the status to
inactive will prevent any further use of the task group.

Notes Notes about this task group, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which task groups employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access task groups for which they have been
added to the permission list.
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Tasks
Tasks

Tasks have the following properties:

Property Description

Name The task name, up to 80 characters. A value is required and must be
unique for all tasks.

Description A description for the task, up to 255 characters.

ID The task ID, up to 80 characters. This value is not required, but if a
value is entered it must be unique for all tasks. This is commonly
used for synchronizing with external systems, such as billing or
accounting.

Status The task status, either Active or Inactive. You cannot delete tasks
that have been used on timesheets, but setting the status to inactive
will prevent any further use of the task.

Planned Start Date The planned task start date.

Planned Finish Date The planned task finish or end date.

Planned Work The planned total number of days to complete this task.

Actual Start Date The actual task start date. This property is only available if projects
are disabled (see the Work Breakdown Structure topic for more
information).

Note that if a value is specified here it will be used by the Time Entry
Rule "Don't allow submitting time for inactive Projects, Tasks etc.". If
this rule is enabled then employees will be prevented from recording
any time entries with dates prior to the Actual Start Date. See the 
Time Entry Rules help topic for more information.

Actual Finish Date The actual task finish or end date. This property is only available if
projects are disabled (see the Work Breakdown Structure topic for
more information).

Note that if a value is specified here it will be used by the Time Entry
Rule "Don't allow submitting time for inactive Projects, Tasks etc." If
this rule is enabled then employees will be prevented from recording
any time entries with dates after the Actual Finish Date. See the Time
Entry Rules help topic for more information.

If you specify the Actual Finish Date you can also have the task be
inactivated automatically a specified number of days afterwards. See
the Project Options help topic for more information.
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Actual Work The actual total number of days or hours spent on this task. This
value is computed by totalling all hours recorded against this task on
employee timesheets. This value is updated every 15 minutes.

Note that as this value can be potentially time consuming to
compute, it is only computed if a non-blank Planned Work value is
specified. You can, however, enter a zero for Planned Work if you
don't know the actual value, in order to get the Actual Work to be
computed.

Administrators can configure the units (days or hours) from the
System > General > Project Options page: see the Project Options
help topic for more information.

Billable Indicates whether this task is billable or not. Note that you can
change which type of object (Project, Task, etc.) has the billable flag.
The Rate Options topic has more information.

Notes Notes about this task, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which tasks employees can access on their timesheets.
Employees with a Permission Level that gives them only limited viewing permission, for
instance, will only be able to access tasks for which they have been added to the permission
list.
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Managing Assets
Asset Tracking

Pacific Timesheet allows you to track assets and their usage. Assets are generally non-labor
items you want to track on a regular basis, such as materials, equipment and other
resources you use as part of your projects or jobs. 

Note: You can change the terminology 'Asset' to suit your organization's needs. The 
Terminology topic has more information.

Related Topics:

 Assets
 Asset Classes
 Asset Types
 Units of Measure
 Asset Entries
 Asset Entry Fields
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Asset Entries
Asset Entries

Asset entries track the actual usage of assets. Asset entries are records keeping track of
what quantities of assets were used over time. For example, you might have a material
asset entry of 10 gallons (the quantity) of diesel (the asset) used on Monday 3/28 (the
date). You can control the specific fields that are entered for each asset type from the Asset
Entry Fields page.

Note: You can change the terminology 'Asset' to suit your organization's needs. The 
Terminology topic has more information.

Assets entries can have the following entry fields (depending upon how the entry fields are
configured: see the Asset Entry Fields topic for more information):

Property Description

Date The date of the entry. This is the date the asset was used, for
instance. This field is required.

Entry ID A unique ID for identifying this entry. If the field is not entered
by the employee than a value is automatically generated. You
can control the formatting of this by editing the ID format on the
Asset Types page. See the Asset Types topic for more
information.

Asset The asset associated with this entry. The selected asset will
determine:

 The unit of measure for the quantity field, e.g. Gallons or
Kilometers.

 The number of digits to the right of the decimal point that
can be entered for the quantity field.

 The unit cost, which can be overridden if the Unit Cost or
Total Cost fields are allowed entry.

 The unit price, which can be overridden if the Unit Price or
Total Price fields are allowed entry.

To learn more about setting up assets refer to the Assets topic.

Quantity The amount of the asset used for this entry, in whatever units
the asset's unit of measure indicates. Note that negative values
are allowed as a way to make corrections to entries that are
locked and therefore not editable.

Description A description for this entry, up to 255 characters. For larger text
input you can also use the Notes field.

Unit Cost The unit cost for the asset used by this entry. Cost is what you
pay for this asset, as opposed to price, which is what you charge
for this asset. The value will default to the unit price of the
selected asset, if specified.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information). 
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Cost The total cost for this entry, computed as the quantity times the
unit cost. Cost is what you pay for this asset, as opposed to bill
amount, which is what you charge for this asset.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information). If this value is overridden then a new unit
cost will be computed for the entry as the total cost divided by
the quantity.

Unit Bill Amount The unit bill amount or rate for the asset used by this entry. Bill
amount is what you charge for this asset, as opposed to cost,
which is what you pay for this asset. The value will default to the
unit bill amount of the selected asset.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information).

Note that both Unit Bill Amount and Bill Amount will be
automatically set to zero if the Billable checkbox is present and
not checked.

Bill Amount The total bill amount for this entry, computed as the quantity
times the unit bill amount. Bill amount is what you charge for
this asset, as opposed to cost, which is what you pay for this
asset.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information). If this value is overridden then a new unit bill
amount will be computed for the entry as the total bill amount
divided by the quantity.

Note that both Unit Bill Amount and Bill Amount will be
automatically set to zero if the Billable checkbox is present and
not checked.

Billable A checkbox field that indicates whether this asset entry is
billable or not. If the asset entry is not billable then the Unit Bill
Amount and Bill Amount values will be automatically set to zero.

Reimbursable A checkbox field that indicates whether the employee associated
with this asset entry should be reimbursed for the cost.

Notes Notes for this entry, up to 4,000 characters (2,000 for Oracle
databases). Use this for longer information about the entry, as
opposed to the description field, which has a limit of 255
characters.

Employee The employee to associate with this entry. By default it is set to
the employee who created the entry.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information).
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Reporting Group The group to associate with this entry. By default it is set to the
reporting group of the employee who created the entry.
Reporting Group is a terminology item and can be changed to
"Cost Center", "Department", "Crew", etc. The Terminology topic
has more information.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information).

Customer/Project/Task You can enter a value for the work breakdown structure (WBS)
for this entry. For more information on see the Work Breakdown
Structure topic.

Note that you can have the employee input as many or as few of
the WBS levels as you like by editing which fields are allowed for
entry (see the Asset Entry Fields topic for more information).

Custom Fields You can have any number of custom fields that can be entered
by the employee. To add new custom fields select the Custom
Fields option on the More menu (see the Custom Fields topic for
more information).
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Asset Entry Fields
Asset Entry Fields

You can customize the list of fields that are entered for each type of asset entry. This gives
you great flexibility in setting up entry templates that are different for each asset type, such
as equipment, materials or expenses. In addition to which fields are shown, you can also
specify the access level for individual fields. For instance, you can have some fields, such as
price or cost fields, that are only editable by managers.

Note: You can add to the list of available entry fields by selecting the Custom Fields option
from the More menu (see the Custom Fields for more information). Once you have added
your custom fields you will need to go back to the Asset Entry Fields page to enabled
them.

Asset entry fields have the following properties:

Property Description

Enabled If checked the field is enabled and can be shown or edited.

Access The default access level or permission for this field: hidden,
read-only or editable.

Access Exceptions Access exceptions allow you to override the default access for
specific employee permission levels. For instance, you may have
cost fields hidden from all users by default, but allow managers
and administrators to see and edit these fields.

Required If checked then a value for this field is required. Entries will not be
able to be saved or submitted until a value is provided.

New Group If checked then this field denotes the start of a new group of
fields. This is a cosmetic setting to help group related fields
together: a dividing line will be inserted before this field to
separate it from previous fields.

Detail If checked then this field will be considered a detail and not shown
in lists of entries. Instead you will need to drill into the listed entry
(or click the details button) to see the field. Check this setting for
fields that are only infrequently entered and to prevent entry lists
from becoming too wide.

Special Field Properties

Some fields have additional properties that can edited:

Field Description
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Entry ID This field is an auto-generated sequential number. Each time an
entry is created the value will be incremented. The default format
is as follows:

{0000000000}

This results in a 10 digit number padded with leading zeros. 

For a number with no leading zeros the format is:

{0} -> 176268

You can prepend or append characters to the format, too, such as:

EQ{00000000}

Note that the Entry ID field can be manually entered, too, by
setting the field access to editable. To turn off the generation of
the sequential number enter the following format:

{}

Reordering Fields

You can specify the order in which the fields appear by clicking the Edit button on the Entry
Fields page, then clicking and dragging each row to move it where you like.

-o-

 



p59

© 2000-2023, Pacific Timesheet

Assets
Assets

Assets are the definitions or profiles of the materials, equipment, etc. you are tracking.
Assets can be broadly divided into user-defined types, such as equipment, materials or
expenses (see the Asset Types topic for more information). Assets can be further divided
into user-defined classes, for example equipment assets may be classified by Truck, Auto,
etc. (see the Asset Classes topic for more information).

Assets define what you keep track of, whereas Asset Entries are used to track the actual
usage of these assets. For example, you may have a material asset named 'Gravel', and an
asset entry that indicates how much gravel a crew used on a particular date. See the Asset
Entries topic for more information.

Note: You can change the terminology 'Asset' to suit your organization's needs. The 
Terminology topic has more information.

Assets have the following properties:

Property Description

Name The asset name, up to 80 characters. A value is required and must
be unique for all assets (regardless of the asset type).

Description A description for the asset, up to 255 characters.

ID The asset ID, up to 80 characters. This value is not required, but if
a value is entered it must be unique for all assets (regardless of the
asset type). This is commonly used for synchronizing with external
systems, such as billing or accounting.

Status The asset status, either Active or Inactive. Setting the status to
inactive will prevent the recording of any further asset entries for
this asset. Note that you cannot delete assets that have asset
entries associated with them, and in those cases you will instead
make the asset inactive to prevent its further use. 

Class The asset class (optional). Asset classes are configured on the
Assets > Asset Class page (see the Asset Classes topic form more
information).

Unit of Measure The unit of measure for this asset (optional). Units of measure are
configured on the Assets > Units of Measure page (see the Units of
Measure topic form more information).

Units Decimal Digits The number of decimal digits of precision for entering the quantity
value for asset entries. It will default to the "Default Decimal Digits"
property for the selected unit of measure, but you can override this.
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Unit Amount The unit amount or cost of this asset, per unit of measure. Amount
is what you pay for this asset, as opposed to the bill amount, which
is what you charge clients or customers for this asset. Unit Amount
is used to compute the total amount based on the quantity entered
by the employee. The unit amount is only useful if you have the
employee enter the quantity.

If multi-currency is enabled for the asset type then you can also
select the default currency for this asset.

Unit amounts can be editable by employees, or fixed (for example,
you may have a Mileage item that has a fixed rate of 0.55 per mile
and you do not want the employee to change that rate).

You can also control whether the unit amount is editable (as well as
total amount) by setting the entry field permissions (see the Asset
Entry Fields topic for more information). 

Unit Bill Amount The unit bill amount or rate for this asset, per unit of measure. Bill
amount is what you charge for this asset, as opposed to cost, which
is what you pay for this asset. Unit bill amount is used to compute
the total bill amount based on the quantity entered by the
employee. The unit bill amount is only useful if you have the
employee enter the quantity.

Unit bill amount can be either a fixed value, or can be computed.
The following options are available:

Fixed
Amount

The unit price is always the value entered: it does
not change based on the unit cost.

Markup The unit bill amount is computed from the unit cost
as a percent markup: 

Unit Bill Amount = Unit Cost * (1 + Markup)

For example, if the markup is 50% and the unit
cost is $10.00, then the unit bill amount will be
$15.00.

Margin The unit bill amount is computed from the unit cost
to give you a percent margin: 

Unit Bill Amount = Unit Cost / (1 - Margin)

For example, if the margin is 50% and the unit cost
is $10.00, then the unit bill amount will be $20.00.
As you can see from the equation, the margin can
never be 100% or greater.

Note that you can optionally allow entries to override this unit bill
amount if you allow the entry's Unit Bill Amount or Total Bill
Amount fields to be editable (see the Asset Entry Fields topic for
more information). 

Notes Notes about this asset, up to 2000 characters.

-o-
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Asset Classes
Asset Classes

Asset classes allow you to organize your assets into logical groupings. For example, given an
asset type of Equipment you might created classes such as "Truck", "Auto", etc. Once you
have defined your asset classes you can select them when editing asset properties (see the 
Assets topic for more information).

Asset classes have the following properties:

Property Description

Name The asset class name, up to 80 characters. A value is required and
must be unique for all classes (regardless of the asset type).

Description A description for the asset class, up to 255 characters.

ID The asset class ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all asset classes
(regardless of the asset type). This is commonly used for
synchronizing with external systems, such as billing or accounting.

Status The asset class status, either Active or Inactive. Setting the status
to inactive will prevent its use when editing assets. Note that you
cannot delete an asset class if there are assets that use it, and in
those cases you will instead make the asset class inactive to
prevent its further use. 
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Asset Types
Asset Types

Asset types are designed to be used for very broad categories of assets, e.g. Material,
Equipment or Expenses. There is no hard limit to the number of asset types you can create,
but keep in mind that each asset type can optionally have a tab on the timesheet, so you
generally want to limit the number to less than 10.

Asset types have the following properties:

Property Description

Name The asset type name, up to 40 characters. A value is
required and must be unique.

Plural Name The plural name of the asset type, up to 40 characters. A
value is required and must be unique.

Description A description for the asset type, up to 255 characters.

ID The asset type ID, up to 80 characters. This value is not
required, but if a value is entered it must be unique for all
asset types. This is commonly used for synchronizing with
external systems, such as billing or accounting.

Status The asset class status, either Active or Inactive. Note that
you cannot delete an asset type if there are assets, classes,
etc. that use it. In those cases you will instead make the
asset type inactive to prevent its further use. 

Asset types have the following advanced properties:

Property Description

Auto-generate Asset Entry ID If enabled then unique asset entry IDs will be automatically
generated whenever an entry is created. By default the ID
format will be a sequential number padded out to 10 digits
with leading zeros. You can alter the ID format to suit your
needs (for example, to more easily integrate with external
systems). Example formats are:

{0} -> A sequential number with no leading zeros
(meaning the length will increase as the sequential number
increases).  For example '1234'.

{00000000} -> A sequential number padded with leading
zeros to be a length of 8 digits.  For example '00001234'.

{ABC-0000000} -> A sequential number padded with
leading zeros to be 7 digits in length, with the prefix 'ABC-'.
For example 'ABC-0001234'.

Note that you should not make the number of zeros in the
format too few or the sequential number will be truncated
and you will not have a unique ID (IDs must be unique).
You should consider a minimum of at least 7 zeros in the
format.
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Asset Sheet Enabled If enabled then asset entries will be collected or grouped
into asset sheets (for example, Expense Sheets). When
employees want to record asset entries they will need to
edit or create an asset sheet first, and asset entries will be
added to the asset sheet. This is convenient for grouping
related entries into a logical unit, such as expenses incurred
on a business trip.

Auto-generate Asset Sheet ID If enabled then unique asset sheet IDs will be automatically
generated whenever an entry sheet is created. The format
is the same as described above for auto-generated asset
entry IDs.

Multi-Currency Enabled If enabled then employees can pick the local currency for
asset entry amounts. When employees create entries the
amount they enter can be in Euros or Canadian Dollars,
even when the base currency for the system is US Dollars
(the base currency is configured on the System > General
page). 

The list of currencies an employee is allowed to choose from
is configured on the System > General > System Options
page.

With multi-currency enabled the entered local amounts will
be converted to the base currency internally, and will be
available for reporting or export/import. For instance, in
addition to the Asset Entry.Amount field you will find
additional fields: Asset Entry.Amount-Local (the amount as
entered by the employee in the local currency) and Asset
Entry.Amount-Currency (the local currency selected by the
employee).

Note that conversions between local currency amounts and
the base currency for the system are handled automatically
using currency exchange rates provided by reputable third
party sources based on official central bank data. Currency
exchange rates can be optionally overridden at the
individual entry level if so desired.

If multi-currency is not enabled then all amounts are
considered to be in the base currency.

-o-
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Units of Measure
Units of Measure (UoM)

Units of measure (UoM) define the type of quantity that is entered for assets. Once you
have defined your units of measure you can select them for your assets from the asset
properties page (see the Assets topic for more information).

Units of measure have the following properties:

Property Description

Name The unit of measure name, up to 40 characters. A value is
required and must be unique.

Abbreviation The abbreviation for the unit of measure, up to 10 characters. If
not specified it will be set to the name (up to the first 10
characters). The abbreviation is what is generally shown to end
users when entering data, running reports, etc.

Description A description for the unit of measure, up to 255 characters.

ID The unit of measure ID, up to 80 characters. This value is not
required, but if a value is entered it must be unique for all units
of measure. This is commonly used for synchronizing with
external systems, such as billing or accounting.

Status The unit of measure status, either Active or Inactive. Note that
you cannot delete a unit of measure if there are assets or asset
entries that use it. In those cases you will instead make the unit
of measure inactive to prevent its further use. 

Default Decimal Digits The default number of decimal digits (digits to the right of the
decimal point) to allow when entering quantities using this unit
of measure. This value is used when editing assets: whenever a
new selection is made for an asset's unit of measure the asset's
decimal digits value will be set to this default value. A value of 0
(zero) means only whole numbers can be entered.

-o-
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Managing Expense Sheets
Managing Expense Sheets

Employees can be given permission to manage other employee's Expense Sheets. A
manager can view, edit and even delete Expense Sheets, depending upon their permission
level. Any employee whose Permission Level allows expense sheet management (for
example Administrator or Manager) can manage Expense Sheets and will see the Expense
Sheets tab. If you do not see the Expense Sheets tab then you have not been given a
Permission Level with expense sheet management permissions. You can check an
employee's Permission Level from the Employees tab.

If the employee's permission level allows only limited expense sheet management then the
employee will need to be added to the permission list for one or more employee groups.
This can be done by clicking the Groups link under the Employees tab, then clicking one of
the groups in the list. In the Permissions section for the group click the Edit button and
add the employee to the permission list with the appropriate permission level. The Groups
topic has more information.

Note: You can use expense sheet management permissions to create "expense keepers" -
employees with the ability to enter expenses for other employees. This avoids the need to
log in as another user in order to fill out their expense sheet. In implementing expense
keepers it is recommended that you create a new Permission Level with only the minimum
required expense sheet permissions such as manage, edit and create. The Permission
Levels topic has more information.

Expense sheet Lookup

To list employee Expense Sheets click the Expenses tab, navigate to Expense Sheets, enter
an appropriate Start date, then click the Search button. You can optionally enter a Finish
 date and Status in order to narrow down the list of returned Expense Sheets.

If you do not find any Expense Sheets then you may have only limited expense sheet
management permissions. As mentioned above, you may need to be added to the
permission list for one or more employee groups.

Clicking a Time Period link in the list will load that employee's expense sheet. Depending
upon your permission level, you may be able to edit or even delete this expense sheet.

Exporting Expense Sheets

If your permission level allows it you can export the list of Expense Sheets by clicking the
tools button in the upper right of the list and then clicking the Export List link. This will
export the expense sheet status information as displayed in the list to your local computer,
in comma-separated value (CSV) format. This file can then be opened in Microsoft Excel or
other applications that support the CSV format. You can optionally change this to Microsoft
Excel's native format (XLS) by clicking the Preferences link on the Home tab.

Clicking the Export link will download the expense entries for each expense sheet in the list
as a file that you can save on your local computer. This is useful for exporting expense
entries to external systems such as Payroll or Accounting applications. You can optionally
mark expense entries as being exported, so that you can avoid re-exporting the same data. 

Expense Entry Corrections
Once an expense sheet has been marked as exported it cannot be unsubmitted (unlocked)
for re-editing. You will need to make corrections to the expense sheet by clicking on the
tools button and then View Expenses in order to view and manage expense entries. You can
search for any expense entries by setting the parameters of the expense entries in search.
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These can include employee, date range, project, etc. You can view already-exported and
processed expense entries and create correction expense entries as follows:

1.Click into the expense entry you intend to correct.
2.Clone the entry by clicking on the clone button.
3.Edit the cloned entry to create a negative entry. If the entry is a mileage entry, change

the quantity entry to negative, or if the entry is an expense amount entry, change
the amount value to negative.

4.Clone and edit the entry again and modify it to create the correct positive value of the
correction entry.

5.Submit and approve the pair of correction entries so they are ready to exported and
processed. 

This is a safeguard to avoid modifying previously exported time entries. 

Note that administrators (those with the "Can Manage All" expense sheet permission) can
bypass this restriction and still unsubmit a previously exported expense sheet, if the need
arises.

Another option for getting access to expense sheet data is to run a Expense Details report.
This report can be customized to only output the fields you require, and can be downloaded
in a number of formats, including Microsoft Excel. The Reports topic has more information.

Importing Expense Sheet Data

If your permission level allows you to import expense data by clicking tools button in the
upper right of the list and then clicking the Import link. The Importing/Exporting topic has
more information generally on how import/export utilities work, including auto-import and
auto-export features. Importing expense data has a few important features worth noting:

1.You can prepare and expense import data file to import credit card data directly into
the system.

2.You should prepare this file to group expense entries to list entries by employee first
and entry date second. You can have multiple groupings of expense entries grouped
by employee then date.

3.When you import these expense entries each expense entry will be assigned an
auto-generated Expense Sheet ID for each employee. The series of expense entries
imported will be grouped into a unique expense sheet using this unique expense
sheet ID.  

Printing Expense Sheets

The 'Print List' option in tools menu in the upper right corner of the expense sheet list allows
you to download a printable hard copy summary list report of all of the Expense Sheets in
the list. You can also print out multiple Expense Sheets for signing, for instance, by clicking
on the Print Expense Sheets button. Note that, rather than printing the entire list, you can
print selected Expense Sheets by clicking the checkbox on each row before selecting the
'Print' option.

You can also print individual Expense Sheets by clicking into an individual expense sheet the
time period link in the expense sheet list, then clicking the 'Print' view button in the
upper-right corner of the expense sheet. This will download a printable version of the
expense sheet suitable for printing.

-o-
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Configuring Expense Fields
Expense Entries

Expense entries track the amount other important details of an expense item within an
expense sheet or report. For example, you might have an expense entry of a meal (the
expense type) that took place on Monday 3/28 (the date). You can control the specific fields
that are entered recorded against each expense item by clicking the Options link under the
More Menu (triangle button) in the upper-right corner of the Expense Sheets list.

Note: You can enable sheet support on any asset type. See the Asset Types help topic for
more information.

Expense entries can have the following entry fields:

Property Description

Date The date of the entry. This is the date the expense was used,
for instance. This field is required.

Entry ID A unique ID for identifying this entry. If the field is not entered
by the employee then a value is automatically generated. You
can control the formatting of this by editing the ID format on
the Expense Types page. See the Asset Types topic for more
information.

Expense Item The expense item associated with this entry. The selected
expense type will be used by users to record:

 The amount that the expense costs. Where the expense item
does not have a unit amount (unit cost) set in its profile,
users are only required to enter the expense item amount,
and not enter values for quantity or unit amount.

 The quantity of the expense item and the unit of measure
for a quantity field where the expense item requires
recording the quantity, such as miles. The expense item can
have a fixed unit amount, such as unit amount per mile for a
mileage expense item. In this case, the amount will be a
calculated value (quantity X unit amount = amount). 

 The number of digits to the right of the decimal point that
can be entered for the quantity field.

 The currency for an expense item unit amount can be set
when multi-currency is enabled. 

 The unit amount can be set as a “fixed” or “editable by
employee.” This can be used when you might have multiple
fixed rate expense items. In the case of a “Mileage USA,”
you could set the unit amount to a fixed rate of .54 USD. For
“Mileage Canada” you could set the unit amount of a fixed
rate of .56 CAD.

Quantity Quantity is used for certain expense items that require
capturing a quantity, such as the number of miles. You can
setup multiple expense types for miles to reflect different
reimbursement rates that will be multiplied times the quantity
entered. For example, #Miles USA would be have a different
unit amount (per mile) than #Miles UK. 
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Description A description for this entry, up to 255 characters. For larger text
input you can also use the Notes field.

Unit Amount The unit amount (cost) of an expense entry. 

Amount The total amount of an expense entry (quantity X unit amount)

Currency Currency is the selected by the employee to designate the
currency of the expense amount where the cost was incurred.
The currency can only be edited if multi-currency is enabled.

Billable A checkbox field that indicates whether this expense entry is
billable or not. If the expense entry is not billable then the Unit
Bill Amount and Bill Amount values will be automatically set to
zero.

Unit Bill Amount The unit bill amount of an expense entry that will be used to
calculate the bill amount billed to a customer.

Bill Amount The total bill amount for this entry, computed as the quantity
times the unit bill amount. Bill amount is what you charge for
this expense, as opposed to amount(cost), which is what you
pay for this expense.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information). If this value is overridden then a new unit
bill amount will be computed for the entry as the total bill
amount divided by the quantity.

Note that both Unit Bill Amount and Bill Amount will be
automatically set to zero if the Billable checkbox is present and
not checked.

Reimbursable A checkbox field that indicates whether the employee associated
with this expense entry should be reimbursed for the cost. You
need to have the Reimbursable field configured as an entry field
in order to see the Total Reimbursement value of an expense
sheet.

Reimbursement
Amount

Reimbursement amount is the amount in the reimbursement
currency that will be reimbursed to an employee in the
reimbursement currency. The reimbursement amount can be
overridden by an employee. The Reimbursement Amount field
shows up automatically in the Entry Details dialog if the
Reimbursable field is present.

Reimbursement
Currency

Reimbursement currency is designated by the employee in the
Expense Sheet and is used to convert an expense amount from
and expense currency into a reimbursement currency. For
example, an airfare expense that is incurred in USD (the
expense currency) might be converted into CAD (the
reimbursement currency). The Reimbursement Currency can
only be edited if the Reimbursable field is present, and 
multi-currency is enabled.

Exchange Rate The exchange rate that converts the expense amount into a
reimbursement amount. Exchange rate can be overridden by an
employee. The Exchange Rate field shows up automatically in
the Entry Details dialog if the Reimbursable field is present, and 
multi-currency is enabled.
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Notes Notes for this entry, up to 4,000 characters (2,000 for Oracle
databases). Use this for longer information about the entry, as
opposed to the description field, which has a limit of 255
characters.

Employee The employee to associate with this entry. By default it is set to
the employee who created the entry.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information).

Reporting Group The group to associate with this entry. By default it is set to the
reporting group of the employee who created the entry.
Reporting Group is a terminology item and can be changed to
"Cost Center", "Department", "Crew", etc. The Terminology topic
has more information.

Note that you can optionally allow this value to be overridden if
you make this field editable (see the Asset Entry Fields topic for
more information).

Customer/Project/Task You can enter a value for the work breakdown structure (WBS)
for this entry. For more information on see the Work Breakdown
Structure topic.

Note that you can have the employee input as many or as few
of the WBS levels as you like by editing which fields are allowed
for entry (see the Asset Entry Fields topic for more information).

Custom Fields You can have any number of custom fields that can be entered
by the employee for an expense entry. To add new custom fields
select Options on the More menu, and then Entry Fields: 
Configure Entry Fields (see the Custom Fields topic for more
information).

-o-
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Multi-Currency
Multi-Currency

Multi-currency allows employees to enter expense entry amounts in the local currency.

Enabling Multi-Currency

To enable multi-currency for expenses, assets or other entry types, you need to do
following:

1. Go to Admin>System>System Options and edit. Enable the currencies you want to
use in your system from a currency picklist. 

2. Go to the main enabled Expense/Asset page, navigate to the tools button, and click
into and edit the Expense/Asset type for which you want to enable multi-currency.
Next to the Multi-Currency Enabled heading, check “Yes - Allow users to choose
currency for entered amounts.”

How Multi-Currency Works

Once enabled, the system automatically fetches and records the exchange rates and
amounts between:

-The original expense amount

-The reimbursement amount, and

-The system base currency amount. 

In the following example recorded on June 21, 2016, the data for an airfare expense is
recorded where the expense entry currency is CAD, the reimbursement currency is GBP,
and the system’s base currency is USD. 

Currency Type Description

Expense Local Currency Expense Type = Airfare
Expense Local Currency = USD
Expense Amount = CAD547.00

Reimbursement Currency Expense Type = Airfare
Reimbursement Currency = GBP
Reimbursement Currency Exchange Rate = 0.531140
Reimbursement Amount = GBP290.53

Base Currency Expense Type = Airfare
Base Currency = USD
Base Currency Exchange Rate = 0.782920 CAD/USD
Base Currency Amount = USD428.26

Once enabled, there will be several specific multi-currency fields that will be made available
that will be used with other related fields in the system. The multi-currency fields are
marked below with an asterisk (*).

Expense Item Currency*

The Expense Item Currency field will be enabled with a pick list of your enabled currency
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values. Users will set the expense item currency value to the local currency where the
expense was incurred. This currency value will then be used to convert the expense item
amount to the reimbursement currency amount. 

Reimburse Amount*

The Reimburse Amount field shows the system-calculated reimbursement amount for this
expense entry.  You can override this amount by selecting the Override check box. This field
should be setup to appear in the details of the expense entry template.

Exchange Rate*

The Exchange Rate field shows the system-calculated exchange rate for this expense
entry.  You can override this amount by selecting the Override check box. This field should
be setup to appear in the details of the expense entry template.

Expense Amount

The Amount field is the amount of the expense entry. This amount must always be paired
with a selected expense currency for multi-currency purposes.

Reimbursable

The reimbursable field, which can be used in non-multi-currency mode, is a check box that
flags the expense entry as reimbursable, and must be checked by the user to include an
expense entry in the reimbursement amount.

-o-
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Managing Employees
Employees

You need to create an employee account for each user that needs to record time or log into 
Pacific Timesheet. Employee accounts are where you specify the login name, email address,
timesheet template and other properties.

Note: You can change the terminology for 'Employee' to suit your organization's needs.
The Terminology topic has more information.

Employee accounts have the following properties:

Property Description

Login Name The employee login name. This is required, and must be a unique value
up to 80 characters. The login name is NOT case-sensitive.

Note: If you are integrating with an LDAP server or an Active Directory
server then you will want this value to match the login name used for
those accounts. See the Security help topic for more details.

Password The employee password, up to 40 characters. The password IS
case-sensitive. The complexity of the password is controlled by
application's security settings. See the Security help topic for more
details.

Note: If you are integrating with an LDAP server or an Active Directory
server then the employee will use the password configured in those
accounts. See the Security help topic for more details.

First Name The employee's first name, up to 80 characters.

Last Name The employee's last name. This field is required and can be up to 80
characters.

ID The employee ID, up to 80 characters. This value is not required, but if
a value is entered it must be unique for all employees. The value here
is commonly used when synchronizing with external systems such as
payroll processing.

Status The employee status, either Active, Inactive or Locked. 

Note: Accounts can become automatically locked after too many
unsuccessful login attempts in a short period of time. See the Security
help topic for more details. 

Note: Locked or inactive employee accounts are not counted when
checking your Pacific Timesheet license to see if you have reached your
maximum number of employee accounts. You can have as many Locked
or Inactive employees as you require. For instance, when an employee
leaves the company you will generally just change their status to
Inactive so that you can retain their historical information, rather than
deleting the employee account.
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First Day The first day of employment. Specifying a value can be important for
several reasons:

- The employee will not be allowed to enter time for dates prior to their
First Day value.

- The employee will not be allowed to submit leave requests for dates
prior to their First Day value.

- This value will affect balance accruals that vary based on the years
employed (see the Balance and Accrual Rules topic for more
information).

Last Day The last day of employment. The employee will not be allowed to enter
time for dates after to this date. It is good practice to set this value
when inactivating an employee.

Last Login This is a read-only field showing the date and time of the employee's
last successful login.
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Photograph An optional employee photograph. Supported formats are PNG, GIF and
JPG, and it is recommended the image be square and approximately
180x180 pixels. You can specify an image up to 500x500 pixels, but it
will be scaled to 180x180 in web pages. Also, the file size must be no
greater than 48K bytes. Note that setting the photograph results in a
copy of it being stored in the application database, so you do not have
to maintain the photograph in the same location that you used when
uploading it.

You can bulk set employee photographs by using an auto-import file.
You can upload all of your employee photograph files to an FTP site,
then send an employee CSV file with two columns as the following
example shows:

Login Name,Photograph

employee1,emp1-photo.jpg

employee2,emp2-photo.jpg

...

When the auto import directory is scanned and the CSV file is read, it
will look for each photograph file in the same directory as the CSV file
and set the user's photograph. You can optionally put the photographs
in a subdirectory, e.g.

Login Name,Photograph

employee1,photos/emp1-photo.jpg

employee2,photos/emp2-photo.jpg

...

When the CSV file is processed it will look for files in the "photos"
subdirectory within the directory containing the CSV file. 

Alternatively, if you have an existing repository of photographs you can
use URLs for the Photograph field values in the import file, e.g.

Login Name,Photograph

employee1,http://xyz.com/images/photo1.jpg

employee2,ftp://xyz.com/pub/foto2.gif

...

Supported URL formats for the Photograph field in the import file are
HTTP, HTTPS and FTP. Another advantage of using a URL is that you
can manually import the file via the web interface, rather than using
the auto-import directory. Note that setting the photograph results in a
copy of it being stored in the application database, so you do not have
to maintain the photograph in the same location that you used when
importing it.
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Permission Level The permission level determines the maximum permissions an
employee has for the application. The exact permissions may depend
upon which objects a user is assigned to, and the permission level they
have for that object. For example, an employee may be given a default
permission level of Manager, but will not be able to manage a project
unless they are assigned to it and given the role of Manager for that
project.

When editing an employee, the list of permission levels will be limited
to only active permission levels. This list will be further limited
depending upon the default permission level of the logged-in user. For
instance, an Administrator will see the full list of active permission
levels, whereas a Manager will not see the Administrator role as it is
considered to have a higher security level.

For more information on permission levels see the Security help topic.

Employee Type The type of employee, for example Non-exempt, Exempt, Hourly,
Salaried, etc. This property is essentially a label used for categorizing
your various types employees. The list of employee types can be
customized from the Employees > Employee Types page, available
under the More menu on the Employees page.

Policy The policy for this employee. Policies are sets of rules affecting time
entry, leave balances, overtime handling, etc. and are managed from
the Policies page under the System tab.

Job Title The optional job title for this employee, up to 80 characters.

Reporting Group The primary or reporting group for this user. This group will be the
default group associated with employee's time and asset entries. For
instance, whenever an employee saves their timesheet, the employee's
current reporting group value will be stored with each time entry.

Note: Reporting Group can be thought of as Division, Cost Center,
Charge Code, etc. depending upon your organization. You can rename
'Reporting Group' from the Terminology page under the System tab.

Default Bill Rate The default bill rate. The rate can be specified as either a named rate or
a custom numeric value. Named rates are configured from the Rate
Options page. The current bill rate, if non-zero, is used when a
timesheet is saved to compute the bill amount for each time entry.

Default Pay Rate The default pay rate. The rate can be specified as either a named rate
or a custom numeric value. Named rates are configured from the Rate
Options page. The current pay rate, if non-zero, is used when a
timesheet is saved to compute the pay amount for each time entry.
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Salary The annual salary for non-hourly employees. The salary, if non-zero, is
used to compute an effective pay rate when a timesheet is submitted.
You should therefore only specify a pay rate or a salary, not both. If
both are specified the pay rate is used and the salary ignored.

Note that the effective pay rate is based on the total hours for the
timesheet period. Since the total hours is only accurate when the
timesheet is submitted, the effective pay rate is not computed until the
timesheet is submitted. You can also have the effective pay rate
computed before a submit by specifying the 'Scheduled Hours' property.
Then, when a timesheet is saved (but not submitted) the scheduled
hours will be used instead of the total hours on the timesheet to give
an approximate effective pay rate. Once the timesheet is submitted,
however, the total hours will be used to give an accurate effective pay
rate.

Scheduled Work
Days

The days of the week the employee is scheduled to work, for example
Monday-Friday. Specifying a value can be important for several
reasons:

- Holidays, when automatically added to timesheets, will only put hours
on days marked as a work day. See the Schedule Rules topic for more
information.

- Leave requests, when added to timesheets after approval, will only
put hours on days marked as a work day. See the Schedule Rules topic
for more information.

- Time entry rules that require a minimum number of hours each work
day will only check on days marked as a work day. See the Time Entry
Rules topic for more information.

Scheduled Hours The number of hours the employee is scheduled to work each week and
each work day. The scheduled hours values affect the following areas of
the system:

- When leave requests and holidays are automatically added to the
employee's timesheet the Scheduled Hours Per Day will be used to
determine how many hours to put on the timesheet. If no value is
specified, the Hours Per Day property on the System > General page is
used. See the Schedule Rules help topic for more information on how
holidays and leave requests can be configured to be automatically
added to timesheets.

- The scheduled hours value is used when displaying how many days of
balance are available on the employee's home page. If no value is
specified, the Hours Per Day property on the System > General page is
used.

- Percent Time Entry timesheets need the Scheduled Hours Per
Week value in order to convert percentages to hours. See the
Templates topic for more information on timesheet templates.
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Scheduled Start The time of day the employee is scheduled to start work or "punch in".
The scheduled start time affects the following areas of the system:

- Employee lateness is determined based on the scheduled start value,
and can trigger the sending of an email notice. See the Notices topic for
information about sending late email notices.

- When adding a new row to an attendance timesheet (one that has
start and finish times) the start time will default to the employee's
scheduled start time.

- If you configure rounding rules to round punches to the scheduled
start time then you will need to specify the employee's scheduled start
time. See the section on rounding in the Time Entry Rules help topic for
more information.

- If you are keeping track of absence points you will need to specify the
scheduled start time. See the Absence Points Rules help topic for more
information.

Scheduled Finish The time of day the employee is scheduled to finish work or "punch
out". The scheduled finish time affects the following areas of the
system:

- If you configure rounding rules to round punches to the scheduled
finish time then you will need to specify the employee's scheduled
finish time. See the section on rounding in the Time Entry Rules help
topic for more information.

- If you are keeping track of absence points you will need to specify the
scheduled finish time. See the Absence Points Rules help topic for more
information.

Email The email address, up to 80 characters.

Phone The phone number, up to 40 characters.

Mobile The mobile phone number, up to 40 characters.

Fax The fax number, up to 40 characters.

Timesheet
Template

The timesheet template for this employee. Different employees can
have different timesheet templates, for example hourly workers may
use a template that has fields for tracking their in and out times on
specific tasks, whereas salaried workers might use a template that only
requires tracking the total hours spent on each task. Timesheet
templates are managed from the Templates page under the System
tab.

A blank value is allowed for the timesheet template, but the employee
will not get a "My Timesheet" tab when they log in to the application.
This may be desired in some cases, such as for an administrative
account, or an employee who needs to log into the application to review
and run reports on other employee's timesheets, but does not need
record their own time.
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Timesheet
Memory

New timesheets are created at midnight of the start of every new time
period. The timesheet memory setting allows you to specify whether
rows and hours are carried forward from the previous timesheet period
when the new timesheet is created. This can make it easier for your
employees to track their time if they commonly work on the same tasks
as appropriate rows will already be on the timesheet. 

The following timesheet memory options are available:
None New timesheets will be blank: no rows or hours will

be carried forward from the previous time period.
Note that even if no rows or hours are carried
forward from the previous period, the application
will still keep track of recently used projects, tasks,
materials, etc. in order to facilitate data entry.

Rows New timesheets will have the same rows as the
timesheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours New timesheets will have the same rows and hours
as the timesheet for the previous period. Only work
hours are carried forward - leave (or paid time off)
rows will carry forward, but not the hours.

Regardless of the timesheet memory setting, employees can manually
copy a previous timesheet via an option in the Tools menu on their
timesheet. You can hide this option from employees by turning off the
"Can copy previous timesheet hours" timesheet permission for the
employee's permission level. See the Permission Levels topic for more
information.

Hours Format The choice of how the employee enters hours, either decimal format
(for example 7.50) or hours:minutes (for example 7:30). 

Note: This setting does not affect the time format - whether a 12 or 24
hour clock is used is determined by the employee's locale setting.

Locale The locale is a geographic/language region that determines the
following:
 The language displayed, e.g. English, French, Spanish, etc.
 The formatting of dates and times. Note that in locations that use

12 hour time (e.g. the United States) you can optionally override
the locale preference and use 24 hour time. The employee can
change this on their Home > Preferences page.

 The formatting of numbers
 The list of company holidays for the selected location. Holidays  can

be configured to only apply to employees in specific time zones. See
the Holidays help topic for more information.

Note: The application will always assume the employee is in this locale,
rather than pick up the locale from the browser, for instance.

Time Zone The employee's time zone. When timesheet data is saved it will be
relative to this time zone. 

Note: The application will always assume the employee is in this time
zone, rather than pick up the time zone from the browser, for instance.



p80

© 2000-2023, Pacific Timesheet

Approver This is the primary approver for the employee. A primary approver can
review and approve or reject this employee's time entries and leave
requests (depending upon the approver's permission level). 

Primary approvers can also receive email reminders and notices when
there are timesheets or requests that need approving, or when
employees are late submitting their time. See the Notices help topic for
more information.

Note: Only employees with permission to approve will appear in the list
of possible approvers. If you do not see an employee in the list then
you may need to change that employee's permission level, or enable
the appropriate approval permission for their permission level. See the 
Security help topic for more information.

Approver Backup This is the backup approver for this employee. The backup approver has
the same capabilities as the primary approver, but will not receive the
approval email notices that are sent to the primary approver. It is a
good idea to assign a backup approver for times when the primary
approver is away or otherwise unavailable.

Notes

Clicking the Notes disclosure triangle allows you to review and enter notes about the
employee (up to 2000 characters).

Current Balances

Clicking the Current Balances disclosure triangle shows the list of current balances for the
employee. You can edit employee balances by clicking the current balance link. The 
Employee Balances topic has more information. Note that employee balances cannot be
edited unless your Permission Level has the "Can edit advanced properties" Employee
permission checked.

Group Membership

Clicking the Group Membership disclosure triangle shows the list of groups the employee is
a member of. The Employee Groups topic has more information about managing groups.

Calendar

Clicking the Calendar disclosure triangle shows the employee's calendar of holidays, leave
requests and other events.

Importing/Exporting Employees

You can import and export employee data using CSV (Comma Separated Values) format
files from the Employees tab. When importing data a good way to start is to do an export
first - this will generate a file you can use as a  template. Once you modify this file
(including removing unnecessary columns) to have your new data you can then import it
back into the application. See the Employee CSV Format help topic for more information on
the import file format.

Note: The default format is CSV but you can change this from the Home > Preferences
page.

Importing/Exporting Employee Balances

You can import and export employee balance data using CSV (Comma Separated Values)
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format files from the Employees tab. When importing data a good way to start is to do an
export first - this will generate a file you can use as a  template. Once you modify this file
(including removing unnecessary columns) to have your new data you can then import it
back into the application. See the Employee Balances CSV Format help topic for more
information on the import file format.

Note: The default format is CSV but you can change this from the Home > Preferences
page.

Custom Fields

Like all major objects in the application, you can customize them by creating new fields.
Choosing the 'Manage Custom Fields' option on the Employees tab will let you create a
variety of new fields or properties specific to your needs.

Related Topics

 Employee Balances
 Employee Groups
 Rate Options

-o-
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Employee Balances
Employee Balances

Employee balances are banks of hours that employees can accrue and use on their
timesheets, such as Vacation, Sick or Flex-time. Balances are associated with leave pay
codes: for instance if you have a Vacation pay code you can optionally have a Vacation
balance (see the Pay Codes topic has more information). Each balance can have its own set
of rules for how hours are accrued and how situations such as when the employee's balance
goes negative are handled. See the Balance and Accrual Rules help topic for more
information.

You can update an employee's balance from the Employee Details page by clicking the
Current Balances disclosure triangle, which shows the employee's balances as of the
current date. Clicking on the current balance link will load the Balance History page. The
Balance History page lists all changes made to the balance: the actual balance for any given
date is simply the total of all the balance changes up to that date. If you have appropriate
permissions you can modify the balance by adding, deducting or setting the balance for a
given date.

Note: In order to change an employee's balance you must have the 'Can edit advanced
properties' Employee permission. In addition, for security purposes, you can only delete
balance changes that you made. Only administrators (those with the 'Can manage all'
Employee permission) can delete balance changes made by others.

Making Bulk Changes To Employee Balances

If you need to update balances for a number of employees you can import the list of
changes using an import file. When importing data a good way to start is to export the
current employee balances via the Export Employee Balances option on the Employees tab -
this will generate a file you can use as a  template. Once you modify this file (including
removing unnecessary columns) to have your new data you can then import it back into the
application. The Managing Employees topic has more information.

-o-
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Employee Groups
Employee Groups

Employee Groups are lists of employees, and can be used for several purposes. You can
create employee groups that represent cost centers or divisions, for instance. These can
then be assigned to the appropriate employees as their Reporting Group (see the
Managing Employees help topic for more information). In addition, groups are used by
Pacific Timesheet for managing application permissions. For instance, rather than assigning
managers to specific employees you give the manager permission for a specific employee
group (the Security help topic has more information about configuring permissions).

Employee groups have the following properties:

Property Description

Name The group name, up to 80 characters. A value is required and must be
unique for all groups.

Description A description for the group, up to 255 characters.

ID The group ID, up to 80 characters. This value is not required, but if a
value is entered it must be unique for all groups. The value here is
commonly used when synchronizing with external systems such as
payroll processing.

Status The group status, either Active or Inactive. You can delete a group, but
often it is preferable to change its status to Inactive. This will keep it
from being used for new data entry, but allow it to be reported on for
historical purposes.

Type The group type allows you to control whether this groups shows up in
lists or pickers on various parts of the application:

 Permission groups are used to provide fine-grained control of
application security. For instance, you might create a Timekeeper
group that is composed of users who enter time for other employees.
All groups are always permission groups, regardless of whether they
are also used as reporting groups or crews.

 Reporting groups are groups that are assigned to employees in their
profile or properties page, and serve as the employee's current cost
center or department (you can rename the term "reporting group" as
appropriate for your organization from the System > General >
Terminology page). The reporting group value is automatically
recorded when an employee saves their time, making it easy to do
departmental or cost center reporting and costing. Enabling the
reporting group checkbox will allow the group to be selected on the
employee properties page, as well as on the timesheet if the group
field is configured for the timesheet template.

 Crews are groups of employees that can have their time recorded for
them by managers or timekeepers using the Crew Timesheet page.
Enabling the crew checkbox will allow the group to be selected on the
Crew Timesheet page (as well as the Crew Approval Kiosk).

Notes

Clicking the Notes disclosure triangle allows you to review and enter notes about the group
(up to 2000 characters).

Employees
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Clicking the Employees disclosure triangle allows you to review and edit the list of
employees belonging to this group. An employee can be in more than one group at the
same time. If you want to check if an employee belongs to more than one group you can
view their group membership on the specific employee's properties page.

Permissions

Clicking the Permissions disclosure triangle allows you to review and edit which employees
or employee groups have been given special permissions for this group. Typically you would
use this to assign an employee manager (someone with 'Can manage limited' Employee
permission) to this group in order to review and edit time or asset entries for employees
who are members of this group. See the Security help topic for more information.

Importing/Exporting Groups

You can import and export group data using CSV (Comma Separated Values) format files
from the Employees > Groups page. When importing data a good way to start is to do an
export first - this will generate a file you can use as a  template. Once you modify this file
(including removing unnecessary columns) to have your new data you can then import it
back into the application. See the Group CSV Format help topic for more information on the
import file format.

Note: The default format is CSV but you can change this from the Home > Preferences
page.

Custom Fields

Like all major objects in the application, you can customize them by creating new fields.
Choosing the 'Manage Custom Fields' option on the Employees > Groups page will let you
create a variety of new fields or properties specific to your needs.

-o-
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Employee Options
Employee Options

The Employee Options page allows administrators to configure various employee settings,
such as which fields are required to be entered when editing employees, etc.

Note: Employee options are global settings that will affect all users. Only administrators
will have access to the Employee Options page.

Note: The terminology of employees, groups and other objects can be changed via the 
System > General > Terminology page.

Required Fields

You can specify which fields are required when adding or editing employees.  By default
fields such as login name, last name, etc. are required, but for your use you may need
additional fields marked as required, such as the employee ID.

Employee Types

An Employee Type is an employee property that you define as a way to differentiate
different categories of employees, for example "Exempt" and "Nonexempt", or "Salaried"
and "Hourly".  You can define any number of employee types. Employee types have the
following properties:

Property Description

Label The display name of the employee type, up to 255 characters. For
example, "Hourly". This is the text shown in the user interface, as
well as in exported data.

Value The internal value for the employee type, up to 255 characters. For
example, "hourly". This is the text stored in the database and,
therefore, shown on reports. Generally you will want to use the same
value for Label and Value.

-o-
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Reports
Reports

Pacific Timesheet supports over 50 different reports. Reports are customizable, allowing you
to:

 Alter which data columns are displayed
 Alter the names of the data columns
 Alter data sorting
 Alter data filtering
 Publish your customized reports for other employees to use

In addition, most reports can be output in HTML, PDF, CSV and Excel formats.

Timesheet Reports

Report Description

Employee Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Pay Code
 Project
 Project Group
 Reporting Group
 Task
 Task Group

Pay Code Hours This report summarizes timesheet hours by pay code. You can
expand this report to further group hours by:
 Employee
 Project
 Project Group
 Reporting Group
 Task
 Task Group

Project Group Hours This report summarizes timesheet hours by project group. You
can expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Reporting Group
 Task
 Task Group

Project Hours This report summarizes timesheet hours by project. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project Group
 Reporting Group
 Task
 Task Group
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Reporting Group Hours This report summarizes timesheet hours by reporting group.
You can expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Task
 Task Group

Task Group Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Reporting Group
 Task

Task Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Reporting Group
 Task Group

Timesheet Details This report lists time entry details for a given date range. As
there are many time entry fields available to report on, you will
probably want to generate a custom version of this report to
show only the information you are interested in.

Create Custom
Timesheet Summary
Report

If the above timesheet summary reports do not group the data
in the format you like you can create your own custom
summary report. You can group by up to 5 different objects or
factors, including custom fields.

Leave Reports

Report Description

Employee Leave This report summarizes employee leave hours.

Employee Leave Details This report lists employee leave time entries in full detail.

Employee Reports

Report Description

Balance Activity This report summarizes changes to balances (sick, vacation,
etc.) for each employee.

Balance Activity Details This report lists details of each change to balances (sick,
vacation, etc.) for each employee.

Employee Attendance This report shows employee in/out times on a daily basis, as
well as indicating if employees are in compliance with their
scheduled in/out times. Any leave taken is also shown. See the 
Employee Attendance Report help topic for more information.
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Employee Details This report lists details for each employee, such as email, phone
numbers, etc.

Employee Pay Report This report shows pay data, such as RT/OT etc. hours and pay
amounts, using rates that depend on the type of hours. For
example OT hours can be configured to have a pay rate 1.5
times the RT pay rate. This report is a variation of the Profit
Report (see below), and for more information see the Profit
Report topic.

System Reports

Report Description

Audit Trail This report lists audit events for the given date range.

Logins This report lists employee logins (successful and unsuccessful)
for the given date range.

System Even Log This report lists information about system events such as sent
emails, scheduled imports and exports, etc.

Other Reports

Report Description

FTE Summary Report This report summarizes full time equivalent (FTE) hours in a
columnar format. For more information see the FTE Summary
Report topic.

Hours Summary Report This report summarizes timesheet hours in a columnar format.
For more information see the Hours Summary Report
(Columnar) topic.

Profit Report This report summarizes profit/loss based on pay amounts and
bill amounts. You can customize this report to break down the
data by employee, project, group, etc. For more information see
the Profit Report topic.

Report Properties

See the Report Properties help topic for information on standard report properties.

Reporting on Archived Data

Older time entry and asset entry data will eventually be moved into archival storage. You
can still report on archived data if you need to (e.g. for auditing purposes, etc.) by altering
the report's "Archive Settings" to target the archived data storage tables. The Data Archival
topic has more information on how the system archives data.

-o-
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Report Properties
Standard Report Properties

When creating or editing reports you can set the following report properties (not all of the
following properties apply to all reports):

Property Description

Name The report name or title, up to 80 characters.

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as the
template for creating this report.

Published If checked then this report can be run by other employees. You can
limit which employees can access a published report by clicking the
button to the right of the check box and selecting the appropriate
permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Page Size The page size for the report. Reports are designed for easy and
accurate printing, and this setting will determine how reports are
paginated.

Orientation The page orientation for printing, either Portrait or Landscape. For
reports with many columns you will generally want to specify
Landscape orientation.

Reporting Period The default time period for the report. The reporting period can be
overridden when running the report.

Report Columns The list of data columns to display on the report. In addition to being
able to add or remove any columns you like, you can also edit the
column heading.

Sort Columns The list of data columns to use for sorting. You can have multiple sort
columns, and sorting can be ascending or descending.
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Subtotal Columns You can optionally show subtotals for any of the report columns
(except for decimal or float columns, as subtotalling for these types of
columns would not make sense). Subtotals will break up the report
into sections with a subtotal for each specified subtotal column. You
can have multiple subtotal columns if needed, but you may only
choose from columns that are specified in the Report Columns
property.

As an example, suppose your data looked like this with no subtotal
columns specified:

Employee      Project    Task     RT    OT

------------------------------------------

Johnson, B.        P1      T1   8.00  1.50

Johnson, B.        P1      T1   8.00  0.00

Johnson, B.        P2      T2   8.00  0.00

Johnson, B.        P2      T2   8.00  0.00

Swayze, P.         P1      T1   8.00  0.00

Swayze, P.         P1      T2   8.00  2.00

==========================================

Total                          48.00  3.50

If you specified Employee.Name as the subtotal field then your report
would look like this:

Employee      Project    Task     RT    OT

------------------------------------------

Johnson, B.        P1      T1   8.00  1.50

Johnson, B.        P1      T1   8.00  0.00

Johnson, B.        P2      T2   8.00  0.00

Johnson, B.        P2      T2   8.00  0.00

------------------------------------------

    Subtotal for Johnson, B.:  32.00  1.50

Swayze, P.         P1      T1   8.00  0.00

Swayze, P.         P1      T2   8.00  2.00

------------------------------------------

    Subtotal for Swayze, P.:   16.00  2.00

==========================================

Total                          48.00  3.50

If you also wanted to see subtotals for projects you would add the
Project.Name column to the list of subtotal columns.
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Employee Filter If non-empty then the report will only show data for the Employees in
the list. You can override this value when running the report.

In addition to specifying individual employees, you can also specify
the following special employee filter values:

Filter Description

(Self) When you add "(Self)" to the Employee Filter only
data for the currently logged-in employee will be
shown (any other employees in the Employee Filter
will be ignored). This is useful for allowing
employees to run reports on only their own time
entries.

(Approvees) When you add "(Approvees)" to the Employee Filter
only data for employees that the currently
logged-in employee is an approver of will be shown
(any other employees in the Employee Filter will be
ignored). This is useful for allowing approvers to
run reports on just employees they can approve.
An approvee is any employee that the logged-in
user is set as a primary approver of in the
employee's profile.

Reporting Group
Filter

If non-empty then the report will only show data for the Groups in the
list. You can override this value when running the report.

Pay Code Filter If non-empty then the report will only show data for the Pay Codes in
the list. You can override this value when running the report.

Project Group Filter If non-empty then the report will only show data for the Project
Groups in the list. You can override this value when running the
report.

Project Filter If non-empty then the report will only show data for the Projects in
the list. You can override this value when running the report.

Task Group Filter If non-empty then the report will only show data for the Task Groups
in the list. You can override this value when running the report.

Task Filter If non-empty then the report will only show data for the Tasks in the
list. You can override this value when running the report.

-o-
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Employee Attendance Report
Employee Attendance Report

This report shows employee in/out times on a daily basis, as well as indicating if employees
are in compliance with their scheduled in/out times. Any leave taken is also shown. Note
that anyone running this report will only see employees they are permitted to report on
based on their permissions.

When creating or editing this report you can set the following properties:

Property Description

Name The report name or title, up to 80 characters (required).

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as the
template for creating this report.

Published If checked then this report can be run by other employees. You can
limit which employees can access a published report by clicking the
button to the right of the check box and selecting the appropriate
permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default time period for the report. The reporting period can be
overridden when running the report. 

Note: Due to the columnar nature of the report your date range will
be restricted to 31 days or less.

Report Columns The list of employee properties to display as columns on the report.
You can also show additional employee reporting group (or cost
center/department depending on your terminology) properties that
you may need to display.

Alerts You can optionally have the report compare employee in/out times
against scheduled times, and display discrepancies in color on the
report.

Employee Type
Filter

Use this filter to restrict the report to only employees of specific
types, e.g. "Hourly" employees. This acts as a default filter - the filter
can always be changed when running the report.

Employee Filter Use this filter to restrict the report to only specific employees. This
acts as a default filter - the filter can always be changed when
running the report. Note that anyone running this report will only see
employees they are permitted to report on based on their
permissions.

Reporting Group
Filter

Use this filter to restrict the report to only employees in specific
reporting groups (or cost centers/departments depending on your
terminology). This acts as a default filter - the filter can always be
changed when running the report. Note that anyone running this
report will only see reporting groups they are permitted to report on
based on their permissions.

-o-
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Hours Summary Report (Columnar)
Hours Summary Report (Columnar)

The Hours Summary Report (Columnar) allows you to summarize employee hours as a
series of columns. Each column represents an interval of time, such as monthly or quarterly.
This is an alternative to the other timesheet reports that list data in a row-oriented format.

When creating or editing this report you can set the following properties:

Property Description

Name The report name or title, up to 80 characters (required).

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as the
template for creating this report.

Published If checked then this report can be run by other employees. You can
limit which employees can access a published report by clicking the
button to the right of the check box and selecting the appropriate
permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default time period for the report. The reporting period can be
overridden when running the report. 

Note that, depending on the Report Interval, the actual start and
finish date of the report may not match the reporting period exactly.
For instance, if the reporting period is set to "Today" and the report
interval is "Yearly" then when the report runs it will snap the start
date to Jan 1 and the finish date to Dec 31 of the current year.

Due to the columnar nature of the report your date range may be
restricted in order to avoid producing too many columns: large
numbers of columns can adversely affect the system's performance.
For instance, you won't be able to a report with a daily interval for a
year as it would produce 365 columns and affect database
performance adversely. You can bypass these limits by specifying a
report filter, which will reduce the amount of data returned. The
report will give you a clear message when you exceed a reporting
period limit, and indicate to you which filter to set to increase the
limit.

Report Interval The report interval determines how the data is grouped into columns.
For instance, a monthly interval for a report being run over the
previous year would show 12 columns, one for each month. Possible
values for the report interval are: Daily, Weekly, Monthly,
Quarterly and Yearly.

Note that when the report runs it will always snap the start date and
finish date to encompass complete intervals, regardless of the 
Reporting Period chosen. For instance, if the reporting period is set
to "Today" and the report interval is "Yearly" then when the report
runs it will snap the start date to Jan 1 and the finish date to Dec 31
of the current year.
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Report Columns The list of data columns by which to group or summarize the report
data into rows (required). You can add or remove columns, and click
and drag to change the column order. The list of columns is limited to
data that can be recorded with time entries, such as employee and
project values, timesheet custom fields, etc. You must have at least
one but no more than 10 report columns.

Note that the report will automatically insert subtotal rows in the
report if you select more than one type of column. For instance, if
you have 2 columns, Project.Name and Employee.Name, then the
report will insert a subtotal row after each group of projects. If you
have 3 columns, Customer.Name, Project.Name and Employee.Name,
then the report will insert a subtotal row after each group of projects
and after each group of customers.

Summarize Choose which timesheet hours data you want to total or summarize
in the report. This can be All Hours, Work Hours or Leave Hours.
If you choose Work Hours or Leave Hours you can optionally limit the
hours to specific pay codes. For instance, if you choose only Over
Time and Double then the hours totalled on the report for each
interval column will be computed as SUM(Over Time + Double Time).

Submitted Filter Use this filter to restrict the report to only hours for timesheets that
are Submitted (locked), or only hours for timesheets that are Open
(unsubmitted). By default all timesheet data is reported on,
regardless of its submission status.

-o-
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FTE Summary Report
FTE Summary Report (Full Time Equivalent)

The FTE Summary Report allows you to summarize employee hours in full time equivalent
employee (FTE) units. The report formats FTE as a series of columns, where each column
represents an interval of time, such as monthly or quarterly. 

Using FTE units provides a way to measure how many full-time employees would be
required to perform the work done in your organization. An FTE is the equivalent of one
person working full time. Consider an employee working the following full time schedule:

8 hours / day
X 5 day / week
X 52 week / year
= 2,080 hours / year

One employee working full time would equal 1 FTE. Two people each working 4 hours per
day, 5 days per week would also equal 1 FTE. The FTE Summary Report computes the FTE
value by totalling the hours for each interval and dividing by the appropriate full time
equivalent hours. For instance, if the total hours against a project for 1 year was 3,120,
then the FTE would be computed as 3,120 / 2,080 = 1.5.

When creating or editing this report you can set the following properties:

Property Description

Name The report name or title, up to 80 characters (required).

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as the
template for creating this report.

Published If checked then this report can be run by other employees. You can
limit which employees can access a published report by clicking the
button to the right of the check box and selecting the appropriate
permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default time period for the report. The reporting period can be
overridden when running the report. 

Note that, depending on the Report Interval, the actual start and
finish date of the report may not match the reporting period exactly.
For instance, if the reporting period is set to "Today" and the report
interval is "Yearly" then when the report runs it will snap the start
date to Jan 1 and the finish date to Dec 31 of the current year.

Due to the columnar nature of the report your date range may be
restricted in order to avoid producing too many columns: large
numbers of columns can adversely affect the system's performance.
For instance, you won't be able to a report with a daily interval for a
year as it would produce 365 columns and affect database
performance adversely. You can bypass these limits by specifying a
report filter, which will reduce the amount of data returned. The
report will give you a clear message when you exceed a reporting
period limit, and indicate to you which filter to set to increase the
limit.
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Report Interval The report interval determines how the data is grouped into columns.
For instance, a monthly interval for a report being run over the
previous year would show 12 columns, one for each month. Possible
values for the report interval are: Daily, Weekly, Monthly,
Quarterly and Yearly.

Note that when the report runs it will always snap the start date and
finish date to encompass complete intervals, regardless of the 
Reporting Period chosen. For instance, if the reporting period is set
to "Today" and the report interval is "Yearly" then when the report
runs it will snap the start date to Jan 1 and the finish date to Dec 31
of the current year.

Report Columns The list of data columns by which to group or summarize the report
data into rows (required). You can add or remove columns, and click
and drag to change the column order. The list of columns is limited to
data that can be recorded with time entries, such as employee and
project values, timesheet custom fields, etc. You must have at least
one but no more than 10 report columns.

Note that the report will automatically insert subtotal rows in the
report if you select more than one type of column. For instance, if
you have 2 columns, Project.Name and Employee.Name, then the
report will insert a subtotal row after each group of projects. If you
have 3 columns, Customer.Name, Project.Name and Employee.Name,
then the report will insert a subtotal row after each group of projects
and after each group of customers.
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Full Time Equivalent This is the FTE hours per week used by the report to convert total
hours into FTE. Enter the number of hours per week that your
organization considers to be full time. For instance, a typical value in
North America would be 40. When the Report Interval is not weekly
then this value is converted to an appropriate amount for the interval
in the following manner:

Interval      FTE Per Period            Example

-----------------------------------------------------------

------

Daily         Weekly FTE / 5            8      = 40 / 5

Weekly        Weekly FTE                40     = 40

Monthly       (Weekly FTE * 52) / 12    173.33 = (40 * 52)

/ 12

Quarterly     (Weekly FTE * 52) / 4     520    = (40 * 52)

/ 4

Yearly        Weekly FTE * 52           2080   = 40 * 52

Note: If you are running this report for employees who work in
different countries or regions that have different FTE hours per week,
you can optionally specify an API Variable for the  Full Time
Equivalent. For instance, if you define an employee custom field to
hold the full time equivalent weekly hours as "FTE Hours", then you
could enter {User.xFTEHours} for Full Time Equivalent. When the
report runs it will look up this value for each report row and use it
when computing the FTE value for the given column. If
{User.xFTEHours} doesn't return a value then the system default will
be used (based on the System > General > Default Hours Per Day
multiplied by 5).

If using an API Variable make sure that the custom field is of type
Number, and that you specify the API Variable name exactly
(case-sensitive) enclosed in curly braces.

Entry Type Filter Use this filter to restrict the report to only Work hours or to only
Leave hours. By default all timesheet hours are included in the
report.

Submitted Filter Use this filter to restrict the report to only hours for timesheets that
are Submitted (locked), or only hours for timesheets that are Open
(unsubmitted). By default all timesheet data is reported on,
regardless of its submission status.

-o-
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Profit Report
Profit Report

This report summarizes profit/loss data based on pay amounts and bill amounts. You can
customize this report to break down the data by employee, project, group, etc. 

Note that all employee data will be shown in the employee's time zone, regardless of the
time zone of the person running the report. For instance, if the report is run  by a reporter
in the Pacific Time for Jan 1-Jan 7, it will correctly summarize data for an employee in
Brisbane using Jan 1 - Jan 7 Brisbane Time. This is different than other timesheet summary
reports that do not shift the data.

When creating or editing this report you can set the following properties:

Property Description

Name The report name or title, up to 80 characters (required).

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as the
template for creating this report.

Published If checked then this report can be run by other employees. You can
limit which employees can access a published report by clicking the
button to the right of the check box and selecting the appropriate
permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default time period for the report. The reporting period can be
overridden when running the report.

Grouping Columns The list of columns by which to group or summarize the report data
into rows (required). You can add or remove columns, and click and
drag to change the column order. The list of columns is limited to
data that can be recorded with time entries, such as employee and
project values, timesheet custom fields, etc. You must have at least
one but no more than 10 grouping columns.

Note that the report will automatically insert subtotal rows in the
report if you select more than one type of column. For instance, if
you have 2 columns, Project.Name and Employee.Name, then the
report will insert a subtotal row after each group of projects. If you
have 3 columns, Customer.Name, Project.Name and Employee.Name,
then the report will insert a subtotal row after each group of projects
and after each group of customers.
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Data Columns The list of data columns to summarize (required). You can add or
remove columns, and click and drag to change the column order. The
list of columns is limited to data that is numeric and can be recorded
with time entries, such as hours, leave, RT, OT, etc. You must have
at least one but no more than 25 data columns.

Some data columns are treated differently than in other timesheet
summary reports:

The "Time Entry.Pay Amount" and "Time Entry.Bill Amount"
columns are computed as the sum of the adjusted rate multiplied by
the hours. The pay rates and bill rates used in the calculation are
adjusted based on OT/RT/DT factors. For instance, OT hours are paid
at 1.5 times the RT rate. You can modify the rate factors by clicking
the Options button on the report. Note that the base or RT rate
values used are the rates in effect when the time entry was recorded:
the total amounts will be correct whether there was only one rate or
multiple rates used in the reporting interval.

The "Time Entry.Pay Rate" and "Time Entry.Bill Rate" columns
will show the unadjusted rate value (e.g. the base or RT rate). Note
that if more than one rate was used during the reporting interval
then the maximum rate during the interval will be shown.

The Calculation.Profit column will show the result of subtracting the
total pay amount from the total bill amount.

Submitted Filter Use this filter to restrict the report to only hours for timesheets that
are Submitted (locked), or only hours for timesheets that are Open
(unsubmitted). By default all timesheet data is reported on,
regardless of its submission status.
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Advanced Topics
Advanced Topics

Administration covers more advanced configuration settings, such as security settings and
customization.

Related Topics

 System Settings
 Pay Codes
 Templates
 Policies
 Security
 Notices
 Devices
 Schema
 Custom Fields
 Importing/Exporting
 Data Archival
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Administrative Overview
Administrative Overview

If you are setting up your timesheet system for the first time, the following settings should
be configured first:

 Week Start
 Default Time Zone
 Email Reply Address

These can be set on the System Settings page. These can be changed at any time, but it is
a best-practice to define these before you start creating new employees.

-o-
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System Settings
System Settings

The System page allows you to control application-wide settings, and is only accessible by
employees with a permission level that allows them to edit system settings, such as
Administrator. The following properties can be set:

Property Description

Default Week Start The default first day of the week, for instance Sunday
or Monday. This is the default value for employees, but
you can have as many different time periods with
different week starts as needed by your organization.
For instance, one group of employees could use a
timesheet template that has a period starting on
Sunday, while another group could use a template that
starts on Monday. See the Time Periods help topic for
more information on time periods, and the Templates
help topic for more information on timesheet templates.

Default Hours Per Day The default number of work hours in a day. This value
is used when putting leave and holidays on timesheets.
In addition, this value is used when displaying how
many days of balance are available on the employee's
home page. This is the default value, but you can
override this value for each employee by setting the
Scheduled Hours Per Day property on each employee's
profile. See the Managing Employees help topic for
more information.

Default Locale The default locale for new employees. A locale is a
language/country combination that determines the
formatting of dates, currency and numbers. All
diagnostic and audit log information is formatted using
the default locale, too.

Default Time Zone The default time zone for new employees.

Base Currency The base currency for application. This will be the
default currency when displaying or prompting for
currency amounts. In addition, asset entries (for
example expense entries), if configured to allow entry
of cost amounts in local currencies, will convert the
entered values into the base currency, for ease of
reporting.

Note that the list of available currencies can be
modified from the System > System Options page. See
the System Options topic for more information.

Outgoing Email (SMTP) Server The host name or IP address of your outgoing email
server. Specify a value here in order to enable the
application to send email notifications such as
timesheet events or forgotten password requests. 
Self-hosted version only.

Port The port number for your SMTP server. The default is
25.



p103

© 2000-2023, Pacific Timesheet

Security If your SMTP server is using connection security you
will need to select the appropriate value here. Your
options are:
None No connection encryption

TLS Transport Layer Security encryption

SSL Secure Socket Layer encryption

Login Name The optional login name for the outgoing email server. 
Self-hosted version only.

Password The optional password for the outgoing email server. 
Self-hosted version only.

Reply Address The email reply address for notifications sent by the
application. This is required if you have specified the
outgoing email server address.

Note that you may want to use a "no reply" email
address, e.g. "noreply@someco.com", if you want to
make it clear to your employees that they should not
respond to the automated email notices sent by the
application.

Spam note: Be careful what address you use for the
reply address. Some destination email servers will
reject the email notices sent by Pacific Timesheet if the
reply address is for a different domain than that of the
email server used to send the email.
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Audit Level The audit level controls the amount of auditing the
system performs. All audit events can be reported on
using the Audit Report, available from the Reports tab.
The following audit levels are provided:

Audit Levels

None No auditing

Standard Standard auditing, which includes
the following audit controls:
 Logging successful and

unsuccessful login attempts,
including their IP address

 Logging login name and
password changes

 Logging audit setting changes
 Logging user creation,

modification and deletion
 Logging timesheet deletion

High (DCAA) Full Defense Contract Audit Agency
(DCAA) auditing. This provides the
following additional audit controls
over the Standard audit level:
 Logging of any changes made to

an employee's timesheet by
another employee (for example
their manager).

 Logging of any changes an
employee makes to their own
timesheet if the time entry is
more than 24 hours in the past.

 Timesheets require approval
 Comments must be recorded

when timesheets are approved,
rejected, or resubmitted for
approval.

 For more information see http://
www.dcaa.mil/

Audit Days The number of days to keep audit data (maximum
365). Note that audit data, especially if using the high
(DCAA) level, can consume a considerable amount of
storage.

Application URL The base address for this application, for example
http://hostname/timesheet. This is used when
formatting links in email notices and other messages.
For instance, the notice variable ${System.url} will be
replaced with this value (see the Notices topic for more
details). Self-hosted version only.

Send Test Email

After configuring your email server settings it is a good idea to send a test email. The email
will be sent to the same address as the reply address.

Related Topics
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 Work Breakdown Structure
 Time Periods
 Holidays
 Work Shifts
 Approval Levels
 Rate Options
 Terminology
 Branding
 Data Integration
 System Options
 System Tools
 License
 System Lists
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Work Breakdown Structure
Work Breakdown Structure

The work breakdown structure (WBS) is used to organize work into a series of components,
such as projects, phases, tasks, etc. You can define up to 5 components, and name each
level as you need. For instance, your organization might have the following WBS:

Client > Project > Phase > Task

Or

Task > Labor Code

WBS components have the following properties:

Property Description

Enabled Indicates whether the WBS component is enabled.

Dependent By default, components in the WBS structure are independent of each
other, and are essentially flat lists.  By enabling dependency on a
WBS component, you can restrict the list of items presented to your
employees to just those for the selected parent component,
eliminating a common source of data entry errors. With dependency
enabled the WBS structure can more resemble a tree structure.

There are two types of dependency settings: Optional and Required.
Optional dependency means items that do not have a parent specified
for them will be visible regardless of which parent is selected by the
employee.  However, items with one or more parents will only be
visible if those parents are selected.

Required dependency means any item without a parent will not be
visible.  You must assign each item a parent if you want employees to
be able to select it.

Note: For large lists of items (>50K) it is highly recommended that if
you enable dependency you make it required.  This will drastically
improve performance of pick lists.

See the Dependencies section below for more information.

Name The singular name of the component, for example "Client".

Plural The plural name of the component, for example "Clients".

Dependencies

Dependencies allow you to limit or scope which items can be added to a timesheet based on
a previous selection in the WBS structure. For instance, you might want to limit some
projects to specific customers. To do this you would select the appropriate "Dependent"
selection from the Dependent menu:
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Selecting "Yes" indicates that a project depends on the parent component above it, in this
case the customer. Now when you view the properties for a project (from the Tasks >
Projects page) you will see a Customers section:

If you leave the Customers section blank (no restrictions) then this project will be not be
visible if "Yes - Parent Required" was chosen.  If "Yes - Parent Optional" was selected and
there were no parents specified, this project would always appear regardless of the selected
customer. This allows you to have 'global' components that are always available, whether a
parent selection is made or not. To limit this project to one or more specific customers click



p108

© 2000-2023, Pacific Timesheet

the Add button and add the appropriate customers. Then, when employees browse for
projects to add to their timesheet, they will not see this project unless one of the customers
in the list is selected first.

Note that dependencies take effect on the timesheet page, as well as for reports that allow
you to filter based on customers, projects, etc., such as the "Timesheet Details" report.

Translations

The terminology you enter should be appropriate for the default language of your system
(as configured on the System > General page).  You can provide translations for up to 4
additional languages by clicking the globe icon next to each terminology row.  Users will see
the appropriate translation based on the Locale setting in their employee profile (as
configured in their employee record on the Employees tab).
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Time Periods
Time Periods

Time periods are used to define common timesheet and reporting periods. You can define as
many different time periods as you need. Once defined, they can be used when editing and
creating Timesheet Templates, or when running reports. The following types of time periods
are supported:

Type Description

Weekly 7 day time period, with your choice of the first day of the week.

Biweekly 14 day time period, with your choice of the first day of the week.

Semimonthly Semi-monthly time period, typically the 1st through the 15th, and the
16th through the end of the month.

Quadweekly 28 day time period, with your choice of the first day of the week.

Monthly Monthly time period, with your choice of the first day of the month.

Custom Custom time periods, where each time period can be a different
number of days.
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Holidays
Holidays

The Holidays page lets you define your company holidays. The following properties can be
set for each holiday:

Property Description

Name The name of the holiday, up to 80 characters. You should keep this as
short as reasonably possible, however, to better fit it on timesheets
and dashboards.

Description A description for the holiday, up to 255 characters.

Date The date of the holiday.

Repeat If this holiday recurs then select the appropriate value. For instance,
for New Years you could set the date to January 1, 2009 and choose a
repeat value of "Yearly on this date". For the U.S. holiday
Thanksgiving you could set the date to November 27, 2009 and
choose a repeat value of "Yearly on the 4th" Thursday of November.

Partial Day Check this option to create a partial day holiday. For instance, you
might have a half-day holiday on New Year's Eve. The actual number
of hours pushed onto employee timesheets will be determined by
their Scheduled Hours Per Day property on the Employees page
(or, if the employee property is not set, the Hours Per Day property
on the System > General page). For example, if the employee is
scheduled to work 8 hours per day, a half-day holiday would result in
4 hours being placed on the timesheet.

Locale You can limit the holiday to a specific set of locales or countries. If
this list is empty then there is no locale limitation. See the Managing
Employees topic for more information on employee locales.

Groups You can limit the holiday to a specific set of employee groups. If this
list is empty then there is no group limitation.
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Work Shifts
Work Shifts

The Work Shifts page lets you define your company work shifts. Work shifts affect how
much an employee is paid by applying a pay differential when working in certain shifts. The
following properties can be set for each shift:

Property Description

Name The name of the shift, up to 80 characters.

Description An optional description for the shift, up to 255 characters.

ID An optional unique identifier for the shift, up to 80 characters.

Start Time The start time for the shift, for example "8:00 AM".

Finish Time The finish time for the shift, for example "5:00 PM".

Valid Days The days of the week for which the shift is valid, such as Monday
through Friday.

Shift Differential The differential rate used to calculate a shift premium when
working in the shift, for example "0.25". If the employee's base
pay was $20/hour, the shift differential would result in a real pay
rate of $25/hour.

Once you have created your shifts you will still need to activate them per employee policy
from the System > Policies page. See the Wage Rules topic for more information.

Additional Configuration: Shift Over Time

If you need to track how much regular time, overtime and double time was spent in shifts,
you will need to do some additional configuration. You will need to create 3 custom
timesheet fields as follows (from the System > Templates > Custom Fields page):

Field Name Description

Shift Regular Time Type = Number, decimal digits = 2

Shift Over Time Type = Number, decimal digits = 2

Shift Double Time Type = Number, decimal digits = 2

The name of the custom field must be exactly the same as shown above. However, once you
have created the custom field, you can later rename it as desired without affecting the
system. Once you have defined these fields then any regular time, over time or double time
hours that fall in a shift will be placed into these fields.
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Approval Levels
Approval Levels

You can define multiple timesheet approval levels. Many organizations require additional
approval levels to handle different work flows. For instance, you might have a manager
approval, a billing approval and a payroll approval. Creating separate approval levels can
facilitate any work flows that are triggered by the approval process.

Approvals are optional - you do not need to have any approval levels enabled if your
organization does not require timesheet approvals. A maximum of four (4) approval levels
are supported.

The following properties can be configured for each approval level:

Property Description

Enabled Indicates whether the approval level is enabled.

Display Name The name for the approval level, up to 40 characters. Names should
be as short as possible, and not include the word "approval" or
"approved" as that will often be redundant in places where approval
information is displayed by the application. A blank name is allowed,
but if you have more than one approval level enabled the names must
be unique.

Applies To You can specify which areas of the application the enabled approval
level is applicable. For instance, you might want 2 levels for time
approval, but only one level for project approval.

Enabled approval levels always apply to time (e.g. timesheet approval
on the Approvals > Timesheet Approvals page), leave requests
(approval from the Leave Requests page) and assets (approval of
asset entries and sheets, from the Assets > Asset Entries page).
You can optionally enable the level for projects if you intend on doing
project approval (e.g. approval from the Approvals > Project Time
Approvals page).
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Rate Options
Bill/Pay Rate Options

Rate options allow you to control how bill and pay rates are specified when an employee
saves their time. Pacific Timesheet has a very flexible bill and pay rate engine that allows
you to configure your rates to depend on not just the employee or the project, but to have
rates that also depend on tasks, jobs and cost centers.

Note: Changes to rate options take effect for the current timesheet period and will not
affect previously submitted timesheets.

The following properties can be configured for bill and pay rates:

Property Description

Rates Depend On The type of object that rates primarily depend on, for example
Employees, or Projects.

Make Exceptions For The type of object for which you may need to make exceptions to
the primary rate. For instance, if your organization's bill rate
depends primarily on Projects, then you might make exceptions
for certain Employees.

Billable/Payable Flag On The object that has the billable/payable flag. A common example
is to have the billable flag on Tasks, so that certain tasks can be
marked as non-billable.

Rates Apply Only For The type of hours for which these rates are applicable. Bill rates
would generally only apply to work hours, whereas pay rates
might apply to both work and leave (in other words, paid leave).

Different organizations have different rules for how bill and pay rates are specified. For
instance, when keeping track of project bill rates you might configure bill rates as follows:

Rates Depend On: Projects
Make Exceptions For: Employees

Billable/Payable Flag On:Tasks
Rates Apply Only For:Work Hours

In the above example the default bill rate is set on the project. Employees can be given
specific bill rates on projects, overriding the default rate. Tasks have a billable flag, allowing
the creation of tasks that are non-billable. Time recorded against a non-billable task will
have a bill rate of zero, regardless of the project or employee bill rate.

Standard Rates

When specifying bill and pay rates you have the option of using named values, rather than
specifying an actual numeric rate. By assigning a named value to a set of employees, for
instance, you can later change the named value's rate and all of the employees will pick up
the new value. Rates have the following properties:

Property Description

Name The rate name, up to 80 characters. A value is required and
must be unique for all rates.

Rate The hourly rate, in the base currency. The base currency is
specified from the System Settings page.
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Status The rate status, either Active or Inactive. You cannot delete
rates that are currently assigned to employees. Setting the
rate to inactive will prevent the rate from being assigned to
new employees.
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Terminology
Terminology

You can override the default terminology for a number objects and phrases in the
application. Make sure when changing the terminology that you specify both singular and
plural versions to avoid confusion.

Translations

The terminology you enter should be appropriate for the default language of your system
(as configured on the System > General page).  You can provide translations for up to 4
additional languages by clicking the globe icon next to each terminology row.  Users will see
the appropriate translation based on the Locale setting in their employee profile (as
configured in their employee record on the Employees tab).
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Branding
Branding

Branding allows you to customize the application suit your organization. You can specify the
following properties:

Property Description

Company Name The name of your company or organization. The company name can
be used in email notices sent by the application.

Application Name The application name. The application name appears in several places
in the product, including the window title and email notices sent by
the application.

Application Logo The application logo, which appears in the upper-left corner of the
page. Supported formats are PNG, GIF and JPG, and the image size
can be at most 320x100 (320 pixels in width and 100 pixels in
height). 

Note that when you upload an application logo file a copy of it will be
stored in the database: the uploaded file is no longer needed by the
application.

Clicking the Restore Defaults button will reset the properties to their factory settings -
make sure you click the OK button after clicking Restore Defaults to confirm the change.
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Data Integration
Data Integration

Data Integration allows you to enable and configure the external data and device integration
facilities provided by Pacific Timesheet. The following integration types are provided:

Integration Type Description

Timesheet Export Configure timesheet export settings, such as which time
entry fields are exported, etc. See the Export Options topic
for more information.

Timesheet Export - Time Bank Time Bank software provides integration with most popular
payroll, HR and general ledger applications. Over 250
systems are supported, and you can find out more by
contacting your sales representative or visiting our website
at https://www.pacifictimesheet.com/.

QuickBooks Interchange File
(IIF)

QuickBooks IIF file support allows you to export your
timesheets into QuickBooks for both invoicing and payroll.
See the QuickBooks Export File help topic for more
information.

Employee Export Configure regularly scheduled exports of employee data.
See the Export Options topic for more information.

Group Export Configure regularly scheduled exports of group data. See
the Export Options topic for more information.

Auto-Import Directory The auto-import directory allows you specify a folder that is
monitored for CSV files that will be automatically imported
into the system. See the Auto-Import Directory help topic
for more information.

LDAP/Active Directory LDAP/Active Directory support allows you to use an LDAP or
Active Directory server for authentication, as opposed to
the built-in application authentication. For more information
see the Security topic.

Barcode Scanner Barcode scanner support allows you to use Codereadr
barcode scanning apps/devices for employee in/out, asset
tracking and other applications.  For more information see
the Barcode Scanner Support topic.

Time Clock Device Time clock device support allows you to integrate with
external time clock devices, such as those provided by
ACTAtek. For more information see the Devices topic.

Web Services API The web services API allows you to send and receive
timesheet, employee, project and other information with 
Pacific Timesheet. System administrators can learn more
about this topic by logging into the customer support portal
and searching for "REST API" to locate and download the
REST API document.
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Timesheet Export Options
Timesheet Export Options

The Timesheet Export Options page allows you to configure how time sheet data is
exported. You can enable and define multiple export configurations, which is useful if you
need to export to more than one system, for example payroll and billing. The following
options are provided:

Options Description

Name You can name the export, which is useful if you have more than one
defined export. For example you might name one 'Payroll' and the other
'Billing'. The name can be up to 80 characters in length.

Description A description of the export configuration, up to 255 characters.

Enabled If checked then this export will show up in the list of available exports in
the Timesheets and Approvals tabs.

Clip to Date
Range

Check this option to clip time entries to the selected date range when
exporting. This option is useful if you are exporting time entries for time
periods different than the timesheet period. You would want to check this
option, for instance, if timesheets have weekly periods but you export to
payroll semimonthly.

Exported Fields Select the data fields to export, as well as their order. This option is useful
if you need to integrate data with external systems such as payroll
processing, etc. For example, SurePayroll systems require the following 6
fields in this order:

TimeEntry.Date
Employee.ID
Employee.Last Name
Employee.First Name
Pay Code.ID
TimeEntry.Hours

You can create a customized export fields by adding Expression Fields. See
the Expression Fields help topic for more information.

Custom
Header

For some external systems you may want a special header at the
beginning of the export file, rather than the standard list of field names.
For example, SurePayroll systems require the following two lines at the
start of the file:

TC
00001
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Pay Code
Rollup

Normally a timesheet export will have one record in the export file for each
time entry on an employee's timesheet. You can use the following Pay
Code Rollup options to modify this:

Rollup time entries by pay code:

This option will summarize or total the hours by pay code for each
employee timesheet. For instance, let's suppose employee Jeff worked 4
days of regular time and 1 day of vacation, and had 5 time entries on his
timesheet. The export file would show only two rows for Jeff:

Jeff, RT, 32.00
Jeff, Vacation, 8.00

As you can see above, the 5 time entries have been rolled up or
summarized into two rows. If Jeff had worked on only one pay code in the
week then there would only be one row in the export file for him. If Jeff
had worked on 3 pay codes in the week then there would be 3 rows in the
export file for him.

Split time entries by pay code:

This option will split a time entry into multiple rows if there is more than
one pay code value for the time entry. For instance, let's suppose Jeff had
worked 41 hours in the week, with 9 hours on Friday (8 regular time and 1
overtime). He had 5 time entries on his timesheet. The export file would
show 6 rows:

Jeff, Mon, RT, 8.00
Jeff, Tue, RT, 8.00
Jeff, Wed, RT, 8.00
Jeff, Thu, RT, 8.00
Jeff, Fri, RT, 8.00
Jeff, Fri, OT, 1.00

As you can see above, the Friday time entry has been split into two records
in the export file, for a total of 6 records for Jeff.

Date Format Select the date format you want to use for exported date and date-time
fields. The following characters specify how the dates are formatted:
d Day in month. Use dd to always output a two-digit day of

month, e.g. "01".
M Month. Use MM to always output a two-digit month, e.g.

"01".
y Year. Use yy to always output a two digit year, e.g. "14".

Use yyyy to always output a 4 digit year, e.g. "2014".

Time Format Select the time format you want to use for exported time and date-time
fields. The following characters specify how the times are formatted:
h Hour in day using 12 hour clock (1 - 12). Use hh to

always output a two-digit hour, e.g. "01".
H Hour in day using 24-hour clock (0 - 23). Use HH to

always output a two digit hour, e.g. "01".
m Minute in hour. Use mm to always output a two-digit

minute, e.g. "01".
a A.M. or P.M.
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Timesheet Export Schedule

You can automate timesheet exporting using the timesheet export scheduling feature. This
allows you to export timesheets to a file on the server (or network drive) where Pacific
Timesheet is installed (self-hosted only), or to an FTP server. The following options are
provided:

Options Description

Schedule
Enabled

Check this option to enable scheduled timesheet exporting.

Schedule The schedule or frequency for timesheet exporting. The time period can be
any created in the System > General > Time Periods page. To specify the
exact time within the time period when the export occurs you specify an
offset (in hours:minutes) from the start or end of the time period. For
instance, if you want to export  timesheets at 4:30 PM (16:30) on the last
day of the time period, you would specify "7:30 hh:mm before the period
ends".

Next Run As you modify the schedule, this property will update to show when the
next export will occur.



p121

© 2000-2023, Pacific Timesheet

Export To You have several options for where you can send the export file:

Directory The export file will be sent to a directory on the
computer's local file system, e.g. "c:\exports"
(self-hosted only).

FTP Server The export file will be sent to a remote directory
using the FTP protocol.

Web Directory The export file will be sent to the customer's web
directory, e.g.
"https://someco.pacifictimesheet.com/customers/som
eco".

If you choose "FTP Server" the following properties must be configured by
clicking the settings button that appears to the right of the menu:

FTP Server The host name or IP address of the FTP server.
Login The user account or login name for the FTP server.
Password The password for the login, above.
FTP Directory The directory where export files will be created, e.g.

"/" or "/tmp". FTP server paths start with a forward
slash, and backslashes are not valid. If blank, the
root directory will be used, which is equivalent to "/".

FTP Port The port number for the FTP server, where 21 is the
default value for most FTP servers.

FTP Mode Check this option to enable passive mode, which aids
when transferring files through firewalls.

Security If the FTP server has connection security enabled you
will need to set the appropriate value here. Your
options are:
None No connection encryption

Implicit SSL Implicit Secure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

Directory The directory on the computer or FTP server where the export file will be
created. If the "Export To" property is set to "Directory" then this is the file
path to the directory where the export file will be created, e.g. "/tmp",
"c:\exports" or "\\morpheus\\c\exports". The path must be valid for the
server that Pacific Timesheet is installed on.

If the "Export To" property is set to "FTP" then this is the directory on the
FTP server where you want the export file created, e.g. "/" or "/tmp". FTP
server paths start with a forward slash, and backslashes are not valid.

File Name The name of the export file, e.g. "timesheets-for-payroll". The "Append
timestamp" option will add the date and time of the export to the file
name, e.g. "timesheets-for-payroll.200908150831". Note that the file
extension will automatically be added when the export file is created,
based on the Format property, described below. For CSV format, the file
extension ".csv" will be added to the file name. For MS Excel format, the
file extension ".xls" will be added to the file name.

Format The format of the export file, either comma-separated-values (CSV) or
Microsoft Excel (XLS). 
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File Encryption You can optionally encrypt the export file using PGP (Pretty Good Privacy).
If you choose this option you need to specify the following options:

Encryption Key The public encryption key to use when encrypting the
export file. Click the settings button to the right of
the menu to import and manage your encryption
keys. An encryption key is required.

Armor Check this option to output the encrypted file in
armored ASCII format, rather than binary format.
The file will have the '.asc' file extension appended to
it.

When the file encryption is set to PGP the export file will have the '.pgp'
file extension appended to the file name. If the armor option is selected
then the file will also have the '.asc' extension added to  it, so the export
file will end in '.pgp.asc'.

Time Period The time period to use when searching for timesheets to export. For
example, you might schedule the export to occur weekly, but want to
export the previous week's timesheets.

Status Select a value if you want to only export timesheets with a particular
status, such as submitted or approved.

Group Select a value if you want to only export timesheets for employees in a
particular group.

Export Status Select a value if you want to only export time entries that are either
unexported or exported. Time entries are only marked as exported if the
"Mark as Exported" option is selected (described below).

Mark as
Exported

Checking this option will mark each exported time entry as having been
exported. This works in conjunction with the "Export Status" filter option,
described above.

-o-
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Expression Fields
Expression Fields

You can create custom export fields using Expression Fields.  Expression fields allow you to
access and combine a large number of variables for export using simple JavaScript syntax.
For instance, you can combine RT and OT using an expression such as:

{TimeEntry.payCode1}+{TimeEntry.payCode2}

Or you could combine the customer, project and task names into one field:

{TimeEntry.customerId.name}+"."+{TimeEntry.projectId.name}+"."+{TimeEntry.taskI

d.name}

Expressions must evaluate to either a number or string (text) value, as per the usual rules
of JavaScript.  For instance, the following expression would evaluate to a number:

{TimeEntry.hours}+100

But the following expression would evaluate to a string:

{TimeEntry.hours}+" hours"

Note 1: null variable values will be converted to a blank value if the variable type is
string, or to zero if the variable type is a number.

Comparisons and Logical Operations

You can use JavaScript comparison and conditional operators.  For example, you could
output an employee custom field value depending upon a pay code ID:

if ({TimeEntry.payCodeId.uid}=="maternity")
    {TimeEntry.userId.xMaternityAccount};
else
    "";

You can also compare numeric values:

if ({TimeEntry.hours}>8.0)
    "OT";
else
    "RT";

Note 2: You should not use the "return" JavaScript keyword.  Instead, the expression
should just evaluate to a single value.

Debugging Scripting Errors

If your expression has a syntax error then the cause will outputted to the export file (as a
string).  Even if the syntax is correct, you could encounter errors in the evaluated
expression if your data is not valid (for example, you divide by zero).  You will want to put
any proper checks in place in the expression to avoid this (you can even use try/catch
exception handling if warranted).
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Time Entry Export Variables

Here is a partial list of variables you can refer to in your expression.  Note that all variables
must be enclosed in "{" and "}".

Variable Data
Type

Description

{TimeEntry.date} Date Date of time entry. Note that you can control
the formatting of this using a pattern argument
- see the section below on Date Formatting.

{TimeEntry.start} Date-time Date and time of start of time entry. Note that
you can control the formatting of this using a
pattern argument - see the section below on
Date Formatting.

{TimeEntry.finish} Date-time Date and time of finish of time entry. Note that
you can control the formatting of this using a
pattern argument - see the section below on
Date Formatting.

{TimeEntry.hours} Numeric Total hours for time entry.

{TimeEntry.type} Text Type of time entry, either 'Work' or 'Leave'.

{TimeEntry.workHours} Numeric Same as hours if type is 'Work', zero otherwise.

{TimeEntry.leaveHours} Numeric Same as hours if type is 'Leave', zero otherwise.

{TimeEntry.payCode1} Numeric Regular hours.

{TimeEntry.payCode2} Numeric Overtime hours.

{TimeEntry.payCode3} Numeric Double-time hours.

{TimeEntry.payCode4} Numeric Triple-time hours.

{TimeEntry.userId.fullName} Text Full name (last, first) of employee for this
entry. You can also use the alias
{User.fullName}.

{TimeEntry.userId.uid} Text ID of employee for this entry. You can also use
the alias {User.uid}.

{TimeEntry.userId.login} Text Login name of employee for this entry. You can
also use the alias {User.login}.

{TimeEntry.groupId.name} Text Name of group (department/crew) for this
entry. You can also use the alias
{Group.name}.
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{TimeEntry.groupId.uid} Text ID of group (department/crew) for this entry.
You can also use the alias {Group.uid}.

{TimeEntry.payCodeId.name} Text ID of pay code for this entry. You can also use
the alias {PayCode.name}.

{TimeEntry.payCodeId.uid} Text ID of pay code for this entry. You can also use
the alias {PayCode.uid}.

{TimeEntry.customerId.name} Text Name of customer for this entry. You can also
use the alias {Customer.name}.

{TimeEntry.customerId.uid} Text ID of customer for this entry. You can also use
the alias {Customer.uid}.

{TimeEntry.projectGroupId.na
me}

Text Name of project group for this entry. You can
also use the alias {ProjectGroup.name}.

{TimeEntry.projectGroupId.uid
}

Text ID of project group for this entry. You can also
use the alias {ProjectGroup.uid}.

{TimeEntry.projectId.name} Text Name of project for this entry. You can also use
the alias {Project.name}.

{TimeEntry.projectId.uid} Text ID of project for this entry. You can also use the
alias {Project.uid}.

{TimeEntry.taskGroupId.name
}

Text Name of task group for this entry. You can also
use the alias {TaskGroup.name}.

{TimeEntry.taskGroupId.uid} Text ID of task group for this entry. You can also use
the alias {TaskGroup.uid}.

{TimeEntry.taskId.name} Text Name of task for this entry. You can also use
the alias {Task.name}.

{TimeEntry.taskId.uid} Text ID of task for this entry. You can also use the
alias {Task.uid}.

You may also refer to any object's custom fields, using the appropriate variable name.  For
example, the "Maternity Account" custom field on an employee object would have a variable
name like this:

{TimeEntry.userId.xMaternityAccount}

You can get the variable name of any custom field from the custom field properties page for
the appropriate object.

Time Sheet Export Variables

Variable Data
Type

Description
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{TimeSheet.start} Date-time Date and time of start of sheet period for the
time entry being exported. Note that you can
control the formatting of this using a pattern
argument - see the section below on Date
Formatting.

{TimeSheet.finish} Date-time Date and time of finish of time sheet period for
the time entry being exported. Note that you
can control the formatting of this using a
pattern argument - see the section below on
Date Formatting.

Aliases

Many expression variables can be replaced with shortcuts or aliases. For example,
TimeEntry.projectId.uid can be replaced with Project.uid, or TimeEntry.userId.fullName can
be replaced with User.fullName. You will want to use the full expression variable name when
there is ambiguity about which field to refer to.  For example, to get the full name of the
user who submitted the time you would use TimeEntry.lockerId.fullName, or to get the full
name of the first approver you would use TimeEntry.apprv1Id.fullName.

Date Formatting

You can control the formatting of dates, times and date-times by adding a date format
pattern as an argument to the variable. The format of this pattern is the Java Simple Date
Format Pattern, described here:

https://docs.oracle.com/javase/10/docs/api/java/text/SimpleDateFormat.html

If you want to format a date variable you would add a date pattern argument after the
variable name. For instance, to format a date variable as YYYY-MM-DD you would do the
following:

{TimeEntry.start,yyyy-MM-dd}

The date pattern argument follows a comma after the name of the variable. Make sure the
argument is contained within the '}', and you cannot use the '{', '}' or ',' characters in date
patterns.

-o-

 

https://docs.oracle.com/javase/10/docs/api/java/text/SimpleDateFormat.html
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QuickBooks Online Export Options
QuickBooks Online Data Integration

Intuit QuickBooks Online (QBO) allows the importing of timesheet data (called Time
Activities in QBO) from an external source. Pacific Timesheet provides a QBO-compatible
timesheet integration that allows the transfer of employee timesheet data directly into QBO.
Once transferred, the time activities can then be  used for invoicing, payroll and reporting
from within QBO.

Note 1: The Pacific Timesheet connection to QBO is configured from the System >
General > Data Integration > Timesheet Export - QuickBooks Online page. If you do
not see the "Timesheet Export - QuickBooks Online" option on this page it means you have
already enabled both of the first two Timesheet Exports. You will need to disable the
second Timesheet Export in order to see the Timesheet Export - QuickBooks Online option.

Note 2: Pacific Timesheet will only upload time activities to your QBO account. It will not
modify objects such as employees, customers, etc. in your QBO system. Your QBO account
is considered the system of record for employees, customers, etc. and for data safety
Pacific Timesheet will not modify your QBO account except to upload time activities.

To connect to a QuickBooks Online account you will need to configure the following
properties in Pacific Timesheet (from the System > General > Data Integration >
Timesheet Export - QuickBooks Online page):

Property Description

Enabled Check this option to enable exporting of timesheet data from Pacific Timesheet to
QBO. When enabled you will see an "Export - QuickBooks Online" item in the
options menu on the Timesheets and Approvals tabs.

Authenticated Click the "Click to Authenticate" link to connect to your QBO account and allow
access to it from Pacific Timesheet. For security, after 100 days you will be asked
to re-authenticate. You can either do this from the System > General > Data
Integration > QuickBooks Online page, or when manually synchronizing or
uploading data (you will be prompted automatically if the authentication has
expired).

Note that for auto-synchronization and auto-export of data you will need to go to
the System > General > Data Integration > QuickBooks Online page every 100
days to re-authenticate, or the background process will fail. You and other
administrators will be given a warning when the authentication is going to expire
on the Home page several days before the expiration. If you are not using the
auto-synchronization or auto-export options then you can re-authenticate when
you manually synchronize or export timesheet data.
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Mapping Mapping allows you to specify how objects in QuickBooks are mapped to objects in
Pacific Timesheet. You can additional specify whether objects in QuickBooks are
synchronized (downloaded from QuickBooks) and created in Pacific Timesheet.

QB Object Pacific Timesheet Object
Employee QB employees always maps to Pacific Timesheet employees.
Vendor QB vendors/contractors always map to Pacific Timesheet

employees.
Customer QB customers can be mapped to any Pacific Timesheet WBS

object, but are generally mapped to the customer object.
Project QB projects should be mapped to the Pacific Timesheet WBS

object that is dependent on the project object. Additionally, as
you can reuse project names in QB under different customers,
you need to enable the "Allow duplicate project names" option on
the Projects > Project Options page.

If you do not use projects in QB (this is a QB advanced setting
option) then you can set the mapping to 'blank' and projects will
be ignored.

Service Item QB service items can be mapped to any Pacific Timesheet WBS
object, but are generally mapped to the task object.

Each mapping that has synchronization enabled will result in a custom field named
"QBO ID" being created for the mapped object in Pacific Timesheet. For instance, if
you enable synchronization for employees, every employee in Pacific Timesheet
will have a QBO ID field that is automatically filled in when the data is
synchronized. The value in this field should NOT be modified and should be
considered read-only.

Last
Synchronized

Clicking the "Synchronize Now" link will download objects from QB and create (or
update, if changed) the correspondingly mapped object in Pacific Timesheet. Only
objects with the "Synchronize" option checked in the mapping table will be
downloaded.

Note that if your authentication has expired you will be automatically asked to
authenticate again upon clicking the "Synchronize Now" link.

Timesheet Export:

When "Timesheet Export - QuickBooks Online" is enabled, you will see the "Export -
QuickBooks Online" option under the "tools" menu (triangle button) on both the Timesheets
and Approvals tabs. Choosing this option will prompt you if you want to export the listed
timesheets to QBO. Note that only submitted (locked) timesheets can be uploaded to QBO.

Successfully uploaded timesheets will be marked as exported. However, some timesheet
data might be skipped or generate an error for the following reasons:

 Timesheets or timesheet data that have already been exported will not be re-exported
and are ignored.

 Timesheets for employees in Pacific Timesheet that have no corresponding employee,
contractor or vendor in QBO will be ignored.

 Time entries in Pacific Timesheet with no customer specified will result in an error and
not be uploaded. The customer field is a required field and should be configured as such
for timesheet templates. The selected customer for a time entry must match an
customer object in QBO or an error will result.

 Project and service items are optional, but if a value is selected then it must match the
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corresponding object in QBO or an error will result.

-o-
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QuickBooks Desktop Export Options
QuickBooks Export File

Intuit QuickBooks Pro allows the importing data from an external source. Pacific Timesheet
provides a QuickBooks-compatible timesheet export file that you can use to transfer time
activities directly into QuickBooks for both invoicing and payroll. The format of the file is the
Intuit Interchange Format (IIF), and uses the Timer Activity import feature of QuickBooks.

Note: More advanced QuickBooks integration, including bi-directional transfer of jobs,
employees and codes, is supported through the Time Bank data integration facility. You
can find out more by contacting your sales representative or visiting our website at 
https://www.pacifictimesheet.com/.

To set up your system for proper export you will need to configure the following properties:

Property Description

Enabled Check this option to enable the QuickBooks export file support. When
enabled you will see an "Export - QuickBooks" item in the options menu
on the Timesheets and Approvals tabs.

Company The QuickBooks company name. This value is found by doing a Timer
Activity Export from QuickBooks, as detailed below.

Company Create
Time

The QuickBooks company create time. This value is found by doing a
Timer Activity Export from QuickBooks, as detailed below.

Template The QuickBooks timer activity export file template. This is detailed
below.

You can control which time entries are exported by specifying any of the following filters:

Property Description

Billable Filter Use this filter to export only billable or non-billable hours. You might use
this filter if you are only using QuickBooks for billing, for instance.

Payable Filter Use this filter to export only payable or non-payable hours.

Hours Filter Use this filter to only export work hours or leave hours.

Employee Filter Use this filter to only export specific employee types.

Getting the Company Name and Create Time

The first step to configuring your system for proper QuickBooks exporting is to determine
the Company name and Company Create Time. To do this you need to start QuickBooks Pro
and run the Timer Lists export under the File > Utilities > Export menu. Save this file to a
convenient location and open it with a text editor such as Notepad or Wordpad. Look for
lines like the following: 

!TIMERHDR VER REL COMPANYNAME IMPORTEDBEFORE FROMTIMER
COMPANYCREATETIME
TIMERHDR  7  0 ArpentN Y 1165339129

The TIMERHDR line has the Company name and Company Create Time values we need. In
this case the Company name is Arpent, and the Company Create Time is 1165339129.

The TIMERHDR fields are:
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VER The version number of the QuickBooks Timer, for example 7. You can
find this information by first running an Timer Activity export in
QuickBooks and viewing the output. You will need to modify the
template replacing the example value with your specific value.

REL The release number of the QuickBooks Timer. You can find this
information by first running an Timer Activity export in QuickBooks and
viewing the output. You may need to modify the template to replace the
example value with your specific value, otherwise QuickBooks may
generate a warning message when importing the data.

COMPANYNAME The name of your QuickBooks company. If you leave this as
${System.company} it will be automatically substituted with the
Company property entered above.

FROMTIMER Indicates whether you are exporting or importing data.  It should always
be the value "Y".

COMPANYCREATE
TIME

A unique number that comes from your QuickBooks Pro company file. 
You can find this information by first running an Timer Activity export in
QuickBooks and viewing the output. You will need to modify the
template replacing the example value with your specific value.

Configuring the Template

The export file generated by Pacific Timesheet will contain the TIMERHDR records above, as
well as TIMEACT records for each timesheet's time entries. The format of a TIMEACT might
look like the following:

!TIMEACT DATE JOB EMP ITEM PITEM DURATION PROJ NOTE
XFERTOPAYROLL BILLINGSTATUS
TIMEACT 3/25/08 ABCompany:Job 123 Bill Williams Support 02:00

N 1

The TIMEACT fields are:

DATE The date the activity was performed, formatted as YYYY-MM-DD (the
standard QuickBooks date exchange format). This is generally set to the
variable ${TimeEntry.date}, described below.

JOB The QuickBooks job, which is in the format Customer:Job. This is
generally set to the variable ${Customer.name}:${Project.name},
described below.

EMP The name of the employee. This is meant to map to the QuickBooks
employee name and must match exactly. Outputted as "Lastname,
Firstname" by default. This is generally set to the variable
${User.name} or ${User.fullName}, described below.

ITEM The name of the service item assigned to the activity. This is generally
set to the variable ${Task.name}, described below.

PITEM The name of the payroll item. This is generally set to the variable
${PayCode.name}, described below.

DURATION This is the duration of the activity in hours and minutes, in HH:MM
format. This is generally set to the variable ${TimeEntry.hours},
described below.

NOTE This field contains the timesheet cell notes. Note that any newline or
tab characters will be replaced with a space on the export. This is
generally set to the variable ${TimeEntry.notes}, described below.

XFERTOPAYROLL "N" if not for payroll, or "Y" if for payroll.
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BILLINGSTATUS Indicates the billing status of the activity, either "1" for billable, or "0"
for non-billable. By default populated with the Task billable status. This
is generally set to the variable ${TimeEntry.billFlag}, described below.

You can control which values from Pacific Timesheet are substituted into the TIMEACT
records by editing the template. The following template variables are supported (and are 
case-sensitive):

Variable Description

${TimeEntry.date} The date of the time entry, formatted as YYYY-MM-DD (the
standard QuickBooks date exchange format). This is generally
used for the DATE field of a TIMEACT record.

${TimeEntry.dateUS} Just like ${TimeEntry.date}, only formatted as M/DD/YY.  Some
older versions of QuickBooks require this format.

${TimeEntry.hours} The time entry hours, formatted as hours:minutes (the standard
QuickBooks hours format). This is generally used for the
DURATION field of a TIMEACT record.

${TimeEntry.notes} The time entry notes, if any. This is generally used for the NOTE
field of a TIMEACT record.

${TimeEntry.billFlag} The time entry billable flag, with the value "0" if the time entry is
not billable, or "1" if the time entry is billable.

${Customer.name} The name of the Customer for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Customer to
something else (e.g. Client), you still use Customer.name for the
variable name.

${User.name} The name of the employee, formatted "Lastname, Firstname". This
is generally used for the EMP field of a TIMEACT record.

${User.fullName} The name of the employee, formatted as "Firstname Lastname".
This is generally used for the EMP field of a TIMEACT record.

${User.id} The ID of the employee. This is generally used for the EMP field of
a TIMEACT record.

${Customer.id} The ID of the Customer for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Customer to
something else (e.g. Client), you still use Customer.id for the
variable name.

${ProjectGroup.name} The name of the Project Group for this time entry. This is
generally used for the JOB or ITEM field of a TIMEACT record. Note
that even if you customized the terminology and renamed Project
Group to something else (e.g. Client Portfolio), you still use
ProjectGroup.name for the variable name.

${ProjectGroup.id} The name of the Project Group for this time entry. This is
generally used for the JOB or ITEM field of a TIMEACT record. Note
that even if you customized the terminology and renamed Project
Group to something else (e.g. Client Portfolio), you still use
ProjectGroup.id for the variable name.

${Project.name} The name of the Project for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Project to
something else (e.g. Job), you still use Project.name for the
variable name.
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${Project.id} The ID of the Project for this time entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Project to something
else (e.g. Job), you still use Project.id for the variable name.

${TaskGroup.name} The name of the Task Group for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Task Group
to something else (e.g. Phase), you still use TaskGroup.name for
the variable name.

${TaskGroup.id} The ID of the Task Group for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Task Group
to something else (e.g. Phase), you still use TaskGroup.id for the
variable name.

${Task.name} The name of the Task for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Task to something
else (e.g. Activity), you still use Task.name for the variable name.

${Task.id} The ID of the Task for this time entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Task to something else
(e.g. Activity), you still use Task.id for the variable name.

${PayCode.name} The name of the Pay Code for this time entry. This is generally
used for the PITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Pay Code to
something else, you still use PayCode.name for the variable name.

${PayCode.id} The ID of the Pay Code for this time entry. This is generally used
for the PITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Pay Code to something
else, you still use PayCode.id for the variable name.

Note that when using the .name variables you need to be careful to match the names in 
Pacific Timesheet with the names in QuickBooks. If your names in Pacific Timesheet cannot
be made identical to those in QuickBooks you will want to use the ID field instead. Change
the appropriate template fields to use the .id variables instead, then update the ID property
of the employees, projects or other objects in Pacific Timesheet with the name as it appears
in QuickBooks.

Exporting To QuickBooks

Once you have configured the company name, company create time and template as
needed, you can generate the QuickBooks export file. To do this click on the Timesheets or
Approvals tab in Pacific Timesheet and list the timesheets you are interested in exporting.
Click the options menu (the icon button with a small triangle to the upper-right of the
timesheet list) and choose the "Export - QuickBooks" item. Save the resulting file to the
appropriate location on your computer. 

Next, start QuickBooks Pro, then go to the File > Utilities > Import > Timer Activities and
import the file you just saved. QuickBooks will import the data and generate a detailed
report of the import results. You can import data as often as your needs require, but be
careful not to import the same file twice as QuickBooks will generate duplicate timer
activities.

-o-
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Export Options
Export Options

The Export Options page allows you to configure and schedule automatic exporting of
employees, groups, projects, tasks and other system object. The data can be exported in
either CSV or XLS format, and sent to either a directory (for the self-hosted version only) or
to an FTP server. 

Note: Cloud systems support auto-exporting to FTP sites only (via FTP/FTPS protocol).
Self-hosted systems can additionally auto-export to file system directories.

The following options are provided:

Options Description

Schedule
Enabled

If checked then the export will automatically run on a recurring schedule.

Schedule The automatic export schedule, which can be daily at a specified time of
day.
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Export To You have the option of exporting to a directory on the computer running
the Pacific Timesheet service (self-hosted only), exporting to an FTP (File
Transfer Protocol) server, or to a Dropbox folder. 

If you choose "FTP Server" the following properties must be configured by
clicking the settings button that appears to the right of the menu:

FTP Server The host name or IP address of the FTP server.
Login The user account or login name for the FTP server.
Password The password for the login, above.
FTP Directory The directory where export files will be created, e.g. "/"

or "/tmp". FTP server paths start with a forward slash,
and backslashes are not valid. If blank, the root directory
will be used, which is equivalent to "/".

FTP Port The port number for the FTP server, where 21 is the
default value for most FTP servers.

FTP Mode Check this option to enable passive mode, which aids
when transferring files through firewalls.

Security If the FTP server has connection security enabled you will
need to set the appropriate value here. Your options are:
None No connection encryption

Implicit SSL Implicit Secure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

If you choose "Dropbox" you can export the data to a Dropbox folder of
your choosing.  Click the "Link New Account" button to open a web page
that gives you the option to allow Pacific Timesheet to access the Dropbox
account (you will be prompted to log into Dropbox if not already logged
in). When you click "Allow" you will be given an authorization code.  Select
and copy this code, then switch back to Pacific Timesheet and enter the
authorization code into the dialog.

Once you have saved the configuration, Pacific Timesheet will create a
"PacificTimesheet" folder within the "Apps" folder in the Dropbox account.  
Pacific Timesheet will only be able to upload files to this folder.  You can
further specify a sub-folder within this folder: for instance, if you specify a
sub-folder named "exports" then there would be an
"/Apps/PacificTimesheet/exports" path created in the Dropbox account,
and all export files would be uploaded to that folder.
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Directory The directory on the computer or FTP server where the export file will be
created. If the "Export To" property is set to "Directory" then this is the
file path to the directory where the export file will be created, e.g. "/tmp",
"c:\exports" or "\\morpheus\\c\exports". The path must be valid for the
server that Pacific Timesheet is installed on.

If the "Export To" property is set to "FTP" then this is the directory on the
FTP server where you want the export file created, e.g. "/" or "/tmp". FTP
server paths start with a forward slash, and backslashes are not valid.

If the "Export To" property is set to "Dropbox" then this will be the
optional sub-folder within the Dropbox account to upload the export files
to.  The sub-folder will be created directly under the
/Apps/PacificTimesheet folder of the Dropbox account.  If left blank then
export files will be uploaded to the /Apps/PacificTimesheet folder of the
Dropbox account.

File Name The name of the export file, e.g. "employees". The "Append timestamp"
option will add the date and time of the export to the file name, e.g.
"employees.200908150831". Note that the file extension will automatically
be added when the export file is created, based on the Format property,
described below. For CSV format, the file extension ".csv" will be added to
the file name. For MS Excel format, the file extension ".xls" will be added
to the file name.

Format The format of the export file, either comma-separated-values (CSV) or
Microsoft Excel (XLS). 

File Encryption You can optionally encrypt the export file using PGP (Pretty Good Privacy).
If you choose this option you need to specify the following options:

Encryption Key The public encryption key to use when encrypting the
export file. Click the settings button to the right of the
menu to import and manage your encryption keys. An
encryption key is required.

Armor Check this option to output the encrypted file in armored
ASCII format, rather than binary format. The file will
have the '.asc' file extension appended to it.

When the file encryption is set to PGP the export file will have the '.pgp'
file extension appended to the file name. If the armor option is selected
then the file will also have the '.asc' extension added to  it, so the export
file will end in '.pgp.asc'.

Status Filter Select a value if you want to only export objects that are active or
inactive.

Timesheet
Filter

This appears only for Employee exports. Select a value if you only want to
export employees who have a timesheet (that is, the Timesheet property
in their employee profile is not blank).

Exported Fields Select the data fields to export, as well as their order.

Custom Header For some external systems you may want a special header at the
beginning of the export file, rather than the standard list of field names.

-o-

 



p138

© 2000-2023, Pacific Timesheet

Auto-Import Directory
Auto-Import Directory

The auto-import directory provides another way for you to import data into Pacific
Timesheet. When CSV files are dropped into the auto-import directory they will be
automatically imported into the system. The format of the import files is exactly the same
as when you import through the web browser. For information about the CSV import file
format see the Importing/Exporting topic.

Note: Cloud systems support auto-importing from FTP sites only (via FTP/FTPS protocol).
Self-hosted systems can additionally auto-import files from file system directories.

To set up a directory for auto-importing you need to configure the following properties:

Property Description

Enabled Check this option to enable auto-importing.
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Import From You have the option of importing from a directory on the computer running
the Pacific Timesheet service (self-hosted only), importing from an FTP
(File Transfer Protocol) server, or importing from a Dropbox folder. 

If you choose "FTP Server" the following properties must be configured by
clicking the settings button that appears to the right of the menu:
FTP Server The host name or IP address of the FTP server.
Login The user account or login name for the FTP server.
Password The password for the login, above.
FTP Directory The directory where export files will be created, e.g.

"/" or "/tmp". FTP server paths start with a forward
slash, and backslashes are not valid. If blank, the
root directory will be used, which is equivalent to "/".

FTP Port The port number for the FTP server, where 21 is the
default value for most FTP servers.

FTP Mode Check this option to enable passive mode, which aids
when transferring files through firewalls.

Security If the FTP server has connection security enabled
you will need to set the appropriate value here. Your
options are:
None No connection encryption

Implicit SSL Implicit Secure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

If you choose "Dropbox" you can import the data from a Dropbox folder of
your choosing.  Click the "Link New Account" button to open a web page
that gives you the option to allow Pacific Timesheet to access the Dropbox
account (you will be prompted to log into Dropbox if not already logged
in). When you click "Allow" you will be given an authorization code.  Select
and copy this code, then switch back to Pacific Timesheet and enter the
authorization code into the dialog.

Once you have saved the configuration, Pacific Timesheet will create a
"PacificTimesheet" folder within the "Apps" folder in the Dropbox account.  
Pacific Timesheet will only be able to see files within this folder.  You can
further specify a sub-folder within this folder: for instance, if you specify a
sub-folder named "imports" then there would be an
"/Apps/PacificTimesheet/imports" path created in the Dropbox account,
and only that folder would be scanned for import files.
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Directory The directory on the computer or FTP server from where the export files
will be imported. If the "Import From" property is set to "Directory" then
this is the file path to the directory where the import files will be replaced,
e.g. "/tmp", "c:\imports" or "\\morpheus\\c\imports". The path must be
valid for the server that Pacific Timesheet is installed on.

If the "Import From" property is set to "FTP" then this is the directory on
the FTP server from where you want to read the import files, e.g. "/" or
"/tmp". FTP server paths start with a forward slash, and backslashes are
not valid.

If the "Import From" property is set to "Dropbox" then this will be the
optional sub-folder within the Dropbox account to scan for import files. 
The sub-folder will be created directly under the /Apps/PacificTimesheet
folder of the Dropbox account.  If left blank then files will be scanned for in
the /Apps/PacificTimesheet folder of the Dropbox account.  Import files in
folders below the specified sub-folder will be ignored - only the top level
will be scanned.

When Finished This option determines what to do to the file when finished, so that it will
not be reprocessed. The following options are available:

Delete Delete the file after successfully importing the data.
Rename Rename the file by appending ".fin" after successfully

importing the data.

File Naming

Import files need to be named in a specific way in order for the system to know how to
process it: 

1. The file name must end is ".csv"

2. The file name must start with the type of objects being imported, then a hyphen, then
the key field, and finally a hyphen:

objects-keyfield-*.csv

The first part, 'objects', is the type of objects being imported, such as employees or tasks.
The next part, 'keyfield', is the object property to use to avoid creating duplicates, for
instance name or id. The '*' is a wild-card indicating that any valid file name text can
appear after the hyphen. For example, to import employees using the login name as the key
field the following file name would be appropriate:

employees-login-myemployees.csv

The following tables lists the objects that can be imported, along with their supported key
fields.

General Imports:

Object Key Fields Notes
employees login, id,

email
If you renamed employees using the terminology feature then
use your plural terminology, making sure to remove spaces, if
any, in the name. For example: "resources-login-.csv",
"resources-login-xyz.csv", etc.
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employeebala
nces

(none) No key field needed. 

If you renamed employees using the terminology feature then
replace 'employee' with your singular terminology, making sure
to remove spaces, if any, in the name. For example:
"resourcebalances-.csv", "resourcebalances-xyz.csv", etc.

groups name, id
timesheets (none) No key field is needed in the file name, but if the import file

specifies the ID column then that will be used to match to a
possible previously existing entry.

File name examples: "timesheets-.csv", "timesheets-xyz.csv",
etc.

billrates (none) No key field needed. For example: "billrates-.csv",
"billrates-xyz.csv", etc.

payrates (none) No key field needed. For example: "payrates-.csv",
"payrates-xyz.csv", etc.

Work Breakdown Structure (WBS) Imports:

Object Key Fields Notes
customers name, id If you renamed customers using the terminology feature then

use your plural terminology, making sure to remove spaces, if
any, in the name. For example: "clients-name-.csv",
"clients-name-xyz.csv", etc.

projectgroups name, id If you renamed project groups using the terminology feature
then use your plural terminology, making sure to remove
spaces, if any, in the name. For example:
"portfolios-name-.csv", "portfolios-name-xyz.csv", etc.

projects name, id If you renamed projects using the terminology feature then use
your plural terminology, making sure to remove spaces, if any,
in the name. For example: "jobs-name-.csv",
"jobs-name-xyz.csv", etc.

taskgroups name, id If you renamed task groups using the terminology feature then
use your plural terminology, making sure to remove spaces, if
any, in the name. For example: "phases-name-.csv",
"phases-name-xyz.csv", etc.

tasks name, id If you renamed tasks using the terminology feature then use
your plural terminology, making sure to remove spaces, if any,
in the name. For example: "activities-name-.csv",
"activities-name-xyz.csv", etc.

Asset Imports:

Object Key Fields Notes
assets name, id If you renamed assets using the terminology feature then use

your plural terminology, making sure to remove spaces, if any,
in the name. For example: "jobmaterials-name-.csv",
"jobmaterials-name-xyz.csv", etc.

assetclasses name, id If you renamed assets using the terminology feature then use
your plural terminology, making sure to remove spaces, if any,
in the name. For example: "jobmaterialclasses-name-.csv",
"jobmaterialclasses-name-xyz.csv", etc.
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assetentries (none) No key field is needed in the file name, but if the import file
specifies the ID column then that will be used to match to a
possible previously existing entry.

If you renamed assets using the terminology feature then use
your plural terminology, making sure to remove spaces, if any,
in the name. For example: "jobmaterialentries-.csv",
"jobmaterialentries-xyz.csv", etc.

Note that these file naming conventions are case-insensitive!

Logging and Error Handling

An import log file will be generated in the auto-import directory, with details about what was
imported, and any errors that might have occurred. Up to 7 days of log files will be
generated - older ones will be deleted automatically. 

If any errors occur during the import, the import file will be renamed by appending ".err" to
the file. 

-o-
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Barcode Scanner Support
Barcode Scanner Support

Pacific Timesheet supports barcode reader software and devices from Codereadr (
codereadr.com).

Barcode Settings

Settings are system-wide properties that affect all barcode scanning services:

Property Description

Enable Codereadr
support

Check this option to enable support for Codereadr barcode scanning.  If
not enabled then all Codereadr barcode scans will be ignored by Pacific
Timesheet.

Enable diagnostic
logging

Check this option to enable diagnostic logging.  When checked, detailed
information on each barcode scan submitted to Pacific Timesheet will be
written to the System Event Log.  Log entries can be viewed from the
Reports > System > System Event Log report.

Note that this setting is generally used only when initially configuring a
new Codereadr service.  It will automatically turn itself off after 7 days,
to avoid cluttering the system event log.

Barcode Services

Services correspond to Codereadr services.  Administrators need to create a service entry in
Pacific Timesheet for each Codereadr service that will be sending scans to Pacific Timesheet.
Services have the following properties:

Property Description

Service ID The Codereadr Service ID (required).  When a barcode scan is sent to
Pacific Timesheet it will identify itself with a Codereadr Service ID, and
there must be a matching service in Pacific Timesheet in order to process
the scan.  There are at least a couple of ways to identify the service ID of
your Codereadr service:  go to codereadr.com and 1) list your services
(Services tab) and click on a service and you will see the Service ID in the
address bar of your web browser, or 2) list your scans (Scans tab) and
click the View Postback Log link below a scan to see the service ID.

Active Check this option to enable this service.  If not enabled then barcode
scans with this Service ID will be ignored by Pacific Timesheet.

Description A description of this barcode service (required, up to 255 characters).  The
value you enter here should help you more easily identify the
corresponding service in Codereadr, as Codereadr doesn't show service
IDs prominently.

http://www.codereadr.com/


p144

© 2000-2023, Pacific Timesheet

Field Mapping Codereadr scans are sent to Pacific Timesheet as a list of data fields. 
These fields must be mapped to corresponding Pacific Timesheet fields.  A
typical mapping might look like this:

Codereadr Field/Question ID Pacific Timesheet Field
scanid Scan ID
tid Employee.ID
timestamp Timestamp
1355861 Punch
1355862 Project.ID
1355863 Task.ID

Note 1: "scanid", "tid" and "timestamp" are required field mappings.

Note 2: The Codereadr field names are case-sensitive!  For instance,
"Scanid" will not match, and must be lower-case "scanid".

Note 3: If certain questions are required, such as the Project, then you
must set the corresponding field on the employee's timesheet template to
be required.  This is done on the System > Templates page in Pacific
Timesheet.

Note: changes to these Pacific Timesheet settings can take up to 30 seconds to take effect.

Codereadr Service Configuration

Log into codereadr.com to create your barcode scan service.  The type of service you will
create is "Postback URL (Real-Time)":

Service type: Postback URL (Real-Time)

Postback URL: <hostname>/timesheet/codereadr

For example, if your Pacific Timesheet cloud system URL is
https://xyzco.pacifictimesheet.com then the Codereadr postback URL would be: 

https://xyzco.pacifictimesheet.com/timesheet/codereadr

When creating your service questions, the first question should be the "punch" status
(first to avoid having the keyboard on the phone popping up), and the possible answers
must be "In" or "Out" (case-insensitive).

After specifying your punch status question, you can then have zero or more barcode
questions that would map to a Pacific Timesheet project, task, etc.

The following Advanced settings are generally also enabled:

[x] Enable  Kiosk Mode:

{

  "pin":"1234",

  "stop_auto_next":"true",
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  "manual_input":"true"

}

[x] Enable custom display configuration:

{

  "value_label":"Badge",

  "response_hidden":"false"

}

L

-o-
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Time Clock Devices
Time Clock Devices

Pacific Timesheet supports time and attendance tracking using hardware access devices,
such as models provided by ACTAtek (www.actatek.com).

The following devices are supported:

Manufacturer Model

ACTAtek
www.actatek.com

 PIN
 Smart Card
 Fingerprint
 Combination

ZK Software
usa.zksoftware.com

 PIN
 Smart Card
 Fingerprint
 Facial
 RFID

Devices have the following properties:

Property Description

Name The device name, up to 80 characters. A value is required and
must be unique.

Description A description of the device, up to 255 characters.

Enabled This determines whether the device will be periodically (every
5 minutes or so) synchronized. Synchronization is where
device attendance information is converted to employee
timesheets.

Work Codes Are For clocks that support entering work codes, this allows you
configure how work codes are mapped to Pacific Timesheet
objects. For instance, you might want work codes to map to
tasks.

IP Address The TCP/IP address of the device.

Secure Connection This option determines whether a secure or encrypted
connection is used when the Pacific Timesheet software
synchronizes with the device. For ACTAtek devices this means
SSL.

Login ID The administrator login ID for the device. For ACTAtek devices
this is case-sensitive.

Password The administrator login password. This is always
case-sensitive.

Last Synchronization The date and time Pacific Timesheet last successfully
synchronized with the device.

Adding Devices

There are two types of time clocks that Pacific Timesheet supports: 1) poll devices and 2)
push devices. For poll devices (such as ACTAtek) Pacific Timesheet must periodically request
attendance information by communicating with the time clock. In order to do this it must
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know the IP address of the time clock. Push devices (such as ZK Software) work in an
opposite manner and send attendance data to Pacific Timesheet whenever someone
accesses the device. This requires configuring the device with the address of the Pacific
Timesheet server.

Push Devices (ZK Software, etc.)

1. The first step will be to install your time clock device and configure it with the address of
your Pacific Timesheet service. Once you have done this and have the time clock running, it
will automatically register itself with the Pacific Timesheet software.

2. Go to the System > Devices page and you should see an entry for the new clock. For
security reasons, the device will be disabled, and you must enable it before it will start
receiving attendance data from the device.

Poll Devices (ACTAtek, etc.)

1. The first step will be to install your time clock device and configure its IP address. If you
are using ACTAtek devices the ACTAtek Devices topic has more information.

2. Go to the System > Devices page and click the Add button. Fill in the name, address and
other settings as appropriate for the device. You can test the connection by clicking the
"Test Connection" button. When finished click the OK button.

3. If Pacific Timesheet can communicate successfully with the device you will see a status of
"Ready". If you see otherwise you will generally find the problem to be a network connection
issue (wrong IP address, no network connection, etc.). The first step to troubleshoot the
problem is to issue a "ping" command from a console on the machine running the Pacific
Timesheet software, for example "ping 192.168.0.100".

Synchronization

For poll devices (such as ACTAtek) Pacific Timesheet will read the attendance information
from each enabled device, usually about every 5 minutes. For push devices (such as ZK
Software) attendance information is sent to Pacific Timesheet as they happen. In order for
proper synchronization to work it is necessary for the employee's login ID or PIN for the
device match one of the following 3 employee properties in Pacific Timesheet :

1. The employee login name.
2. The employee ID.
3. The "Time Clock ID" custom employee field. If the login ID used for the time clock is not
appropriate for either the employee login or employee ID in Pacific Timesheet, then you can
create a custom text field named "Time Clock ID" (via the Employees tab > Manage Custom
Fields option). If this field is present then the device synchronization will try to match
against this field to find the appropriate Pacific Timesheet employee.

Some devices can record a group ID with each attendance record. Each group ID should
have a corresponding group in Pacific Timesheet with the same name or ID for proper
synchronization.

Some devices can record a work code or ID with each attendance record. Each work code or
ID should have a corresponding object in Pacific Timesheet with the same name or ID for
proper synchronization. You specify which type of Pacific Timesheet object maps to work
codes via the "Work Codes Are" device property, described above.

Note: You can check for synchronization errors by viewing the synchronization log for each
device. From the System > Devices page click the name link to see the details of the
device. At the bottom of the page is the most recent synchronization messages.
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ACTAtek Devices
ACTAtek Devices

First Time Setup

Follow these steps to set up your ACTAtek device for the first time. If using multiple time
clocks please see the note at the end of this topic:

1. Connect the power and network cable to the device. The installation instructions that
came with the package cover this in detail.

2. Configure the IP address of the device. You will want to use a fixed (static) IP address.
Press the menu button on the device, which is the second button down from the top-right
corner of the keypad. You  will be prompted to log in - use the following values:

Login ID A999

Login Password 1

Press the arrow buttons on the bottom row of the keypad to move the selection to the "IP
Setting" menu, then press the enter button (the lower-right-most button on the keypad).
Then change the following values:

Subnet Mask The subnet mask, for example 255.255.255.0

DHCP Turn this off since we are using a fixed IP address

IP Address The TCP/IP address of this device, for example
192.168.0.100

Gateway The default gateway, for example 192.168.0.1

The network protocol used by the ACTAtek device is HTTP/HTTPS, so you may need to make
sure that those ports are allowed if any firewalls are between the device and the Pacific
Timesheet software.

The remaining setup steps will be performed from the device's web-based administration
interface.

3. Using a browser, enter the administration web page address for this device:

http://192.168.0.100

Replace the IP address above with the value appropriate for yours. Log in as the Super
Admin with the following values:

Login ID A999

Login Password 1

Login Level Super Administrator

Note that the login ID and password is case-sensitive (whereas for Pacific Timesheet only
the password is case-sensitive).

4. Click the Terminal Clock link on the navigation panel on the left side of the page. Set the
following values as appropriate:

Date The current date



p150

© 2000-2023, Pacific Timesheet

Time The current time

Time Zone The appropriate time zone for this device

Note: You have the option to use SNTP (Simple Network Time Protocol) to automatically
adjust the device's clock. This is not needed, however, as Pacific Timesheet will
automatically keep the device clock synchronized.

5. By default the ACTAtek device will record every access as an IN punch. This is useful if
you are using multiple devices and your employees may punch in on one device but out on
another. If you require your employees to punch in and out on the same device you should
set the device to record both IN and OUT punches. To do this click the "Authentication/Log
Setup" link on the left side of the page, then enable the "Auto IN/OUT" and "Auto Reset
IN/OUT" settings.

Adding Employees

Employees (also called Users by the ACTAtek device) are generally best added at the device,
a necessity if using fingerprints. To add a new user to the device follow these steps:

1. Press the menu button on the device, which is the second button down from the top-right
corner of the keypad. You  will be prompted to log in - use the following values:

Login ID A999

Login Password 1

2. Choose the "Add User" menu and press the enter button (the lower-right-most button on
the keypad). Your options will include, depending upon the model, either fingerprint, smart
card or password. Choose the desired authentication method and press the enter key. You
will be asked for a user ID, which can be up to 20 characters (digits plus the letter A, B or
C). Enter the desired user ID and then follow the instructions for recording fingerprints,
smart card information or a password.

3. Using a browser, log into Pacific Timesheet and create an employee to match the one just
created on the device. Make sure either the employee's Login Name, Employee ID  or Time
Clock ID field matches the user ID entered on the device. The Time Clock ID field is an
optional custom field to use when you cannot use the login name or employee ID fields. To
create this, go to the Employees > Manage Custom Fields page and add a new text field
named "Time Clock ID".

Note: It is important that the Pacific Timesheet employee Login Name, Employee ID or
Time Clock ID field match the user ID on the device, otherwise the employee's timesheet
will not synchronize with the device.

Note: If you replace an old or defective device with a new one, you should also delete the
device entry from the list and re-add it. Otherwise you may find the system will not
synchronize with the new device.

Note: Using Multiple Time Clocks

When implementing multiple ACTAtek time clocks you have two major configuration
options:

1. Stand Alone Configuration (Default)
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In this configuration each time clock acts as a stand-alone device. In this configuration,
each clock must be individually configured, with users enrolled at each device. Each device
must be added to Pacific Timesheet for synchronization.

2. Master/Client Configuration

In this configuration you define one of your time clocks as the master device. Then every
other device is defined as a client and configured to synchronize with the  master device. In
this configuration you only need to configure and enroll users at the master device. Only the
master device should be added to Pacific Timesheet for synchronization as it will collect
access logs from the client timeclocks.

Note: Do not add client devices to Pacific Timesheet for synchronization or you will get
duplicate timesheet data.

Note: Resetting the Super Admin (A999) Password

For security reasons, there is no way to manually reset the device back to its factory
settings or otherwise reset the Super Admin (A999) password. If you have forgotten your
Super Admin password please do the following:

1. Email the serial number and IP address of the unit to support@actatek.com, letting them
know you want to reset the Super Admin password. To get the serial number and IP address
press the Enter button on the ACTAtek unit six times and it will display the information.

2. You will be emailed a link to a password recovery patch, which will, for security, expire
after 48 hours. Download this patch to your local computer.

3. Open a browser on your local computer and go to the recovery page of the ACTAtek unit,
as described in the email response from ACTAtek. For instance:

    http://192.168.1.88/cgi-bin/recovery.cgi

4. Upload the recovery patch as per the instructions on this page. Once the upload is
completed you will be able to log in as the Super Admin: A999 with password 1.

-o-
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Data Connections
Data Connections

The Data Connections page allows you to review your cloud drive connections for Dropbox
and Microsoft OneDrive. You can configure auto-import and exports to use these
connections. The Data Connections page allows you to review and test (and re-authenticate,
if need be) your cloud drive connections, as well as to delete and add connections.

You can also add new data connections from the export options or from the auto-import
options pages. New connections added from the Data Connections page will be available for
use from the export/import options pages, as well.

Note: When authenticating a cloud drive connection, you will be redirected to the vendor's
(e.g. Dropbox's) authentication page. Once successfully authenticated the new connection
will appear in Pacific Timesheet. The vendor's authentication page will usually set cookies
that will persist the account name/email address used for the authentication. If you need
to add additional accounts for the same vendor you will have to restart the browser, use
another browser, or even delete cookies from the vendor's site. Otherwise you may end up
bypassing the authentication page without being asked for the account name/email
address.
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System Options
System Options

System options are system-wide or global settings, and include the following properties:

Property Description

Crew Timesheets If enabled then crew timesheets are available. Crew timesheets allow
you to quickly record and track time for groups (crews) of employees
using a large grid-style timesheet.

Note: You can change the terminology 'Crew' to suit your
organization's needs. The Terminology topic has more information.

Crew Mobile App If Crew Timesheets is enabled you will see the "Mobile App" options link. 
Clicking this allows you to specify settings for users of the Pacific
Timesheet - Crew mobile app (for iOS and Android).  You can specify the
following options:

Data Retention How long data entered using the mobile app is stored
on the mobile device.  The app is designed to operate
when there is no network connection and therefore
stores crew timesheet and asset data on the mobile
device.  When a network connection is available it will
synchronize and upload/synchronize any stored data
to the cloud system.  Data stored on the mobile device
will eventually be purged after the number of days
specified for data retention (regardless of whether it
has been uploaded or not, though the user will be
notified if un-uploaded data is nearing its purge date).

Enabled Leave Specify which types of leave paycodes (if any) will be
recorded on the mobile app.  As the mobile app is
designed to work offline, any leave recorded on it will
be assumed to be accurate and will therefore erase
any potential leave of the same paycode on the cloud
system when the crew timesheet is uploaded. 
Typically you would allow paycodes like Sick or Per
Diem to be recorded on the mobile app.  Scheduled
leave like Vacation or Holiday would not generally be
recorded on the mobile app as in offline situations the
mobile app might not be aware of such scheduled
events.

Asset Tracking If enabled then asset tracking is available. Asset tracking allows the
recording of material, equipment and other types of resources used on
projects and jobs.

Note: You can change the terminology 'Asset' to suit your
organization's needs. The Terminology topic has more information.
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Location Tracking If enabled then employee locations will be tracked as they record their
time. Checking the "Location Tracking" checkbox will result in asset
tracking being enabled, and a new asset type named "Location" being
created. You may still need to enable / disable the "Location" asset type
for each appropriate timesheet template (on the System > Templates
page).

As employees enter time on their timesheets (or crew leads enter time
for crews) a new location entry will be created indicating the location
along with a timestamp. Subsequent data entry for the same day will
only result in new location entries if the employee's location has changed
by more than about 11 meters (36 feet). Locations will be more accurate
for devices that have GPS, but a reasonably close location will usually be
recorded even using computers/tablets without GPS (depending upon
the OS and web browser).

Export File EOL This setting allows you to specify the type of EOL (End Of Line) character
to use when generating text export files, such as CSV (Comma
Separated Values) data. What you choose here will depend upon what
external applications you wish to integrate with. Most applications
support the LF (Line Feed) character. However some Windows
applications do require CR+LF (Carriage Return and Line Feed)
characters.

Import File Blank Values Blank number and date values are generally ignored in import files, to
avoid accidentally clearing out existing values. You can change this
default behavior by choosing the "Don't Ignore Blank Values" option:
when this is set a blank date or numeric value in an import file will clear
out the appropriate value in the Pacific Timesheet object.

Enabled Currencies Select which currencies are applicable for you organization. Users will
only be able to choose a currency type from the list of enabled
currencies. For easiest data entry for your users you should enable as
few currency types as possible so they do not have to navigate a long
menu of options. Enabling or disabling currencies will not affect any
previously entered data: this setting only alters the list of currency types
a user can select when entering, say, and expense entry in a local
currency.

Picker Button Width The picker button is the menu button that lets you choose projects,
tasks, expenses, etc. on many pages of the application.  When used on
pages where real estate is at a premium, such as the Crew Timesheet or
Expense Sheet pages, it may be helpful to specify a maximum width in
order prevent the page from becoming too wide and unwieldy.  The
value you specify is in units of "em", meaning the size of the widest
character in the alphabet, e.g. "M" (which is where the name "em"
comes from).  So if you specify a value of 20 then you are guaranteed to
see at least 20 characters, and generally many more as most characters
are not as wide as "M".  If a value is truncated then you can always see
the full value by simply clicking the menu button.

Mobile Picker Fields You can control how much information is displayed in the list of projects,
expenses, etc. shown when you search for these items in the mobile
client.  You may not want to show the description, for instance, if you
prefer to see more items at one time on the screen.

-o-
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System Tools
System/Administrative Tools

System tools are advanced utilities that can be used to perform periodic administrative
tasks, such as re-running leave accruals after making a policy change that need to be
applied retroactively, or mass-updating timesheet data that needs to be charged to a
different project or group.

Rerun Accruals Wizard

The Rerun Accruals Wizard is tool that will walk you through reprocessing employee leave
accruals for a past period of time.  You might use this wizard after making an accrual policy
change that needs to be applied retroactively to a set of employees.  When the wizard runs
it will remove all old accruals for the affected employees and date range and generate new
ones based on their current policy settings.  

The wizard will collect the following information from you before running:

Rerun Accruals (Wizard)

Policies Select one or more employee policies with accrual rules that you
wish to reprocess.

Balances Select one or more balances that you wish to reprocess.

Employees This is an optional filter that allows you to limit the reprocessing
to specific employees.  If you don't specify any employees then
ALL employees with the selected policies will be reprocessed. 
To select an employee, start typing a name or ID: a list of
matching employees will appear for you to choose from (you
must type at least 2 characters for the list to show).

Date Range Select the date range over which you want to rerun accruals. 
Processing runs from midnight at the start of the date range to
11:59 PM (23:59) at the end of the date range, in the time zone
of each employee being processed. 

Once this information is collected you will be given a chance to review all of the settings
before running the wizard.  As reprocessing accruals can affect current timesheet users by
altering their balances, you should only run this wizard during off-peak usage hours, e.g.
after 5:00 PM if most users finish work by then.

Mass Update Wizard

The Mass Update Wizard is tool that will walk you through updating multiple time and asset
entries for a past period of time.  You might use this wizard to make mass changes to
project, department, etc. values for historical employee data.  The wizard will not alter
timesheet hours or asset entry amounts, nor will it create or delete time or asset entries - it
will only change how those entries are classified.  For example, you could use this wizard to
change all time recorded against Project 1 to Project 2 for the past 3 months.

Note that the Mass Update Wizard does NOT update bill or pay rates and amounts based on
any new values.  For instance, if your bill rate depends on the project, and you are mass
updating a new project value, the original bill rates and amounts for the affected records will
be left unchanged.
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Warning: You cannot undo the changes made by the Mass Update Wizard - use
extreme caution when running this wizard and verify every setting before clicking
the Run button!

The wizard will collect the following information from you before running:

Mass Update (Wizard)

'Include' Fields Specify one or more entry field values to determine which time
or asset entries will be included in the mass update.  To select a
value start typing a name or ID: a list of matching items will
appear for you to choose from.

If you do not choose any value for a particular 'include' field
then ALL entries will be matched for that field.  For instance, if
you leave the Project 'include' field blank then entries with
[NULL], Project 1, Project 2, etc. project values will match.

To select or match the null value, start typing the expression
'null' (without the quotes) to see the [NULL] value option.  The
[NULL] value will match entries where the particular field was
left unset or blank by the employee.

'Set As' Fields Specify the new value for the field for the records specified by
the 'Include' fields property.  To select a value start typing a
name or ID: a list of matching items will appear for you to
choose from.

Leave the 'Set As' field value blank for it to be ignored and left
unchanged.

To set the field to a null value, start typing the expression 'null'
(without the quotes) to see the [NULL] value option.  The
[NULL] value will clear out any previous value the record
contained.

Entry Types If you have assets enabled you can specify whether time
entries, asset entries or both types of entries are included in the
mass update.  If you do not have assets enabled then you will
not see this option and time entries will always only be updated.

Employees This is an optional filter that allows you to limit the mass update
to specific employees.  If you don't specify any employees then
ALL employee records with specified 'Include' field values will be
updated.  To select an employee start typing a name or ID: a
list of matching employees will appear for you to choose from
(you must type at least 2 characters for the list to show).

Date Range Select the date range for the entries to be included in the mass
update.  Processing runs from midnight at the start of the date
range to 11:59 PM (23:59) at the end of the date range, in your
time zone (the time zone of the system administrator running
the wizard, not the time zone of the employees whose records
are being updated). 

Once this information is collected you will be given a chance to review all of the settings
before running the wizard.  This wizard will process both submitted (locked) and
unsubmitted entries. If mass-updating a date range that has unsubmitted data you should
consider running this wizard during off-peak usage hours, e.g. after 5:00 PM if most users
finish work by then.
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Update Bill/Pay Rates Wizard

The Update Bill/Pay Rates wizard is used to update past time entries to use the current bill
and pay rate settings. When you save any changes to an employee's bill or pay rates the
change takes effect immediately, but only for current and future timesheets. This wizard
allows you to apply the current bill and pay rate values retroactively, without having to
manually adjust individual timesheets.

The wizard will collect the following information from you before running:

Update Bill/Pay Rates (Wizard)

Rate Type Select the type of rate you want to update, either Bill, Pay or
Both.

Employees This is an optional filter that allows you to limit the updating to
specific employees.  If you don't specify any employees then
ALL employees with time entries in the specified date range will
be reprocessed.  To select an employee, start typing a name or
ID: a list of matching employees will appear for you to choose
from (you must type at least 2 characters for the list to show).

Date Range Select the date range over which you want to update the rates. 
Time entries that fall within midnight at the start of the date
range to 11:59 PM (23:59) at the end of the date range will be
updated. 

Once this information is collected you will be given a chance to review all of the settings
before executing the update.  If updating many users it is suggested you run this wizard
during off-peak usage hours, e.g. after 5:00 PM if most users finish work by then.
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License
License

Enter your license key on this page. After clicking OK your new license will take effect
immediately.

The license limits how many active employees your system may have. There is no limit on
how many inactive users you may have, so in general you need never delete terminated
employees, just inactivate their accounts.

If you are hosting the software yourself, a free, non-expiring 10-employee license is
generated when installed. This free license does not come with any technical support. You
can purchase a support contract or a license for more employees by contacting your Pacific
Timesheet reseller or sales@pacifictimesheet.com, or visiting www.pacifictimesheet.com.
When ordering a new license you will be asked to provide the host computer name, which
can be found on System > General > License page.
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System Lists
System Lists

System lists are collections of named values that you can modify, such as Employment
Types. You might need to modify lists when integrating with external systems such as
payroll applications.

List items have the following properties:

Property Description

Name The name of this item, up to 255 characters.

Value The value for this item, up to 255 characters.
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Pay Codes
Pay Codes

Pay codes are used to categorize time entries. For instance you might use pay codes like
Regular Time or Over Time for work time entries, and pay codes like Sick or Vacation for
leave time entries.

Note: Some built-in pay codes have special uses, and changes to them should be carefully
considered. For instance, to avoid confusion you would not want to rename Holiday to
Vacation, or rename Over Time to Double Time. The following built-in pay codes have
special uses:

Regular Time, Over Time and Double Time are used by the Over Time Rules (see the
Policies topic for more information).

Flex Time is used by the Flex Time Rules (see the Policies topic for more information).

Holiday is used when placing holidays onto timesheets by the Schedule Rules (see the
Policies topic for more information).

Note: You can change the terminology for Pay Code, Work and Leave to suit your
organization's needs. The Terminology topic has more information.

Pay codes have the following general properties:

Property Description

Name The pay code name, up to 80 characters. A value is required and
must be unique for all pay codes.

Description A description for the pay code, up to 255 characters.

ID The pay code ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all pay codes. This
is commonly used for synchronizing with external systems, such
as payroll or accounting.

Status The pay code status, either Active or Inactive. You cannot delete
pay codes that have been used on timesheets. Setting the
status to inactive will prevent any further use of the pay code.

Type The pay code type, either Work or Leave. This property can only
be changed when creating a new pay code - once a pay code
has been created you cannot change its type.

Note that the terminology for Work and Leave can be changed
from the General page under the System tab.

Can Request If checked then this pay code can be requested from the
employee's Home tab. For instance, you might want the
"Vacation" pay code to be requested, but it would not make
sense for the "Sick" pay code to be requested.

Note that this option is unavailable for Work type pay codes: it
is intended for Leave pay codes such as Vacation.

Note that this option is unavailable if the "Don't add to hours
total" option is enabled in the Options dialog (see below).  When
this option is enabled the pay code is assumed to be for
non-time data such as per-diem amounts.



p162

© 2000-2023, Pacific Timesheet

Balance Enabled If enabled, a balance will be tracked for this pay code. Leave
hours recorded against this pay code will automatically be
deducted from the associated balance. The Employee Balances
topic has more information.

Note that this option is unavailable for Work type pay codes: it
is intended for Leave pay codes such as Vacation.

Note that this option is unavailable if the "Don't add to hours
total" option is enabled in the Options dialog (see below).  When
this option is enabled the pay code is assumed to be for
non-time data such as per-diem amounts.

Color The color is used on employee calendars when shading days
with leave requests or holidays. Employee calendars appear on
the Home tab or the Employees tab.

Notes Notes about this pay code, up to 2000 characters.

In addition to the above properties, the following advanced options are available by clicking
the Options link in the lower-right corner of the Edit Pay Code page:

Property Description

Has report column Checking this option will create a database column that will
store the number of hours for this pay code for each time entry.
This makes it easy to add a column to timesheet reports to
display the total for this pay code (otherwise a SQL expression
needs to be used). The drawback is that this will increase
storage requirements by a few bytes for each time entry, so you
don't want to enable this for more than a handful of pay codes.

Don't add to hours total Checking this option will result in any values entered for this
pay code  on a timesheet not contributing or adding to the
employee's hours. This is typically used for tracking per-diem
amounts or other non-time data.

Note that when this option is enabled the pay code will no
longer be requestable or have a balance.

Permissions

Permissions allow you to restrict which pay codes employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access pay codes for which they have been
added to the permission list.

-o-
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Templates
Timesheet Templates

Timesheet templates define the type and layout of time entry fields for employee
timesheets. You can create any number of timesheet templates, which gives you great
flexibility in the types of timesheets you assign to employees. For instance you might
require hourly workers to record their start and finish times, whereas others might just
track total hours.

Timesheet templates are assigned to an employee from the Employee Details page. See the 
Managing Employees topic for more information.

Timesheet templates have the following properties:

Property Description

Name The template name, up to 80 characters. A value is required and must
be unique for all templates.

Description A description for the template, up to 255 characters.

Status The template status, either Active or Inactive. You cannot delete
templates that are currently assigned to employees. Setting the status
to inactive will prevent the template from being assigned to new
employees.

Time Period The time period for this template. The Time Periods topic has more
information.

Default This determines whether this template is the default timesheet
template for new employees.

Timesheet Fields The list of time entry fields that appear in the main section of the
timesheet. The fields will appear in the order specified. For each field
you can specify the following options:

Work Only: If checked, this field will only be shown on work rows,
otherwise it will be shown on both work and leave rows.

Required: If checked then a value is required for this field. If no value
is provided then timesheet will generate an error message and will be
prevented from being submitted.

Detail Fields The list of time entry fields that appear in the Details section of the
timesheet. The fields will appear in the order specified. As for
timesheet fields above, you can specify whether each field is Work
Only or Required.

Total Fields The list of fields that appear in the Totals section of the timesheet.

The following time entry fields are available (as well as any custom fields you may have
created):

Property Description

Start The start time for the time entry. Times are entered in the format
appropriate for the employee's locale.

Finish The finish time for the time entry. Times are entered in the format
appropriate for the employee's locale.

Hours The number of hours for the time entry. The format can be entered in
either decimal or hh:mm format.
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Pay Code The pay code for the time entry.

Reporting Group The employee group associated with this entry. If not entered from the
timesheet then pulled from the employee's profile. This value may also
be called the Cost Center or Department, depending upon your
organization (see the Terminology topic for more information).

Customer The customer for the time entry.

Project Group The project group for the time entry.

Project The project for the time entry.

Task Group The task group for the time entry.

Task The task for the time entry.

Bill Rate The bill rate for the time entry. If not entered from the timesheet then
the value is pulled from the appropriate object as per the Bill Rate
Options settings. See the Rate Options topic for more information.

Bill Amount The bill amount for the time entry. If not entered from the timesheet
then computed as Bill Amount = Hours x Bill Rate. If entered from the
timesheet then the Bill Rate will be computed as Bill Rate = Bill
Amount / Hours. 

Pay Rate The pay rate for the time entry. If not entered from the timesheet
then the value is pulled from the appropriate object as per the Pay
Rate Options settings. See the Rate Options topic for more
information.

Pay Amount The pay amount for the time entry. If not entered from the timesheet
then computed as Pay Amount = Hours x Pay Rate. If entered from
the timesheet then the Pay Rate will be computed as Pay Rate = Pay
Amount / Hours. 

Notes A text field for notes about this entry.

You can also define any number of custom fields for use on the timesheet template.
Timesheet custom fields are configured from the System > Templates > Manage Custom
Fields page. Once you create the custom fields they will show up in the list of available
fields for the template.

You can preview what the timesheet will look like by clicking the Preview button on the
Timesheet Template Details page.

Subtopics

Timesheet Asset Tracking

Timesheet Advanced Settings

Timesheet Submit Message
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Asset Tracking
Asset Tracking

If Asset Tracking is enabled (see the Asset Tracking Options topic) then you can configure
which types of assets can be entered from this template. Being able to configure which
assets can be entered from the timesheet template gives you great flexibility in who can
input asset entries in your organization. For instance, you may only want to have field crews
keep track of equipment usage, which you could do by giving the field crew their own
timesheet template with equipment entry enabled.
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Advanced Settings
Advanced Settings

Advanced settings allow you to control some less common aspects of time entry:

Property Description

Time Entries
Allowed

This option allows you to limit time entries on for this timesheet
template to just work or leave. For instance, if you are only tracking
leave or time off you would set this value to "Leave Only". If you
never record leave then you would set this to "Work Only".
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Time Entry Mode This determines whether the employee enters hours on their
timesheet (Standard), or use some other mode to track their time:

Standard Standard time entry in which employees
enter time in hours on their timesheet.

Percent Time Entry Employees enter their time as a
percentage of the total time they worked
during the timesheet period. Both work
and leave time can be recorded. Just like
standard time entry, time can be
allocated as percentages against different
projects and tasks.

The system will convert percentages
entered by the employee into actual
hours, based on the employee's 
Scheduled Hours Per Week property in
their employee profile (if not specified
then 40 hours per week is assumed). The
employee only sees percentages, but
managers can review or report on both
percentages and actual hours. 

Note 1: Only weekly, bi-weekly and
quad-weekly timesheet periods are
supported. This is because entered
percentages must be converted to hours
by the system, which is done using the
employee's scheduled hours per week
property.

Note 2: Rounding is not supported with
percent time entry - all percentages are
manually entered and can be up to 2
decimal digits. Do not enable the
Rounding Time Entry Rule as it may
produce odd results.

Note 3: To enforce that 100% of time is
accounted for on an employee's timesheet
you should enable the following 2 
Schedule Rules:

[x] Timesheet hours cannot be greater
than scheduled hours
[x] Timesheet hours cannot be less than
scheduled hours

See the Schedule Rules topic for more
information.

Presence/Absence Time
Entry

Rather then entering hours, employees
toggle checkboxes on their timesheet
indicating which days they worked. They
can have multiple rows per day or week
to track work done on different projects
or tasks.
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Attendance Entry If this option is checked then the Attendance Widget will be shown at
the top of the timesheet (week view only), as well as on the crew
timesheet (by adding an In-Out column). This option is only useful if
you are not capturing start and finish times on the timesheet itself.
Attendance entry times will be rounded according to the employee's
policy if rounding is enabled (see the Time Entry Rules topic for more
information).

There are two attendance widget styles:

Single in/out/meal per
day

Only one in and out time can be entered
per day for each employee. You can
specify whether a meal was taken by
selecting the number of meal minutes
from a menu, or by checking a checkbox if
only one meal time is allowed.

Multiple in/outs
(punches) per day

Multiple punches can be entered per day
for each employee. Rather than selecting
a meal from a menu or checkbox, the
employee would punch out for a meal and
punch back in when returning to work.

The following options can be set if the attendance entry widget is
enabled:

Copy attendance hours
down to timesheet

If checked then attendance hours will be
carried down to the first row of the
timesheet whenever attendance is
changed.

Reject timesheet if
different than timesheet
hours

If checked then attendance hours must
match timesheet hours before the
timesheet can be submitted.
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Submit and Review Messages
Submit and Review Messages

You can create a custom message that the employee is presented with when they submit or
review their timesheet:

Property Description

Submit Message The custom message to present to the employee upon timesheet
submit. If blank then no custom message is presented.

Review Message The custom message to present to the employee upon timesheet
review. Only employees with the "Can review my timesheet only"
permission will see this message.
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Policies
Policies

Policies are sets of rules governing the behavior of employee timesheets, leave accrual and
more. You can create any number of policies and assign different policies to different
employees. For instance, you might have one policy for exempt employees titled "Exempt
Policy", and another policy for hourly employees named "Hourly Policy", each with different
rule settings. Each employee must have a policy, which is specified in the Employee Details
page.

Policies are composed of several sets of related rules. This includes Time Entry Rules,
Balance and Accrual Rules, Over Time Rules and Flex Time Rules. Policies have the
following properties:

Property Description

Name The policy name, up to 80 characters. A value is required and
must be unique for all policies.

Description A description for the policy, up to 255 characters.

Status The policy status, either Active or Inactive. You cannot delete
policies that are currently assigned to employees. Setting the
status to inactive will prevent the policy from being assigned
to new employees.

Default This determines whether this policy is the default policy for
new employees.

Policy Rules

 Time Entry Rules
 Schedule Rules
 Flex Time Rules
 Balance and Accrual Rules
 Over Time Rules
 9/80 Over Time Rules
 Work Shift Rules
 Wage Rules
 Absence Points Rules
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Time Entry Rules
Time Entry Rules

Time entry rules can be used to control how many hours an employee can enter on a
timesheet, whether time entries are rounded or not, and many other options. If any rule is
violated an error will appear on the timesheet, and the timesheet cannot be submitted for
approval until the rule violation is corrected.

Hours Checks are rules that restrict how many hours employees may enter on their
timesheet:

Rule Description

Minimum hours per
work day

The minimum number of hours that should be entered each work
day. This rule is checked when the timesheet is submitted, and
counts both work and leave hours in the day total. For example, if
you enter 8.00 hours for this value then the employee must
record 8 hours of work, sick, vacation, etc. for each day of the
work week, or they will not be able to submit their timesheet.
What is considered a work day is determined by the employee's
Scheduled Work Days property on their employee properties
page. See the Managing Employees topic for more information.

Maximum hours per day The maximum number of hours (both work and leave) that can be
entered per day.

Minimum hours per
week

The minimum number of hours that can be entered per week.
This rule is checked when the timesheet is submitted, and counts
both work and leave hours in the week total.

Maximum hours per
week

The maximum number of hours (both work and leave) that can be
entered per week.

Minimum hours per
period

The minimum number of hours that can be entered per period.
This rule is only useful for timesheet periods that are longer than
one week. This rule is checked when the timesheet is submitted,
and counts both work and leave hours in the period total.

Maximum hours per
period

The maximum number of hours (both work and leave) that can be
entered per period. This rule is only useful for timesheet periods
that are longer than one week.

Leave Checks are rules that restrict how many hours of leave employees may take on any
given day:

Rule Description

[Leave] minimum hours
per day

If an employee puts non-zero [Leave] hours on their timesheet,
this is the smallest amount that can be taken in one day. For
instance, if the employee enters 2.00 hours of Vacation on their
timesheet, and the minimum is set to 4.00, they will see an error
message when saving the timesheet, and will need to fix the
entry before they can submit the timesheet.

[Leave] maximum
hours per day

The maximum [Leave] hours that can be taken in one day. For
instance, if the employee enters 9.00 hours of Vacation on their
timesheet, and the maximum is set to 8.00, they will see an error
message when saving the timesheet, and will need to fix the
entry before they can submit the timesheet.
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[Leave] can't be taken
until employed for

The probationary period or number of days an employee must be
employed before they can take [Leave] hours. This rule requires
that the employee's "First Day" property must be set in their
employee profile. When this rule is enabled the employee will not
be able to make [Leave] requests or enter [Leave] on their
timesheet until after the specified number of days of employment.

In the above table [Leave] means any of your configured leave pay codes, e.g. Holiday,
Vacation, etc. You will be able to configure each pay code separately.

Note that if you set the minimum and maximum hours described above to be the same
value for a given pay code, this implies the employee cannot take a partial day of leave.
When generating a leave request for the given pay code the employee will not see the
"Partial Day" option.

Rounding rules allow you to control whether and how time entries are rounded:

Rule Description

Round time entries to The number of minutes to round time entries to, for example 15.
If the timesheet template has the Start and Finish fields, then
the start and finish times will be rounded. If the timesheet
template has only the Hours field then the hours will be rounded.

Note that if you want to keep track of the original or unrounded
start and finish times you need to add the "Actual Start" and "
Actual Finish" custom fields, as described in the note below. You
can also add a "Disable Rounding" checkbox custom field to turn
off rounding for an individual time entry.

Rounding Mode How rounding is done, either Nearest, Round Up or Round Down.

Nearest:

The Nearest rounding mode will round the start and finish time of
a punch to the nearest rounding increment. For example, if
rounding is to 15 minutes then 8:07 will round to 8:00 and 8:08
will round to 8:15. For timesheets that are only recording hours
(no start/finish times) then the hours entered will be rounded to
the nearest rounding value, instead of the start and finish times.

Round Up

The Round Up rounding mode will round the start and finish time
of a punch to the next rounding increment. For example, if
rounding is to 15 minutes then 8:01 will round to 8:15 and 8:16
will round to 8:30. For timesheets that are only recording hours
(no start/finish times) then the hours entered will be rounded to
the next rounding increment, instead of the start and finish times.

Round Down

The Round Down rounding mode will round the start and finish
time of a punch to the prior rounding increment. For example, if
rounding is to 15 minutes then 8:14 will round to 8:00 and 8:16
will round to 8:15. For timesheets that are only recording hours
(no start/finish times) then the hours entered will be rounded to
the prior rounding increment, instead of the start and finish
times.
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Round punch-in to
scheduled start time

Checking this option will round punch-ins to the employee's 
scheduled start time if the punch is within the specified minutes
of the scheduled start time. For example, if you specify that
punches 15 minutes or less before the scheduled start time be
rounded to the start time, and the employee is scheduled to start
at 9:00AM, then a punch of 8:50AM will be rounded to 9:00AM.
However, a punch of 8:40AM will not be rounded. This rule is
useful if you want to prevent employees from recording more
than their scheduled number of hours, even if they come in a few
minutes early.

If the regular rounding rule is also enabled (for example, round
punches to the nearest 15 minutes), then the regular rounding
rule will only run if the punch does NOT fall within the specified
minutes of the scheduled start time.

The employee's scheduled start and finish times are specified in
their profile. See the Managing Employees topic for more
information.

Round punch-out to
scheduled finish time

Checking this option will round punch-outs to the employee's 
scheduled finish time if the punch is within the specified
minutes of the scheduled finish time. For example, if you specify
that punches 15 minutes or less after the scheduled finish time be
rounded to the finish time, and the employee is scheduled to
finish at 5:00PM, then a punch of 5:10PM will be rounded to
5:00PM. However, a punch of 5:20PM will not be rounded. This
rule is useful if you want to prevent employees from recording
more than their scheduled number of hours, even if they leave a
few minutes late.

If the regular rounding rule is also enabled (for example, round
punches to the nearest 15 minutes), then the regular rounding
rule will only run if the punch does NOT fall within the specified
minutes of the scheduled finish time.

The employee's scheduled start and finish times are specified in
their profile. See the Managing Employees topic for more
information.
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Note: If you want to preserve the original or unrounded start and finish times you need to
add the following timesheet custom fields to Pacific Timesheet:

Custom Field Type Description

Actual Start Time This field holds the unrounded or original start time of
day. 

Note that you must create this field exactly as
named, "Actual Start", in order to create the expected
underlying database field (t_timeentry.xactualstart).
After creating the field you can then rename it as this
will not affect the name of the underlying database
field.

Actual Finish Time This field holds the unrounded or original finish time
of day. 

Note that you must create this field exactly as
named, "Actual Finish", in order to create the
expected underlying database field
(t_timeentry.xactualfinish). After creating the field
you can then rename it as this will not affect the
name of the underlying database field.

Disable
Rounding

Checkbox This is optional and is only needed if you want to be
able to turn off rounding on a per-entry basis on a
timesheet. After creating this custom field you can
add the checkbox to the time entry details, giving you
the option to turn off or disable rounding for an
individual time entry. The "disable rounding"
checkbox will only work if you also have the "Actual
Start" and "Actual Finish" time fields, describe above.

Note that you must create this field exactly as
named, "Disable Rounding", in order to create the
expected underlying database field
(t_timeentry.xdisablerounding). After creating the
field you can then rename it as this will not affect the
name of the underlying database field.

Timesheet custom fields are configured from the System > Templates > Manage Custom
Fields page. It is not required that you put these fields on the timesheet templates
themselves - their value will still be filled in and you can report on them like any other
timesheet field.

Meal Deduction rules allow you to automatically deduct meal time from punches:

Rule Description

Automatic meal
deduction

Check this option to automatically deduct the specified minutes
from time entries. You might specify, for instance, that 30
minutes are deducted from time entries that are 8 or more hours.
This is done by splitting the time entry into two parts, and taking
the deduction from the middle of the time entry. In this way the
employee's start and finish times, if entered, are always
preserved.
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Apply to entries at least If automatic meal deduction is enabled then you need to specify
the smallest punch that gets a meal deduction. For instance, you
may only want a meal deduction for time entries that are 8 hours
or larger.

Maximum deductions
per day

You can limit how many automatically generated meal deductions
an employee is allowed per day with this setting.

Note that the punch having the meal deducted will be split into two punches, with a meal
break in the middle. In this way the punch in and out times are preserved. The meal will fall
in the middle of the punch, starting at the nearest whole hour.

Splitting rules are sometimes needed for certain payroll applications:

Rule Description

Automatic midnight
split

Check this option if you want punches that span midnight to be
split into two punches - one ending on midnight and one starting
at midnight. This will prevent hours that are worked after
midnight from being booked to the timesheet period in which the
punch was started.

Default Timesheet rules control which timesheet period an employee is presented with
when they log into Pacific Timesheet:

Rule Description

Default Timesheet Check this option if you want to change the default timesheet
period that loads when an employee logs in. Normally the current
timesheet is presented, but you can alternatively have the
previous timesheet, if not submitted, be presented. The
mandatory option is for cases where you want the employee to fill
out and submit their previous timesheet before moving to a new
one.

Miscellaneous rules:

Rule Description

Don't allow submitting
time for inactive
Projects, Tasks etc.

Check this option to enable an additional check when the
timesheet is submitted that prevents employees from submitting
time for inactive items such as projects or tasks. Pacific
Timesheetalready prevents users from choosing inactive items
when adding new rows to their timesheet, and will not carry
forward inactive rows if using the "timesheet memory" or "copy
previous timesheet" features. However, this rule does an extra
check to catch any items that might have been inactivated after
any rows were added to the timesheet.

For objects such as Projects and Tasks that have Actual Start
Date and Actual Finish Date properties, this rule will take those
values into consideration. For instance, an error will be presented
to a user if they try to save a time entry for a date that falls after
a project's last day, regardless of whether the project's status
property is currently set to active or inactive.

Note that this rule will only run for the previous and current
timesheet periods to avoid difficulty if a manager retroactively
edits an older timesheet.
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Autofill Autofill will automatically add work hours to a timesheet when it
is submitted to make it match the employee's scheduled hours.
For this to work the employee's scheduled hours per week
property must be set in their profile. The adjustment work entry
will be added to the last day of the timesheet period.

This setting is useful for salaried employees who may be only
tracking leave, but the back-end payroll system requires their
total hours total to, say, 40 each week.

-o-
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Schedule Rules
Schedule Rules

Schedule rules can be used to prevent employees from entering more or less hours than
they are scheduled for. You set an employee's scheduled hours from the Employee Details
page.

The following rules can be configured:

Rule Description

Timesheet hours cannot be
greater than scheduled
hours

Requires the employee to put no more than their scheduled
number of hours on the timesheet. The timesheet cannot be
submitted until they correct this.

Timesheet hours cannot be
less than scheduled hours

Requires the employee to put no less than their scheduled
number of hours on the timesheet. The timesheet cannot be
submitted until they correct this.

Add Holidays to timesheet If checked then any Holidays the employee can take will be
put on their timesheet automatically. Note that if a holiday
falls on a day the employee is not scheduled to work, no
hours will be added to the timesheet. What is considered a
work day is determined by the employee's Scheduled Work
Days property on their employee properties page. See the 
Managing Employees topic for more information.

Add Leave requests to
timesheet

If checked then approved Leave Requests will be put on the
employee's timesheet automatically. Note that if leave falls
on a day the employee is not scheduled to work, no hours
will be added to the timesheet for that day. What is
considered a work day is determined by the employee's
Scheduled Work Days property on their employee properties
page. See the Managing Employees topic for more
information.

Don't allow submitting of
Leave requests with
conflicting or overlapping
dates

If checked then employees will not be able to submit leave
requests that conflict with other leave requests they may
have submitted for the same dates.

Don't allow submitting of
Leave requests if balance
falls below minimum

If checked then employees will not be able to submit leave
requests that if the balance for the selected pay code (e.g.
Vacation) would fall below the minimum allowed. If the pay
code has no balance associated with it then this setting is
ignored. The minimum balance allowed is specified on the
Balance and Accrual Rules page.

-o-
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Flex Time Rules
Flex Time Rules

Flex Time Rules allow you to automatically accrue hours into the Flex Time balance when
employees work more than a specified number of hours in a day or week. This allows
employees to 'bank' these hours for use on later days.

Note: You can change the name from Flex Time to whatever you prefer (for example
Comp Time) by simply renaming the Flex Time pay code on the System > Pay Codes
page. You will be warned against modifying a built-in pay code, but renaming this will not
cause any problems unless you have previously created work flows (such as timesheet
exports) that rely on this name.

The following rules can be configured:

Rule Description

Daily work hours
over

If enabled, then total work hours over this threshold in a single day
will result in hours being added to the Flex time balance. The number
of hours added depends on the Accrual Rate (see below). For
example, if the daily threshold is 8 and the accrual rate is 1.5, then an
employee who works 10 hours in one day will have 3.0 hours added to
their Flex Time balance.

You can override this daily threshold to specify values for each day of
the week, too. For instance, you might specify a threshold of zero for
Saturday and Sunday in order that any weekend work adds to the
employee's Flex Time balance.

You can cap how many hours over the threshold can contribute to the
flex time balance by setting the Maximum Hours value next to each
daily threshold. For instance, if the employee works a total of 5 hours
over the threshold, but the maximum is 4, then only (4 x Accrual
Rate) hours will be added to the Flex Time balance.

Weekly work hours
over

If enabled, then total work hours over this threshold in a single week
will result in hours being added to the Flex time balance. The number
of hours added depends on the Accrual Rate (see below). For
example, if the weekly threshold is 40 and the accrual rate is 1.5,
then an employee who works 42 hours in one week will have 3.0
hours added to their Flex Time balance. 

This rule is processed after any daily rules, so that hours will not be
double counted. That is, any daily limits will be processed first, and
any hours over the daily limits will not add to the weekly total.

You can cap how many hours over the threshold can contribute to the
Flex Time balance by setting the Maximum Hours value next to the
weekly threshold. For instance, if the employee works a total of 5
hours over the threshold, but the maximum is 4, then only (4 x
Accrual Rate) hours will be added to the Flex Time balance.
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Period work hours
over

If enabled, then total work hours over this threshold in a timesheet
period will result in hours being added to the Flex time balance. The
number of hours added depends on the Accrual Rate (see below). For
example, if the period threshold is 80 and the accrual rate is 1.5, then
an employee who works 82 hours in the timesheet period will have 3.0
hours added to their Flex Time balance. 

This rule is processed after any daily and weekly rules, so that hours
will not be double counted. That is, any daily and weekly limits will be
processed first, and any hours over those limits will not add to the
period total. This rule is only useful for timesheet periods that are
longer than one week.

You can cap how many hours over the threshold can contribute to the
Flex Time balance by setting the Maximum Hours value next to the
period threshold. For instance, if the employee works a total of 5
hours over the threshold, but the maximum is 4, then only (4 x
Accrual Rate) hours will be added to the Flex Time balance.

Accrual Rate The multiplicative factor used to determine how many hours will be
added to the balance for every work hour over the specified limit. For
instance, if the accrual rate is 1.5 and the employee works 2 hours
over the limit, then 3.0 hours will be added to the balance. The
accrual rate value defaults to 1.0, but can be any positive value.

-o-
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Balance and Accrual Rules
Balance and Accrual Rules

Balance and accrual rules control how balance limits and accruals are handled. Balances are
associated with Pay Codes, and can be enabled from the Pay Code properties page. 

Note: If automatic accruals are enabled and you are not seeing the accruals you expect,
please refer to the troubleshooting section below.

The following rules can be configured for each enabled balance:

Rule Description

Minimum Balance The minimum value for this balance, in hours. Employees will
be alerted when their timesheet puts a balance below this
value, and they will not be able to submit the timesheet.

Maximum Balance The maximum value for this balance, in hours. The balance
will be capped at this value. Note that if accrual is enabled
(see below) this option will instead be entered in the accrual
table.

Enable Accrual Enables automatic accrual on this balance. Automatic accrual
means the system will automatically accrue hours and
perform rollovers to the employee's balance on a regular
interval.

Accrual Period If accrual is enabled you should choose the appropriate
accrual period. The accrual will happen before midnight on the
last day of the period, making it available for the first day of
next period. You can choose from any period you have defined
in the System > General > Time Periods page, as well as the
following special time periods:

Hourly - For Every Hour Worked

Hours are accrued before midnight on the last day of the
timesheet period, based on the number of work hours
recorded on the timesheet. The accrual calculation is
performed when the timesheet is submitted.

Yearly - Employee anniversary

Hours are accrued at end of the anniversary year, in which
the anniversary year starts on the month and day of the
employee's first day of employment. For instance, if the
employee started working on March 28, 2012, then
anniversary years would look like:

    March 28, 2012 to March 27, 2013
    March 28, 2013 to March 27, 2014
    etc.

The accrual would occur before midnight on March 27 of each
period for this employee.

When you enable accrual an accrual rate table will appear. You can specify accrual rates,
etc. that vary by the number of years employed (if you don't have values that vary for the
number of years employed then you will only need one row in the accrual table). You can
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click the Add button to add as many rows as you need. Each row in the accrual table can
have the following properties:

Property Description

Years Employed The number of years of employment that this rate starts to
take effect.  If you only have one row in your accrual table
this property will be hidden and default to zero, meaning the
rate will apply to all employees using this policy, regardless of
their years of employment.

The number of years of employment is determined by the
employee's First Day property (see the Employees topic for
more details). If the employee's first day is not set then it is
assumed to be zero years.

Accrual Rate The accrual rate for this balance, in hours. Accruals will be
automatically granted before midnight on the last day of the
specified accrual period.

Max. Work This column only appears if the accrual period is set to
"Hourly - For Every Hour Worked". This is the maximum
number of work hours to consider when calculating the
accrual, for example 40 for a weekly timesheet period, or 80
for a biweekly timesheet period. Leave this value blank if
there is no maximum.

Maximum The cap or maximum hours the balance can reach. Leave this
value blank if there is no maximum.

Rollover The maximum hours that can be carried forward each rollover
period for this balance. The balance will be capped at this
value just before midnight on the last day of the rollover
period (generally December 31, but you can choose any
rollover period you need to, as described below). Leave this
value blank if there is no rollover.

You can specify several accrual/rollover options:

Rule Description
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Rollover Period If a rollover value is specified in the accrual table (described
above), you should choose the appropriate rollover period (it
will default to Yearly starting on January 1). The rollover will
happen before midnight on the last day of the period, making
it effective for the first day of next period. You can choose
from any period you have defined in the System > General >
Time Periods page, as well as the following special time
period:

Yearly - Employee anniversary

Rollover happens at end of the anniversary year, in which the
anniversary year starts on the month and day of the
employee's first day of employment. For instance, if the
employee started working on March 28, 2012, then
anniversary years would look like:

    March 28, 2012 to March 27, 2013
    March 28, 2013 to March 27, 2014
    etc.

The rollover would occur before midnight on March 27 of each
period for this employee.

Rollover/accrual
sequencing

This controls whether the rollover runs immediately before or
immediately after an accrual that would fall on the same
date. 

For instance, if you are using annual accrual and annual
rollover they will both occur on the last day, before midnight
on December 31. You would likely want the rollover to
happen just before the accrual, otherwise the employee would
start the new year with no balance.

However, if your accrual period is monthly, you might prefer
the rollover to run just after the accrual, essentially acting as
a sort of cap. 

How the sequencing of accrual and rollover is handled varies,
so you will have to set this based on your organization's
requirements.

Move Excess Rollover
Hours To

If you specify a non-blank rollover value, you can have excess
hours (hours over the rollover value) be added to a separate
balance. For instance, you might set the annual rollover for
the 'Sick Leave' balance at 0.00, and have any left-over hours
be added to an 'Extended Sick Leave' balance.

Forecast only If this option is checked then no accrual will actually be added
to the employee's balance. The accrual settings will only be
used in forecasting an employee's available hours when
requesting leave (for instance from the Home > New Leave
Request page). You would only want to check this option if
you are importing or synchronizing your balances from an
external payroll or HR system (that is, an external system is
calculating your accruals).

Troubleshooting Automatic Accruals

If you are not seeing the expected accruals or rollovers for your employees please review
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the following troubleshooting steps before contacting support:

1. Make sure that the employee has the correct policy in their employee profile, and that the
policy has accruals enabled.

2. If no accrual is happening, make sure the "Forecast only" option is not checked. Also
make sure the correct accrual rate is specified in the accrual rate table.

3. If the accrual is happening but an incorrect rate is being used, make sure the correct
"First Day" property is set in the employee's profile.

4. For non-yearly accrual periods, employees who have been employed for less than one
accrual period (for example, an employee started a week ago but the accruals happen every
month) will not trigger an accrual. That is, the system will not give them a partial or
pro-rated accrual for working a partial accrual period. You can always specify an initial
balance for the employee if need be, from the Current Balances section of their employee
profile page. For yearly accrual periods the accrual will happen even if the employee has
been employed less than one year. For these employees you can pro-rate or provide a
partial accruals by specifying accrual rates for partial years.

5. Understand that the accrual or rollover is not generated until the last day of the period,
just before midnight. Any changes you make to an employee's accrual rules will not take
effect until the end of the subsequent accrual or rollover period. If you add a new employee
whose first day is before the current date, you may need to specify an initial balance as the
system will not go back in time and generate past accruals and rollovers.

6. This is for self-hosted customers only: As the system generates accruals and rollovers
just before midnight at the end of the period, you need to make sure the Pacific Timesheet
service is running. If you shut down the computer or service at night then the accruals or
rollovers might not happen. You can shut down or restart the computer for maintenance
needs, but in general you want to leave it running overnight in order for the accruals,
rollovers and other background processes to run.

7. There might be cases where you need to rerun accruals and rollovers for a past period of
time for a large number of employees. Pacific Timesheet has a utility to rerun your current
accrual settings for a past time period. Please contact support@pacifictimesheet.com for a
solution document outlining how to use this utility to rerun past accruals and rollovers.

-o-
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Over Time Rules
Over Time Rules

Over time rules allow you to automatically compute over time and double time on employee
timesheets.

Note: Make sure you do not turn on both the regular over time rules and the 9/80 over
time rules for the same policy. There should be at most ONE type of over time rules
enabled for a policy.

The following rules can be configured for over time and double time:

Rule Description

Daily work hours over Any work hours over this amount in a single day will be
marked as over time. You can override this value and specify
individual values for each day of the week, too.

Weekly work hours over Any work hours over this amount in a week will be marked as
over time, after the daily rule is processed.

Period work hours over Any work hours over this amount in a timesheet period will be
marked as over time, after the weekly rule is processed. This
rule is only useful for timesheet periods that are longer than
one week.

Note that rules are processed in the above order, and that double time rules are processed
after all over time rules are processed.

The following rules can be configured to handle consecutive days:

Rule Description

Consecutive days rules
start after

The number of consecutive days of work before the
consecutive days rules are applied. This can include days
worked prior to the current week (the "consecutive days"
option), or only consecutive days with the work week (the
"consecutive days in a work week" option).

Work hours over [  ] are
Over Time

Any work hours over this amount on a consecutive day will be
over time.

Work hours over [  ] are
Double Time

Any work hours over this amount on a consecutive day will be
double time.

The following rules can be configured to handle holiday work:

Rule Description

Work hours on 'holidays' If checked then work hours on 'holidays' will be converted to
over time (or double time, depending upon your selection).
'Holidays' are any days with hours for the selected pay codes
(by default simply the Holiday pay code).

Partial day holidays are also handled by the holiday work rule. A day is considered to be a
partial day holiday if the number of holiday hours is less than the employee's scheduled
hours. For example, if an employee is scheduled to work 8 hours and has a holiday of 4
hours, then it is expected that the employee would work 4 hours. Only work hours beyond
the 4 hours will be converted to over time.
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Options allow you specify additional time entry pay codes that you would consider as
regular work hours. For instance, some organizations consider Holiday hours to contribute to
the total regular hours. If so, you would add the Holiday pay code to the list.

Example

As an example, here is how California, U.S. over time rules would be configured:

Over Time Rules:

[x] Daily work hours over  [ 8.00]

[x] Weekly work hours over [40.00]

Double Time Rules:

[x] Daily work hours over  [12.00]

[x] Weekly work hours over [60.00]

Consecutive Days Rules:

[x] Consecutive days rules start after: [6] [consecutive days in a work week]

    On those consecutive days:

    Work hours over: [ 0.00] are Over Time

    Work hours over: [ 8.00] are Double Time

-o-
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9/80 Over Time Rules
9/80 Over Time Rules

9/80 or compressed schedules allow employees to work more hours in the first 9 days of a
10 day (two week) work period, then take the last day off. For instance, rather than working
40 hours each week, employees could work 44 hours in the first week, then 36 hours in the
second week, with that final Friday off. If you have employees working a compressed 9/80
work schedule you will want to use the 9/80 Over Time Rules rather than the regular Over
Time Rules. The 9/80 rules will correctly compute overtime for compressed weeks, taking
into account hours worked in the previous week.

In addition to affecting how OT is calculated, employees with 9/80 Over Time Rules enabled
will also see changes to the following:
- Company holidays that fall on the Friday off will have not hours pushed onto timesheets
for that Friday.
- Leave requests that fall on the Friday off will not have any hours pushed onto timesheets
for that Friday.
- The Scheduled Work Days in the employee's profile is ignored if they are using the 9/80
Over Time Rules.

Note: You cannot enable both the regular Over Time Rules and the 9/80 Over Time
Rules for the same policy. There can be at most ONE type of over time rules enabled for a
policy.

The following rules can be configured for computing over time:

Rule Description

Weekly Hours The maximum number of work hours per week considered
"regular time", for example 40. Work hours over this value in a
single week will be considered over time.

Note that you can include certain types of leave hours as
"regular time" with respect to reaching the maximum. For
example, you might want Holiday hours to contribute to the over
time calculation. See the Leave property below for more
information.

Midpoint The time and day of the week that is considered the end of the
week (or the midpoint of the two week cycle), for example Friday
12:00 noon. This defines the compressed week - any hours
recorded beyond this will be counted for the next week (whether
work or leave). The selected day is usually taken off on the
second week of a two week cycle. 

Note: This only applies to employees entering start/finish times
on their timesheets.

Day Off The 'Friday' in the two week cycle that is considered the day off.
Typically this would be the 'Friday' in the 2nd week. 

In cases where your employees all have the same biweekly pay
cycle, but you don't want to have everyone off on the same
Friday, you would create 2 policies: one with the 1st Friday off
and another one with the 2nd Friday off. You would then assign
the appropriate policy to employees that work those schedules.



p187

© 2000-2023, Pacific Timesheet

Holiday Work If an employee records hours on a day with holiday hours then
that day is considered holiday work. If you pay employees a
different rate for those hours then you may prefer to assign
those holiday hours to another pay code of your choosing, for
example "Holiday Work".

The list of pay codes available is limited to work pay codes. See
the Pay Codes help topic for information on creating new pay
codes.

Depending on how payroll is processed, you might want to avoid
double-payment of "holiday work" hours and "holiday" hours.
Consider an employee timesheet that has 9 hours of Holiday and
2 hours of work on Tuesday, for a total of 11 hours. Rather than
sending 11 hours to payroll you can send 2 hours of holiday work
and 7 hours of holiday for a total of 9 hours by using the Holiday
Backout option. You can back out an equivalent amount of
holiday hours for each hour of holiday work. This is configured in
the Options dialog (see below).

Callout Work Callout work is for employees who may be called to work at
remote locations periodically to do "callout" work - work that is
outside of the normal day-to-day work done at their normal
location. This work could occur during normal work hours, or
after work hours. If you pay employees a different rate for those
hours then you may prefer to assign those callout hours to
another pay code of your choosing, for example "Callout Work".

The list of pay codes available is limited to work pay codes. See
the Pay Codes help topic for information on creating new pay
codes.

In order to specify that the time entered on the timesheet is
callout work you will need to define a timesheet template 
custom field named "Callout", then assign this custom field to
the appropriate employee timesheet templates. The type of the
custom field must be either "Check Box" or "List". You would
normally use a check box, but might use a list if you have more
than one type of callout work for the employee to select.

Note: The custom field MUST be named exactly "Callout"
(without the quotes, case-sensitive) the first time you create it
(in order for the database column name to be created correctly),
but once you save the custom field you can afterwards edit it
and rename it to anything you prefer (the database column
name will not change).

Leave You can optionally include specific leave pay codes in the
overtime computation. For instance, you might want holiday
hours to be considered as work for the purpose of computing
overtime. For example, if you add Holiday to the list of leave that
contributes to overtime then working 41 hours up to the Friday
midpoint would give you one hour of overtime whether all of
those hours were work or some were work and some were
Holiday.

You would not generally add Holiday to the list of leave that
contribute to overtime if you are already specifying the Holiday
Work rule, above.
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If you click the "Options" link in the lower-right corner of the 9/80 Over Time Rules page
you can specify the following optional properties:

Rule Description

Holiday Overtime If the employee would have received overtime hours during the
day of the holiday for the work done, you can optionally have
those overtime hours placed in the specified pay code, for
example "Holiday Work OT".

The list of pay codes available is limited to work pay codes. See
the Pay Codes help topic for information on creating new pay
codes.

Holiday Backout Depending on how payroll is processed, you might want to avoid
double-payment of "holiday work" hours and "holiday" hours.
Consider an employee timesheet that has 9 hours of Holiday and
2 hours of work on Tuesday, for a total of 11 hours. Rather than
sending 11 hours to payroll you can send 2 hours of holiday work
and 7 hours of holiday for a total of 9 hours by using the Holiday
Backout option. You can back out an equivalent amount of
holiday hours for each hour of holiday work.

You can specify two ways that holiday hour deductions are
processed:

1. Deduct one hour of Holiday for every hour of work that occurs
on the same day.

2. Deduct one hour of Holiday for every hour of work that occurs
on the same day, as long as the work was done during scheduled
work time. The scheduled work time is specified by the
scheduled start/finish times in the employee's profile.

Callout Mapping If you are using a List custom field instead of a Check Box
custom field then you need to specify the pay code for each list
item that you want the callout hours to go to. For example, a
callout with two list choices might look like this:

Callout List Item     | Pay Code

--------------------------------

Callout               | CO

Continue From Callout | COC

Callout Minimum You may want to specify a minimum number of hours an
employee is granted when doing callout work. For instance, you
might grant employees a minimum of 4 hours of callout work
even if they only record 1 hour of actual work.

This minimum is only granted if the callout occurred outside of
normal work hours (as specified in by the employee's scheduled
start/finish time in their employee profile). You can extend what
is considered normal work hours by specifying the number of
minutes before/after their schedule that is still considered
normal work hours. For example, if you specify 120 minutes (2
hours) before/after as normal hours, then an employee with a
start/finish of 8AM-5PM would really have a normal work hour
schedule of 6AM-7PM. Callout hours starting on 6AM or later and
starting before 7PM would not be granted the minimum hours.
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Exempt Mode Cap regular time to 40 hours per week with no overtime. This is
intended for salaried employees who work a compressed
schedule. They can record as many hours as they worked, even
if over the standard 9/80 schedule, but will receive no overtime.

Test Mode Unlike other less complex rules, 9/80 Over Time rules run only
when a timesheet is submitted. Check this option to run 9/80
Over Time rules on save, too. This will stay active for a
maximum of 7 days then turn itself off automatically, to avoid
adversely affecting system performance.

Important configuration notes:

1. If employees are not recording in/out times (just hours) then you need to specify the
employee's "Scheduled Start" property in their profile for the compressed  overtime rule
to work properly. This is also true if you are including leave in overtime calculations. The
scheduled start value is specified on the Employees properties page for each employee (or
can be set in bulk via an import file).

2. If including leave in your overtime calculations you need to enable the database column
for each leave pay code included. This is required in order for any split leave (leave that
falls on the midpoint) to be stored properly. You enable the database column by editing
each appropriate pay code on the Systems > Pay Codes page, clicking the Options link in
the lower right corner, and checking the "Has report column" property.

-o-
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Work Shift Rules
Work Shift Rules

Work shift rules are used to compute how many hours an employee worked fall into each
defined work shift. Before setting up your work shift policies you need to define your work
shifts, on the System > General > Work Shifts page. The Work Shifts topic has more
information. 

When configuring your work shift rules you can specify the following properties:

Rule Description

Enabled Shifts This is the list of enabled work shifts for this policy. Work
shifts are global objects, but you can selectively
enable/disable different ones for each policy. For instance,
you might have two different night shifts: one from
10PM-6AM for employees at one  location, and one from
12AM-8AM at another location. You can then create two
policies and enable the appropriate night shift for each policy.

Shift Hours Depend On This property determines how a work time entry has its hours
associated with the appropriate work shift. The possible
options are:

1. Each Shift Worked

Hours are proportioned into each shift that the time entry falls
on. For instance, if all 8 hours are worked in Shift 1 then all 8
hours are associated with Shift 1. But, instead, if half the
work was in Shift 1 and the other half in Shift 2 then each
would get 4 hours.

2. Largest Shift Worked

All work hours are put into the work shift that had the most
hours. For instance, if an employee worked 8 hours, with 2
hours in Shift 1 and 6 hours in Shift 2, then Shift 1 would get
zero hours and Shift 2 would get 8 hours.

3. First Shift Worked

All work hours are put into the first work shift. For instance, if
an employee worked 8 hours, with 2 hours in Shift 1 and 6
hours in Shift 2, then Shift 1 would get 8 hours and Shift 2
would get zero hours.

-o-
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Wage Rules
Wage Rules

Wage rules help keep you in compliance with governmental rules regarding missed meals,
split shifts and other work issues affecting employee wages and benefits.

Automatic Missed Meal Premium

Also called a "missed meal penalty", the automatic missed meal premium rule allows you to
credit an employee with regular time hours (the premium) for every missed meal in a block
of work. The following properties are supported:

Property Description

Add The number of regular hours (the premium) to add for every
missed meal, for example 1.00. These hours are added to the
regular time pay code for the time entry that incurred the
missed meal.

For every The minimum number of continuous hours that must be
worked before a meal is considered missed, for example 5.00.
Any hours worked over this value without a meal break will
trigger the missed meal penalty.

Waive If Waives the second missed meal if hours worked are over this
value. If hours worked are over twice this value then no waive
occurs. A blank value means no waive occurs.

Minimum Meal The minimum number of hours that constitute a meal, e.g.
0.5 (30 minutes).

Adjust regular hours If checked the missed meal hours (the premium) will be
added to the regular time hours for the time entry.

Adjust pay amount If checked the pay amount will be increased by the missed
meal hours (the premium) * pay rate for the time entry.

Note: Only one missed meal premium will be computed each day. 

The additional regular hours or premium is added to the employee's regular hours for the
appropriate time entry. Also, the pay amount for that time entry will be increased by the
appropriate amount (regular hours x employee's pay rate). 

To make it easier to report on missed meal premiums, you can optionally define the
following two custom timesheet fields: "Meal Penalty Hours" and "Meal Penalty".

The "Meal Penalty Hours" field is the number of regular hours (the premium) added. This
is a number field, and is created from the System > Templates > Manage Custom Fields
page. You must name the field exactly as  shown (without the quotes). Once you have
created the field, you can later edit it and change the name if desired without affecting
operation. 

The "Meal Penalty" is the premium (number of regular hours added) multiplied by the
employee's pay rate. This is a currency field, and is created from the System > Templates
> Manage Custom Fields page. You must name the field exactly as  shown (without the
quotes). Once you have created the field, you can later edit it and change the name if
desired without affecting operation.

If you want to waive the missed meal calculation for a day you can create a checkbox
custom field named "Meal Penalty Waiver" and put it on the timesheet details. If checked
for a time entry that has a missed meal premium (visible by the comment added), then the
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premium will be removed. You must name the field exactly as  shown (without the quotes).
Once you have created the field, you can later edit it and change the name if desired
without affecting operation.

Calculation Notes

Meal penalties are computed using a California lab law approach in which total work hours
are divided into blocks of, in the case of California, 5 hours. This can result in somewhat
surprising behavior. For instance, let's suppose an employee works the following hours in a
day:

     In       Out  Hours

 9:00AM   12:00PM   3.00

12:45PM    6:45PM   6.00

You might expect that the employee would be granted a missed meal premium for the
second punch as it exceeds 5 hours. This would not be the case, however. The first 5 hour
work block starts at 9:00AM and goes to 2:45PM (accounting for the meal break from
12:00PM to 12:45PM). As there was a meal break in that 5 hour block no penalty is granted.
The next 5 hour block starts at 2:45PM (not 12:45PM!). As the employee clocked out at
6:45PM there are only 4 hours in this block, so no penalty is granted.

Missed Meal Premium Example

A typical example would be that of California:

Add: 1.00
For Every: 5.00
Waive If:
Minimum Meal: 0.50

To waive the second meal in California the configuration would be:

Add: 1.00
For Every: 5.00
Waive If: 6.00
Minimum Meal: 0.50

Automatic Split Shift Premium

The automatic split shift premium rule allows you to credit an employee with extra pay (the
premium) for every split shift worked. A split shift is one in which a day's work is divided
into two or more parts separated typically by at least one hour. The following properties are
supported:

Property Description

Shift separation The number of hours between two work shifts that, if greater
than this value, would indicate a split shift. In other words, if
two work shifts in a single day have a time separation greater
than this value then they are considered a split shift.

Minimum wage The minimum wage used in computing the premium. The
premium is computed according to the following formula:

Premium = M - ((E - M) x H)

Where M = Minimum pay, E = Employee's hourly rate and H =
the number of hours worked.
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The additional pay or premium is added to the employee's pay amount for the appropriate
time entry.

To make it easier to report on split shift premiums, the additional pay or premium is also
added to a timesheet custom field named "Split Shift Premium". You can create this field
from the System > Templates > Manage Custom Fields page. You must create a currency
field named exactly as shown (without the quotes). Once you have created the field, you
can later edit it and change the name if desired without affecting operation.

If you want to waive the split shift calculation for a day you can create a checkbox custom
field named "Split Shift Waiver" and put it on the timesheet details. If checked for a time
entry that has a split shift premium (visible by the comment added), then the premium will
be removed. You must name the field exactly as  shown (without the quotes). Once you
have created the field, you can later edit it and change the name if desired without affecting
operation.

Split Shift Example:

A typical example would be a shift separation of 1 hour. Let's presume an employee works
two shifts with more than 1 hour between them, for example:

8:00AM - 12:00PM - 4 Hours
2:00 PM - 6:00PM - 4 Hours

If the employee has a pay rate of $10.00/hour, and the minimum wage is set to
$12.00/hour, then the premium or additional wage would be:

Premium = 12 - ((10 - 12) * 8) = 28

The employee would gain an additional $28.00 pay.

-o-
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Absence Points Rules
Absence Points Rules

Absence points rules will automatically compute demerit points based on employee
tardiness and absence. You can tailor the rules so that different points can be added based
on coming in late, leaving early, or for different types of absences (e.g. excused sick leave
might be given different points than unexcused sick leave).
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Absence points rules require the configuration of the following custom timesheet template
fields:

Custom Field Type Description

Absence Points Number This field holds any absence points incurred. The number
of decimal digits depends upon your needs - if you allow
fractional points then you will want to set an appropriate
number, e.g. 2. Note that you must create this field
exactly as named, "Absence Points", in order to create
the expected underlying database field
(t_timeentry.xabsencepoints). After creating the field
you can then rename it as this will not affect the name
of the underlying database field.

Absence Reason List This field allows managers to specify an absence reason
for leave taken by employees. For instance, you may
have the reason "Excused" for excused absence, and the
reason "Unexcused" for unexcused absence. Each reason
can result in different points being added (see the
Absence rule below). Note that you must create this field
exactly as named, "Absence Reason", in order to create
the expected underlying database field
(t_timeentry.xabsencereason). After creating the field
you can then rename it as this will not affect the name
of the underlying database field.

Note that the list of reasons can have different absence
points configured for each reason. If you add or rename
any of the reasons in the list you will need to edit the
points again in the absence rule. See the Absence rule
below for information on how to configure points for each
absence reason.

Absence
Override

Check Box This field provides a way for the manager to override or
manually enter absence points on employee timesheets.
By checking the Absence Override check box the
manager can change or enter points into the Absence
Points field. Note that you must create this field exactly
as named, "Absence Override", in order to create the
expected underlying database field
(t_timeentry.xabsenceoverride). After creating the field
you can then rename it as this will not affect the name
of the underlying database field.

Absence Extra
(Optional)

Text, Text
Area, List

The Absence Extra field is optional and can be used to
record additional information about the absence. For
example, you may provide a list off additional reasons
for the absence, e.g. Medical Appointment, Plant Injury,
etc. Alternatively, you could simply have it be a text
area for entering additional details about the absence.
Note that you must create this field exactly as named,
"Absence Extra", in order to create the expected
underlying database field (t_timeentry.xabsenceextra).
After creating the field you can then rename it as this
will not affect the name of the underlying database field.

Warning Type Text, List This field allows you specify that a warning was given to
the employee, and is generally a list of values such as
Verbal, Written, etc. Note that you must create this field
exactly as named, "Warning Type", in order to create the
expected underlying database field
(t_timeentry.xwarningtype). After creating the field you
can then rename it as this will not affect the name of the
underlying database field.

Warning Points Number This field holds the absence points for the date of the
warning. The number of decimal digits should match
what you used for Absence Points. Note that you must
create this field exactly as named, "Warning Points", in
order to create the expected underlying database field
(t_timeentry.xwarningpoints). After creating the field
you can then rename it as this will not affect the name
of the underlying database field.

Warning
Description

Text, Text
Area, List

This field allows you to enter a description of the
warning given to the employee. Note that you must
create this field exactly as named, "Warning
Description", in order to create the expected underlying
database field (t_timeentry.xwarningdescription). After
creating the field you can then rename it as this will not
affect the name of the underlying database field.

Note that if creating a text area you should limit the size
to no more than 255 characters, as it is quite easy to
bump into the limits of a database's record size (e.g. 8K
for Microsoft SQL Server) if you create a few 2000
character text area fields. You will still be able to record
additional notes about the warning as these will go into
the time entry's notes field.

Timesheet custom fields are configured from the System > Templates > Manage Custom
Fields page. It is not required that you put these fields on the timesheet templates
themselves. However, if you want a manager to be able to review and edit the points while
reviewing and approving timesheets you will want to add these fields to the appropriate
timesheet templates. When adding these fields to a timesheet template you need to
specify the following Field Options for each of the above fields (by clicking the [...]
button next to the field name):

    [ ] Required
    [ ] Work only
    [x] Manager Only

This will ensure the fields appear for both work and leave time entries, and that only
managers (or administrators) can modify the values - the employee will not be able to
change them.
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The following absence rules can be configured:

Property Description

Absence rule If enabled then points will be added when leave hours are entered
on the timesheet. The number of points added depends on the
selected Absence Reason. For instance you might configure 0
points for the reason "Excused", and 5 points for the reason
"Unexcused". If no reason is selected then no points will  be added
by the rule.

Note that if the list of absence reasons is changed (by editing the 
Absence Reason custom field), then the points will need to be
entered for any new or renamed absence reasons.

In-late rule If enabled then points will be added depending upon how many
minutes late the employee came in. The employee must have the 
Scheduled In property set in their profile in order for this rule to
work. You can enter multiple levels of points, e.g. 2-5 minutes = .5
points, 6-15 minutes late = 1 point, etc.

Out-early rule If enabled then points will be added depending upon how many
minutes early the employee left. The employee must have the 
Scheduled Out property set in their profile in order for this rule to
work. You can enter multiple levels of points, e.g. 2-5 minutes = .5
points, 6-15 minutes late = 1 point, etc.

Too-few-hours rule If enabled then points will be added depending upon how much
less than the scheduled hours of work were performed in any given
day. The scheduled hours will be taken from the Scheduled Hours
Per Day property in the employee's profile, if set, or from the
default Hours Per Day property on the System > General page. 

Points can be configured in two ways based on the "Use percent of
scheduled hours" check box. If this check box is checked then how
many points are incurred will depend upon the percentage of
scheduled hours worked, for example 0-50% = 1 point, 51-99% =
.5 points and 100% = 0 points. 

If the "Use percent of scheduled hours" check box is not checked
then the points incurred will depend upon the number of minutes
early the employee left, for example 2-5 minutes = .5 points, 6-15
minutes = 1 point, etc.

Too-long-meal-break
rule

If enabled then points will be added depending upon how many
minutes beyond the specified meal break the employee takes. A
meal is considered any gap more than 15 minutes long between
two blocks of work. If there is more than one gap between blocks
of work in one day then the longest one is assumed to be the meal
break.

Note that what is considered a day is determined by the
employee's Scheduled Start and Scheduled Finish times (as
specified in the employee's profile on the Employees tab). For a
typical 9AM to 5PM schedule a day is from midnight to midnight.
For someone working the late shift the day will be centered over
their scheduled start and finish times, so may run from 12 Noon to
12 Noon. In this way the system will not inadvertently consider a
meal break to be the end of a day's work.
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The following global options can be set:

Property Description

Default reporting
period

The default time period to use when reporting employee absence
points. This can be overridden by the person viewing the report,
but is handy to ensure that the various reports default to an
appropriate date range for your business, such as "Last 365 Days".

Note that the absence points shown on the Home tab will always
be for the default reporting period. If the employee wants to view
points for other periods they can click the points link to view a
details report and change the reporting period.

Minimum/maximum
total points allowed in
period

Enter non-blank numeric values if you want to keep absence points
for employees from going below or above specified values. For
instance, if you do not want absence points to be less than zero
you would enter "0" for the "minimum total points  allowed" field.
Note that the minimum and maximum values do not affect the
individual absence point entries the employees receive. Instead,
the min/max rule is used when computing the total absence points
for an employee when you run the Absence Points report on the
Employees > Absence Points page.

As an example, suppose an employee had accumulated the
following absence points over the current year, and no minimum
total points were specified:

Date    Points  Total Points

----------------------------

Jan  1    1.00          1.00

Mar  3   -2.00         -1.00

Feb  7    1.00          0.00

Apr 22    1.00          1.00

============================

                        1.00

The total for the year if no minimum is set would be 1.00. If you
now specify a minimum total points of 0.00 then you get the
following total points:

Date    Points  Total Points

----------------------------

Jan  1    1.00          1.00

Mar  3   -2.00          0.00

Feb  7    1.00          1.00

Apr 22    1.00          2.00

============================

                        2.00

As you can see, the total points is now 2.00, but the individual
points entries were not altered.
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Warning Threshold The number of points beyond which you will be suggested to give a
warning to the employee. For example, if you specify 5.0 points as
the warning threshold then any employee with more than 5.0
points will be marked as needing review. If you wanted 5.0 to
trigger a warning then your threshold should be set to 4.99.

Warnings will not be automatically sent to employees. Instead,
when an employee's points are greater than the warning threshold
then the "Warning Action" column on the Absence Points
dashboard will show "Review", indicating the employee may need
to be warned by their manager. If warned then the manager would
then use the Absence Points dashboard to record the event. 

Adjusting Points

Managers and administrators can view and adjust absence points for individual employees.
This is done by viewing the Absence Points dashboard on the employee's profile page (note
that the Absence Points dashboard only appears for employees that have the Absence Points
Rules enabled on their employee policy). By clicking the Add Adjustment button you can
enter positive or negative absence points for specific dates. Adjustments can be deleted by
clicking the delete [-] button on each adjustment row on the dashboard.

-o-
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Security
Security

The security page allows you to control security-specific application settings, such as
authentication and password policies. Security has the following properties:

Property Description

Expire Idle Sessions After The number of minutes of inactivity allowed before a login
expires.

Authentication Type Multiple types of authentication are supported through a
pluggable authentication architecture. The following
authentication types are provided in the base product
package:

 Standard Authentication
 LDAP/Active Directory Authentication
 SAML 2.0 Authentication
 Okta Authentication
 OneLogin Authentication
 Ping Identity Authentication

Refer to the appropriate topics below for more information on
configuring these authentication types.

Standard Authentication

Standard authentication provides basic login management and strong password support
from with the application - no external authentication sources are required. Passwords are
stored securely in the database using a one-way encryption algorithm. Standard
authentication has the following properties:

Property Description

Maximum Invalid Login
Attempts

The maximum number of invalid login attempts before the
account is locked. Locked accounts must be either unlocked
by an administrator, or can be unlocked by the user by
requesting a new temporary password. To disable this feature
enter a blank value.

Maximum Password Age The number of days before employees are asked to create a
new password. To disable this feature enter a blank value.

Maximum Password
History

Password history keeps employees from reusing previous
passwords. Enter the number of passwords you want to keep
in the history, or blank to disable this feature.

Minimum Password Length The minimum number of characters allowed in new
passwords. To disable this feature enter a blank value.

Minimum Lower Case
Characters

The minimum number of lower case characters allowed in new
passwords (a..z). To disable this feature enter a blank value.

Minimum Upper Case
Characters

The minimum number of upper case characters allowed in
new passwords (A..Z). To disable this feature enter a blank
value.

Minimum Numeric
Characters

The minimum number of numeric characters allowed in new
passwords (0..9). To disable this feature enter a blank value.



p200

© 2000-2023, Pacific Timesheet

Minimum Special
Characters

The minimum number of special characters allowed in new
passwords (for example !,$#,%). To disable this feature enter
a blank value.

Other Authentication Types

LDAP/Active Directory Authentication
SAML Authentication
Okta Authentication
OneLogin Authentication
Ping Identity Authentication

Related Topics

 Permission Levels
 Permission Lists

-o-
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Permission Levels
Permission Levels

Permission levels have the following properties:

Property Description

Name The name of the permission level, up to 80 characters.

Description A description of the permission level, up to 255 characters.

Status The status determines whether the access level appears in
lists or not. This is useful if you cannot delete an access level
because it is in use by one or more employees.

General object permissions include:

Permission Description

View Determines whether an employee with this permission level
can view all or a limited subset of the objects. If set to limited
then the employee must be assigned to the individual objects
you wish them to see.

Report Determines whether an employee with this permission level
can report on all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to report on.

Manage Determines whether an employee with this permission level
can manage all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to manage. Management permissions
include:

Edit Can change properties of the object.

Edit Advanced Can change advanced properties of the
object, which generally means anything
involving bill, pay and other monetary rates
and amounts.

Create Can create new objects of this type.

Delete Can delete objects of this type.

Import Can import objects of this type.

Export Can export objects of this type.

Customize Can manage custom fields for objects of
this type.

Note that Leave Requests do not have any sub-permissions
for Manage, unlike many other objects in the system. The
'Can Manage' permission effectively gives the user the ability
to view leave requests in a read-only format on the Leave
Requests tab. You might use this permission if you want to
allow some employees to see leave requests for planning
purposes, but prefer other employees do the approvals.
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Approve Determines whether an employee with this permission level
can approve all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to approve.

Timesheet Special Permissions

There are some special timesheet permissions:

Permission Description

Can view my timesheet If not checked, the "My Timesheet" tab will not be shown,
even if the employee has a timesheet template in their
employee profile. This permission is useful for simplifying the
user interface for employees who meet all of the following
criteria:

1. They are not recording work hours
2. They are not required to submit their timesheet
3. They are only using the Leave Request feature on the

Home tab to record leave
4. Their employee policy's Schedule Rules is configured to

add leave requests to their timesheet

Can undo submit of my
timesheet

This applies to timesheet objects only, and determines
whether an employee can unsubmit (unlock) their timesheet.
Note that once a timesheet has been approved the employee
will not be able to unsubmit it, regardless of this permission.

Note that this permission also works in conjunction with the
"Can review my timesheet only" permission (see below). If
both are checked than the employee will be able to review
their timesheet in a read-only manner, and will be able to
"undo" and change their review.

Can copy my previous
timesheet hours

This permission determines whether employees can have
timesheet memory carry forward hours from the previous
timesheet (this is set from the Home > Preferences page).
This permission also determines whether the employee sees a
"Copy Previous Timesheet" option on their timesheet. If this
permission is off then the employee can only carry forward or
copy rows from the previous timesheet.

Note that if you turn this permission off, but an employee has
already set their timesheet memory to carry forward rows and
hours, you will need to also change their timesheet memory
setting from Employees page.

Can punch from time clock
device only

Turning this permission on will allow an employee to only
punch in/out from a time clock device, ensuring their physical
presence. The employee will not be able to punch in/out from
a web browser. The employee will still be able to add leave to
their timesheet using a web browser, however.
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Can edit my punches This applies to timesheets only, and determines whether an
employee can edit work time entries on their timesheet. If
this permission is not enabled then:

 Employees will not be able to edit the start, finish or hours
fields of their work rows manually.

 Employees will not be able to delete work rows from their
timesheets.

 Employees will not be able to delete their timesheet.

Employees will still be able to change the project or pay code,
enter notes, etc. of work rows. Also, this permission does not
affect leave rows - employees will be able to add leave rows
to their timesheet.

Can review my timesheet
only

This permission allows employees to see their timesheets in a
read-only view, and gives them the ability to review the time
entered for them. They can then accept the timesheet or
report a problem. This is useful for employees working in
crews where a site manager enters time for them.

Timesheet reviews can only be done by the employee, and
must happen BEFORE the timesheet is submitted (locked).
The review is stored in the timesheet notes field. Managers
can see the reviews from the Timesheets and Approvals tabs
with clear icons indicating whether the employee accepted the
timesheet or reported a problem.

Note 1: The employee review icons are only shown for
unsubmitted (unlocked) timesheets. Once submitted, the
review  icons are no longer shown (as the timesheet is
considered processed), but the review information is still
available in the timesheet notes field.

Note 2: If you want to allow the employee the ability to
"undo" their review, check the "Can undo submit of my
timesheet" permission (see above). They will be able to undo
and change their review until the timesheet is submitted
(locked) by their manager. However, they will not be allowed
to undo the submit of the timesheet, as the review permission
only allows read-only access to the timesheet.

Leave Request Special Permissions

There are some special leave request permissions:

Permission Description

Can create my leave
requests

Employees with this permission enabled (meaning they have
this permission enabled for the permission level in their
employee profile) will be able to create new leave requests for
pay codes they are allowed to access (based on their pay code
'Can view' permission). They will also be able to delete leave
requests they created as long as they have not been marked
as approved. To delete an approved leave request it must first
be unapproved by an approver.
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Can create for approvees Employees with this permission enabled (meaning they have
this permission enabled for the permission level in their
employee profile) will be able to create (and delete) leave
requests for employees. The list of employees they can do this
for depends on their 'Can approve' leave request permission,
as well as whether they are assigned as approvers to any
employees in their employee profiles.

Note that this permission requires the 'Can approve'
permission be enabled as a pre-requisite.

-o-
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Permission Lists
Permission Lists

A permission lists is a set of users and groups given special permissions to access an object.
This is useful in larger organizations where you want to distribute some of the application
management tasks to mulitple employees. Another use is to limit which objects, such as
projects, tasks or paycodes, that an employee can view and add to their timesheets.

-o-
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LDAP/Active Directory Authentication
LDAP/Active Directory Authentication

LDAP/Active Directory authentication allows you to authenticate employees against an LDAP
(Lightweight Directory Access Protocol) server. This includes Microsoft Active Directory when
it is configured with LDAP support (see the notes below). 

LDAP/Active Directory authentication has the following properties:

Property Description

LDAP Server The host name or IP address of the LDAP server.

LDAP Server Port The port number of the LDAP server. The default port number is
389 (or 636 if using SSL).

Use SSL Check this option if you want to connect to the LDAP server
using SSL (Secure Socket Layer). This option will increase your
security by encrypting all communications between the
timesheet application and the LDAP server. Your LDAP server
must be configured for SSL for this to work.

Login The login name of a technical or administrative user, if this LDAP
server requires authentication. Depending upon your directory
server a simple login name might work, such as "Directory
Manager", or you might need to enter a distinguished name such
as 
"CN=ADMINISTRATOR,CN=USERS,DC=PACIFICTIMESHEET,DC=
COM". Note that for some Active Directory installations you need
to enter this in upper-case.

Another variant for Active Directory is of the form
admin@pacifictimesheet.com. This is the SAM account name
followed by the domain of the Active Directory server.

Password The login password.

Search Base The LDAP search base, which determines where a search for
employees will start. This is a distinguished name (DN), such as
"DC=pacifictimesheet,DC=com".

Search Filter The LDAP search filter, which is used to find employees in the
directory. The value depends on the type of directory server and
how it is configured. For many open source LDAP servers the
following will work:

(&(objectClass=inetOrgPerson)(uid={0}))

For Microsoft Active Directory the following will generally work:

(&(objectClass=user)(sAMAccountName={0}))

Logging Check this option to help troubleshoot authentication failures.
Errors are logged to the System Event Log, and can be view with
the Reports > System Event Log report. For self-hosted systems
you can also view detailed information in the log files located in
the <PacificTimesheet>/tomcat/logs directory. 

You can test these settings by clicking the "Test Configuration" button. This will connect to
the specified LDAP server and perform a search, reporting any errors that arise.

When using LDAP/AD authentication you still need to have an employee account in Pacific
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Timesheet for each employee that will use the system. If an employee has an LDAP/AD login
but does not have a Pacific Timesheet login they will not be able to log in into Pacific
Timesheet. The LDAP/AD account is linked to the Pacific Timesheet account via the
employee's login name. For instance, if using AD you might be using the sAMAccountName
attribute to link to Pacific Timesheet (see the Search Filter property, above). So if the
sAMAccountName attribute is "jjones" then the Pacific Timesheet login name needs to be
"jjones", too.

What if you want to use the employee's email address as the login, but your Active
Directory (AD) sAMAccountName attribute is not an email address? Then you can refer to
another AD attribute, such as "mail", by altering the Search Filter property described
above. For example instead of using (&(objectClass=user)(sAMAccountName={0})) you
could instead use (&(objectClass=user)(mail={0})).

In the event of an LDAP failure, such as the directory server being unavailable, or no
matching user account being found in the directory, Pacific Timesheet will fail over to
standard authentication. The entered login name and password will be checked against the 
Pacific Timesheet database. This ensures an administrator will still be able to log in using
the Pacific Timesheet account, and change the LDAP settings if need be. This also allows you
to have accounts in Pacific Timesheet that are not in the directory server, such as 'admin'.

When using LDAP authentication your employees will no longer see the "Change Password"
link on their home page (unless an LDAP failure occurred and the standard authentication
was used instead, as described above). 

Microsoft Active Directory Notes

You will need to enable LDAP support in Active Directory (AD). Then add the object classes
and related attributes for the "inetOrgPerson" and "groupOfUniqueNames" object classes to
the Active Directory schema by using the Active Directory Management Console snap-in,
ADSIEdit. "groupOfUniqueNames" is defined in RFC 2256, "inetOrgPerson" in RFC 2798.

Pacific Timesheet employee accounts are linked to AD accounts via the SAM account name
("sAMAccountName" attribute) by default. You can use a different attribute, e.g. "mail", by
entering a custom Search Filter value, as described above. This is useful, for instance, if you
are using email addresses for the Pacific Timesheet logins.

-o-
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SAML 2.0 Authentication
SAML 2.0 Authentication

SAML 2.0 allows you to have single-sign-on (SSO) using a SAML 2.0 compliant identity
provider.

The first step to implementing SSO with Pacific Timesheet is to create a SAML 2.0
application in your identity provider. You will need to configure where to go to in the Pacific
Timesheet application. The will often be called the Single Sign On URL, the Recipient URL or
the Destination URL. Enter your Pacific Timesheet URL in its full format, e.g.

https://xyz.pacifictimesheet.com/timesheet/home.do

Replace the 'xyz' portion above with the subdomain you use.

Troubleshooting Note: Make sure compression is turned on for any SAML 2.0
configuration. Pacific Timesheet  expects the SAML data to be compressed.

Once you have created the Pacific Timesheet application icon you must then configure the
security settings in Pacific Timesheet. First, find the values you need to enter into Pacific
Timesheet by going to your identity provides Admin dashboard and finding the SSO settings
for the application created above. Enter the following information into Pacific Timesheet on
the System > Security page:

Property Description

Name This is the name used in the login button on the Pacific Timesheet
login page.

Issuer URL The value from the identity provider, for example:
https://app.onelogin.com/saml/metadata/439734

SAML 2.0 Endpoint
(HTTP)

The value from identity provider, for example:
https://app.onelogin.com/trust/saml2/http-post/sso/439734

Certificate The identity provider's X.509 security certificate. You can specify
both a primary certificate, and optionally a secondary certificate.
When a login request is authenticated the primary certificate is used
first, and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the primary one expires to ensure there is no loss of access
to the application when the primary certificate expires. Once the
primary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field. 

Note that the X.509 certificate should be in PEM format, meaning it
should start with the header line -----BEGIN CERTIFICATE----- and
end with the footer line -----END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted systems you can
also view detailed information in the log files located in the
<PacificTimesheet>/tomcat/logs directory.

When you use an identity provider to connect to Pacific Timesheet, you will need a
corresponding employee account in Pacific Timesheet. The identity provider's account
information (be it email address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The match will be made against the Pacific Timesheet account's login



p209

© 2000-2023, Pacific Timesheet

name, employee ID or email address, in that order.

Note: Even if SSO is enabled you can allow some employees to log in using Pacific
Timesheet's standard authentication (user name and password). On the login page the
employee can choose either to log in with the standard user name and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Timesheet
accounts that do not use the configured identity provider, such as the 'admin' account, or
client approver accounts, still able to log in with a user name and password.

-o-
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Okta Authentication
Okta Authentication

Okta authentication allows you to have single-sign-on (SSO) using the Okta SAML 2.0
identity provider.

The first step to setting up SSO with Okta is to create a new application icon in Okta named
Pacific Timesheet. Search the catalog for Pacific Timesheet and use that to create the new
application. Make sure you enter your subdomain, e.g. "xyz". This comes from your Pacific
Timesheet application URL, e.g. https://xyz.pacifictimesheet.com.

Troubleshooting Note: Make sure "Request Compression" is set to "Compressed" in your
Okta SAML configuration. Pacific Timesheet  expects the SAML data to be compressed.

Once you have created the Pacific Timesheet application icon in Okta you must then
configure the security settings in Pacific Timesheet. First, find the values you need to enter
into Pacific Timesheet by going to the Okta Admin > Applications page. Locate and click the
Pacific Timesheet application you created above, then go to the Sign On panel. Click the
View Setup Instructions and enter the following information into Pacific Timesheet on the
System > Security page:

Property Description

Name This is the name used in the login button on the Pacific Timesheet
login page.

Identity Provider
SSO URL

The value from Okta, for example:
https://xyz.okta.com/app/xyz/exk3ycblt53P0Gcry0h7

Identity Provider
Issuer

The value from Okta, for example:
https://www.okta.com/exk3ycblt53P0Gcry0h7

Certificate The Okta X.509 security certificate. You can specify both a primary
certificate, and optionally a secondary certificate. When a login
request is authenticated the primary certificate is used first, and if
that fails then the secondary certificate will be used. You would
typically provide a secondary certificate a few days or weeks before
the primary one expires to ensure there is no loss of access to the
application when the primary certificate expires. Once the primary
certificate is fully expired you can replace it with the secondary
certificate at your earliest convenience, then clear the secondary
certificate field. 

Note that the X.509 certificate should be in PEM format, meaning it
should start with the header line -----BEGIN CERTIFICATE----- and
end with the footer line -----END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted systems you can
also view detailed information in the log files located in the
<PacificTimesheet>/tomcat/logs directory.

When you use an identity provider to connect to Pacific Timesheet, you will need a
corresponding employee account in Pacific Timesheet. The identity provider's account
information (be it email address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The match will be made against the Pacific Timesheet account's login
name, employee ID or email address, in that order.
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Note: Even if SSO is enabled you can allow some employees to log in using Pacific
Timesheet's standard authentication (user name and password). On the login page the
employee can choose either to log in with the standard user name and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Timesheet
accounts that do not use the configured identity provider, such as the 'admin' account, or
client approver accounts, still able to log in with a user name and password.

-o-
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OneLogin Authentication
One Login Authentication

One Login authentication allows you to have single-sign-on (SSO) using the One Login SAML
2.0 identity provider.

The first step to setting up SSO with OneLogin is to create a new application icon in
OneLogin named Pacific Timesheet. Search the catalog for Pacific Timesheet and use that to
create the new application. Make sure you enter your subdomain, e.g. "xyz". This comes
from your Pacific Timesheet application URL, e.g. https://xyz.pacifictimesheet.com.

Once you have created the Pacific Timesheet application icon in OneLogin you must then
configure the security settings in Pacific Timesheet. First, find the values you need to enter
into Pacific Timesheet by going to the OneLogin > Apps page. Locate and click the Pacific
Timesheet application you created above, then go to the SSO panel. Enter the following
information into Pacific Timesheet on the System > Security page:

Property Description

Name This is the name used in the login button on the Pacific Timesheet
login page.

Issuer URL The value from OneLogin, for example:
https://app.onelogin.com/saml/metadata/439734

SAML 2.0 Endpoint
(HTTP)

The value from OneLogin, for example:
https://xyz.onelogin.com/trust/saml2/http-post/sso/439734

Certificate The OneLogin X.509 security certificate. You can specify both a 
primary certificate, and optionally a secondary certificate. When a
login request is authenticated the primary certificate is used first,
and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the primary one expires to ensure there is no loss of access
to the application when the primary certificate expires. Once the
primary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field. 

Note that the X.509 certificate should be in PEM format, meaning it
should start with the header line -----BEGIN CERTIFICATE----- and
end with the footer line -----END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted systems you
can also view detailed information in the log files located in the
<PacificTimesheet>/tomcat/logs directory.

When you use an identity provider to connect to Pacific Timesheet, you will need a
corresponding employee account in Pacific Timesheet. The identity provider's account
information (be it email address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The match will be made against the Pacific Timesheet account's login
name, employee ID or email address, in that order.



p213

© 2000-2023, Pacific Timesheet

Note: Even if SSO is enabled you can allow some employees to log in using Pacific
Timesheet's standard authentication (user name and password). On the login page the
employee can choose either to log in with the standard user name and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Timesheet
accounts that do not use the configured identity provider, such as the 'admin' account, or
client approver accounts, still able to log in with a user name and password.

-o-
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Ping Identity Authentication
Ping Identity Authentication

Ping Identity authentication allows you to have single-sign-on (SSO) using the Ping Identity
SAML 2.0 identity provider.

The first step to setting up SSO with Ping Identity is to create a new application icon in Ping
Identity named Pacific Timesheet. Log in as an administrator to Ping Identity, click the Add
Application button, and search the catalog for Pacific Timesheet. Use that to create a new
application, leaving all values at their default except for ACS URL and SP entityId. For
these two properties make sure to replace the ${Customer's subdomain} expression with
your Pacific Timesheet subdomain. For example, if your Pacific Timesheet URL is
https://xyz.pacifictimesheet.com, then your subdomain is 'xyz' and the values would be:

ACS URL     -> https://xyz.pacifictimesheet.com/timesheet/home.do

SP entityId -> https://xyz.pacifictimesheet.com/timesheet/home.do

Once you have created the Pacific Timesheet application icon in Ping Identity you must then
configure the security settings in Pacific Timesheet. First, find the values you need to enter
into Pacific Timesheet by going to the Ping Identity Admin > Applications page. Locate and
click the Pacific Timesheet application you created above to load the configuration
parameters. Enter the following values into Pacific Timesheet:

Property Description

Name This is the name used in the login button on the Pacific Timesheet
login page.

Initiate SSO URL The value from Ping Identity, for example:
https://sso.connect.pingidentity.com/sso/sp/initsso?saasid=b04a3a
23-0ccf-b8a5-b4d2f7f4f086

SSO Relay State The value from Ping Identity, for example:
https://pingone.com/1.0/b04a3a23-0ccf-b8a5-b4d2f7f4f086

Certificate The Ping Identity X.509 security certificate. You can specify both a 
primary certificate, and optionally a secondary certificate. When a
login request is authenticated the primary certificate is used first,
and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the primary one expires to ensure there is no loss of access
to the application when the primary certificate expires. Once the
primary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field. 

Note that the X.509 certificate should be in PEM format, meaning it
should start with the header line -----BEGIN CERTIFICATE----- and
end with the footer line -----END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted systems you
can also view detailed information in the log files located in the
<PacificTimesheet>/tomcat/logs directory.

When you use an identity provider to connect to Pacific Timesheet, you will need a
corresponding employee account in Pacific Timesheet. The identity provider's account
information (be it email address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The match will be made against the Pacific Timesheet account's login
name, employee ID or email address, in that order.
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Note: Even if SSO is enabled you can allow some employees to log in using Pacific
Timesheet's standard authentication (user name and password). On the login page the
employee can choose either to log in with the standard user name and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Timesheet
accounts that do not use the configured identity provider, such as the 'admin' account, or
client approver accounts, still able to log in with a user name and password.

-o-
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Notices
Notices

Notices are emails that can be sent to employees for various events that occur in the
application. 

Note: You must configure the SMTP settings before being able to send email notices. The 
System Settings topic has more information.

The following email notices can be sent:

Notice Description

Employee Late The Employee Late notice is sent to an employee's primary
approver if the employee punches in after their scheduled start
time (see the Managing Employees topic for more information
about the scheduled start time). For this notice to be sent
make sure the employee's "Scheduled Start" and "Approver"
properties are specified, and that their approver has a valid
email address in approver's employee profile.

Timesheet Due The Timesheet Due notice is sent to employees who have not
submitted their timesheet by a certain date. The date is
relative to the end of the timesheet period, either before or
after it. By default, this notice is not sent to employees using
leave-only timesheets, but you can override this setting.

Timesheet Late Like the Timesheet Due Notice, the Timesheet Late notice is
sent to employees who have not submitted their timesheet by
a certain date. The date is relative to the end of the timesheet
period, either before or after it. By default, this notice is not
sent to employees using leave-only timesheets, but you can
override this setting. You can optionally CC the employee's
approver(s) using the CC property.

Timesheet Rejected The Timesheet Rejected notice is sent to employees
immediately upon their timesheet being rejected.

Timesheet Submitted The Timesheet Submitted notice is sent to the employee's
primary approver immediately upon submission of their
timesheet.

Timesheet Approval Due The Timesheet Approval Due notice is sent to primary
approvers who have timesheets waiting their approval. This is
sent at a date relative to the end of the timesheet period,
either before or after it. You can optionally CC the employee's
backup approver(s) using the CC property.

Timesheet Approval Late Like the Timesheet Approval Due notice, the Timesheet
Approval Late notice is sent to primary approvers who have
timesheets waiting their approval. This is sent at a date relative
to the end of the timesheet period, either before or after it. You
can optionally CC the employee's backup approver(s) using the
CC property.

Request Approved The Request Approved notice is sent to request owners
immediately upon their leave request being approved.

Request Rejected The Request Rejected notice is sent to request owners
immediately upon their leave request being rejected.
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Request Submitted The Request Submitted notice is sent to the employee's
primary approver immediately upon submission of a leave
request.

Request Approval Due The Request Approval Due notice is sent to primary approvers
who have leave requests waiting their approval. This is sent at
a date relative to either the date of submission or the start
date of the requested leave. You can optionally CC the
employee's backup approver(s) using the CC property.

Request Approval Late Like the Request Approval Due notice, the Request Approval
Late notice is sent to primary approvers who have leave
requests waiting their approval. This is sent at a date relative
to either the date of submission or the start date of the
requested leave. 

You can optionally CC the employee's backup approver(s) using
the CC property.

The Request Approval Due notice can optionally keep resending
the notice if warranted. Checking this option will cause the
notice to be resent each day (for up to 14 days) until any
requests that are late for approval have been approved or
rejected.

Crew Timesheet Rejected The Crew Timesheet Rejected notice is sent to managers if the
crew timesheet they submitted is later rejected. This notice is
only available if the Crew Timesheet option is enabled (from
the System > Timesheet Options page).

Asset Sheet Approved The Asset Sheet Approved notice is sent to asset (e.g.
expense) sheet owners immediately upon their sheet being
approved.

Asset Sheet Rejected The Asset Sheet Rejected notice is sent to asset (e.g. expense)
sheet owners immediately upon their sheet being rejected.

Asset Sheet Submitted The Asset Sheet Submitted notice is sent to the employee's
primary approver immediately upon submission of an asset
(e.g. expense) sheet.

Asset Sheet Approval Due The Asset Sheet Approval Due notice is sent to primary
approvers who have asset (e.g. expense) sheets waiting their
approval. This is sent at a date relative to the date of
submission of the sheet. You can optionally CC the employee's
backup approver(s) using the CC property.

Asset Sheet Approval Late Like the Asset Sheet Approval Due notice, the Asset Sheet
Approval Late notice is sent to primary approvers who have
asset (e.g. expense) sheets waiting their approval. This is sent
at a date relative to the date of submission of the sheet. 

You can optionally CC the employee's backup approver(s) using
the CC property.

The Asset Sheet Approval Due notice can optionally keep
resending the notice if warranted. Checking this option will
cause the notice to be resent each day (for up to 14 days) until
any sheets that are late for approval have been approved or
rejected.

Editing Notices
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Administrators can edit the subject and body of the notices. The subject is plain text, but
the body can be either plain text or HTML. If using HTML then the body must be enclosed by
<html> and </html> tags. The body text can be up to 4000 characters. Both the title and
body can contain the following substitution variables:

Substitution Variables

Variable Description Notes

${Crew.name} The name of the crew or group. For Crew notices only.

${Crew.url} The address of the Crew Timesheet
page. This value is based on the
Application URL system property, which
can be modified on the System Settings
page.

For Crew notices only.

${Request.approve.url} Request owner's full name. For Request notices
only.

${Request.date} Request date range, as entered by user. For Request notices
only.

${Request.description} Request description, as entered by the
employee.

For Request notices
only.

${Request.rejecter} The manager who rejected the request. For Request Rejected
notice only.

${Request.rejectMessage
}

Request rejection message, in request is
rejected.

For Request Rejected
notice only.

${Request.type} Request type, for example "Vacation". For Request notices
only.

${Request.user.fullName} Request owner's full name. For Request notices
only.

${System.applicationNam
e}

Application Name, as specified in the 
Branding page.

For all notices.

${System.companyName
}

Company Name, as specified in the 
Branding page.

For all notices.

${System.currentDate} Current date For all notices.

${System.currentDateTim
e}

Current date and time For all notices.

${System.currentTime} Current time For all notices.

${System.url} Address of login page. This value is
based on the Application URL system
property, which can be modified on the 
System Settings page.

For all notices.

${TimeSheet.approve.url} Address of the timesheet approval page.
This value is based on the Application
URL system property, which can be
modified on the System Settings page.

For Timesheet notices
only.

${TimeSheet.period} Timesheet period For Timesheet notices
only.

${TimeSheet.rejecter} The manager who rejected the
timesheet.

For Timesheet
Rejected and Crew
Timesheet Rejected
notices only.
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${TimeSheet.rejectMessa
ge}

The timesheet rejection reason. For Timesheet
Rejected notice only.

${TimeSheet.url} Address of 'My Timesheet' page. This
value is based on the Application URL
system property, which can be modified
on the System Settings page.

For Timesheet notices
only.

${TimeSheet.user.fullNam
e}

Timesheet owner's full name. For Timesheet notices
only.

${User.fullName} Employee full name, in FIRSTNAME
LASTNAME format.

For all applicable
notices.

${User.list} A list of employees. The list will depend
on the type of notice. For instance, in
the Timesheet Approver Due and
Timesheet Approver Late notices this
value will resolve to the list of
employees with timesheets that need
approving.

For all applicable
notices.

${User.login} Employee login name For all applicable
notices.

${User.scheduledIn} Employee's scheduled start time. For Employee Late
notice only.

${User.actualIn} Employee's actual start time. For Employee Late
notice only.

${Sheet.approve.url} Address of the Asset Sheet approval
page. This value is based on the
Application URL system property, which
can be modified on the System Settings
page.

For Asset Sheet
notices only.

${Sheet.date} Asset sheet date/date range, as entered
by the employee.

For Asset Sheet
notices only.

${Sheet.description} Asset sheet description, as entered by
the employee.

For Asset Sheet
notices only.

${Sheet.rejecter} The manager who rejected the asset
sheet.

For Asset Sheet
Rejected notice only.

${Sheet.rejectMessage} Asset sheet rejection message, if any. For Asset Sheet
Rejected notice only.

${Sheet.type} Asset sheet type, e.g. "Expense". For Asset Sheet
notices only.

${Sheet.user.fullName} Asset sheet owner's full name. For Asset Sheet
notices only.

-o-
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Schema (Self-Hosted Version Only)
Schema

A schema is a set of database tables, and is used by the application to store timesheet data
and settings. If you are hosting the application yourself you can review your schema
settings, as well as edit or create a new schema. Normally you would use the schema
created by the installer and never change these settings. But if you would like to use an
external database like Microsoft SQL Server or Oracle, or if you installed the WAR version of
the application, you will need to create a new schema before you can use the system. 

Note: For security reasons you may only access the Schema page if you are on the
computer running the timesheet service.

For a list of supported databases and versions refer to the System Requirements topic. The
installer provides the following database:

Bundled Database

MySQL 5.0.22 Default TCP/IP Port: 3316
Administrative Login: See the "Bundled Software" section in
timesheet-install.pdf

The Schema page is located at the following address:

http://localhost/timesheet/system/db-show.do

If you changed the default HTTP port from 80 then you will need to specify the port number,
too, for example:

http://localhost:8080/timesheet/system/db-show.do

This will load a page showing the current schema configuration. You can edit this schema
configuration by clicking the Edit button, or create a new schema by clicking the Create
button. Note that for security reasons you need to be using a browser on the same machine
that the application is installed on.

Editing the schema configuration will not alter the schema, just the settings that the
application uses to connect to the schema. Creating a new schema will not delete or alter
the old schema, but will create a new schema and update the settings so that the
application will use the new one.

Schema Properties

Database Type

The type of database management system (DBMS) to be used. The following types are
supported:

Server Address

The TCP/IP address or host name of the database server. Use localhost if the database
server is running on the same computer as the application.

Server Port

The TCP/IP port number used by the database server. The value will default to the number
appropriate for the database type, which is generally the value you want to use.
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Schema Name/Oracle SID

For Microsoft and MySQL the schema name is the name of the database. For Oracle you
would use the SID (Server IDentifier).

Login Name

The login name for the database account to use when connecting to the database server.

Password

The password for the login.

When creating a new schema you have the following additional properties:

Admin Login

The login name for the administrative account for the database server. Note that if creating
a new schema or database using the bundled MySQL database, the default administrative
login is root with the password is timesheet.

Admin Password

The password for the administrative account. Note that if creating a new schema or
database using the bundled MySQL database, the default administrative login is root with
the password is timesheet.

New Schema Name

For Microsoft and MySQL this is the name of the new database to create. For Oracle this is
the name of the new tablespace to create.

New Login

The login name for the new database account to use when connecting to the database
server.

For Oracle Database 12c or later the login name must begin with the three characters
'C##' or 'c##' (without the quotes).

New Password

The password for the new login.

SQL Server 2005 Note: SQL Server 2005 has stricter login and password rules than SQL
Server 2000 by default. Make sure the password for the new database schema doesn’t
match the new schema name, as this will often cause an error. You can see details for the
error message in the log files, located in the tomcat/logs directory of the installation
directory.

-o-
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Custom Fields
Custom Fields

You can customize many objects in the application by adding new data fields. Custom fields
allows you to store additional information with an object, such as a text string, a date, a file
attachment or any other value as needed for your business-specific requirements. You can
manage custom fields for objects from the "Manage Custom Fields" link on the options menu
on the page that lists the objects. For instance, to manage Employee custom fields you go
to the Employees page, click the options menu (the small triangle to the top-right of the
employee list) and choose "Manage Custom Fields". If you do not see this you may not have
management permissions for this type of object - check your Permission Level in your
employee profile to verify that you have the appropriate permissions.

Once created, custom field values can be set through the web interface for each object, or
imported/exported. You can create reports that include the custom fields as well. 

Note: If you create a report with a custom field, then later delete the custom field, the
report will generate an error when run. This is because the database column is now
missing. To correct this simply edit the report and remove the obsolete report column in
order for the report to run correctly again.

Custom fields have the following properties:

General Properties

Field Name

The name of the custom field. This is the name that will appear on the properties form, as
well as in import/export files. This field is required and can be up to 80 characters. 

Note: When saving a new custom field for the first time the system will create a database
column to hold values based on the name you enter. You can rename the custom field at
any time after this, but the internal database column name will not change (in order to
prevent custom SQL reports from not working). Therefore, if you are required to create a
custom field with a specific name (for example, for Absence Points Rules) you must enter
it exactly as specified the first time (including the proper upper/lower case lettering).

Type

The type of custom field, which can be one of the following:

Type Description

Checkbox A field representing a true/false choice.

Currency A number representing a currency amount. The value
can be entered as an edit box or as a drop-down list.

Date A date value.

Date and Time A date and time value.

Email Address A text field for entering and displaying an email
address.

Employee An employee selection.

File Attachment Allows uploading and downloading of a file. Maximum
size is limited to 250MB.
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Image Allows uploading and displaying of an image. Maximum
size is limited to 250MB. Supported image file formats
are PNG, GIF and JPG.

List A text field allowing the selection of one or more
choices from a list of choices. Note that the List type is
only for lists of text items (Number and Currency type
fields can also have lists but those are configured
directly from their properties page).

Number A numeric value, allowing an arbitrary number of
decimal places of precision. The value can be entered
as an edit box or as a drop-down list.

Text A text value, entered via an edit box.

Text Area A text value that allows line breaks.

Time A time of day value.

Web Link A text field for entering and displaying a web address.

You can only specify the type when adding a new custom field. If you need to change the
type of an existing custom field you need to delete the existing one and create a new one.

Position

The position determines where on the form the field will appear.

Start New Field Group

Checking this option will cause a horizontal line to appear immediately before this field. This
is useful when grouping several related fields.

Description

A description of this field. This should be as brief as possible, but can be up to 255
characters.

Required

Checking this option will require a value for this field.

Default Value

Specifies the default value for the custom field.

Timesheet custom fields that are text (e.g. Text, Text Area, List, etc.) also allow you to
default the value to an employee property by using the ${User.xyz} variable, where User
refers to the employee object and xyz is the name of the employee property. For example
${User.lastName} would default the value to the employee's last name. If you had an
employee custom field named "Pay Class" then you would use ${User.xPayClass}.

Checkbox Properties

Checkbox Text

Text or label that appears to the right of the checkbox. This should be as terse as possible,
but can be up to 80 characters.

Currency Properties
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Currency

The currency symbol.

Decimal Digits

The number of digits to display after the decimal point. This can be zero if displaying an
integer value.

Input Type

The type of input widget used, either an edit box or a drop-down list.

Minimum Value

If the Input Type is set to Edit Box, then you can specify the minimum value that can be
entered. Leave this blank if there is no minimum value.

Maximum Value

If the Input Type is set to Edit Box, then you can specify the maximum value that can be
entered. Leave this blank if there is no maximum value.

List Choices

If the Input Type is set to Drop Down List, then you can specify the numbers in the list.
Enter each number on a separate row by pressing the enter key, for example:

1.00

2.00

3.00

...

The number format is entered in the locale of the administrator making the changes, but
when the list is presented to employees the numbers will be reformatted as appropriate for
their locale, as well as have the currency symbol added. For example, if the employee has
the French locale and the currency was set to EUR then they would see the list formatted as
follows:

€1,00

€2,00

€3,00
...

Image

Image custom fields allow you to upload an image, which will be presented as a smaller
thumbnail that can be clicked to view at its native or full resolution. Supported image file
formats are PNG, GIF and JPG.

Thumbnail Width
Thumbnail Height

The default thumbnail size if not specified is 500x500 pixels. You can specify your own size
here, in pixels. Images whose native size is smaller than this will not be scaled up, but
images larger than this will be scaled down, so the thumbnail size represents the maximum
size shown to the user. The original image can always be viewed by clicking on the
thumbnail.
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List

List Style

The style of the list control, which can be either a drop-down menu or a list box.

List Box Height

The height of the list box, in rows.

Multiple Selection

Checking this option allows multiple selections. Note that multiple selections are stored in
same field just like single selections, but with each selection being separated by a line break
character.

List Choices

Enter your list choices here, with each choice starting on a new line.

Number

Decimal Digits

The number of digits to display after the decimal point. This can be zero if displaying an
integer value.

Input Type

The type of input widget used, either an edit box or a drop-down list.

Minimum Value

If the Input Type is set to Edit Box, then you can specify the minimum value that can be
entered. Leave this blank if there is no minimum value.

Maximum Value

If the Input Type is set to Edit Box, then you can specify the maximum value that can be
entered. Leave this blank if there is no maximum value.

List Choices

If the Input Type is set to Drop Down List, then you can specify the numbers in the list.
Enter each number on a separate row by pressing the enter key, for example:

1.00

2.00

3.00

...

The number format is entered in the locale of the administrator making the changes, but
when the list is presented to employees the numbers will be reformatted as appropriate for
their locale. For example, if the employee has the French locale they would see the list
formatted as follows:

1,00

2,00
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3,00

...

Text

Maximum Characters

The maximum number of characters that can be entered in this field. This can be up to 255
characters.

Text Area

Maximum Characters

The maximum number of characters that can be entered in this field. This can be up to
4000 characters.

Rows

The height of the text area, in rows.

-o-
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Importing/Exporting
Importing/Exporting

You can import and export objects such as employees, groups and tasks in CSV (Comma
Separated Value) format. Note that your ability to import or export will depend upon your
permission level: administrators can import and export any object but other permission
levels may have the ability to import or export disabled.

CSV Formatting Notes

In order to make data interchange as reliable as possible, the following formatting rules are
followed:

 By default, dates, times and numbers are formatted for the locale of the user doing
the import/export. You can override the date and time formatting for each export from
the System > General > Data Integration page.

 Unicode (UTF8) character encoding is used in order to fully support international
languages. Make sure you save your CSV files in UTF8 format in order to not lose
accented characters, etc. Exported CSV data is always generated in UTF8 format.

 Field values with commas or carriage returns are 'escaped' by enclosing the value in
double-quotes.

 Fields with multiple values have each value separated by a carriage return (also
called a "hard" carriage return in Excel, entered using ALT+ENTER). Alternatively, when
importing data you can optionally specify a semicolon ";" character instead, if you
prefer.

In addition:

 All fields are optional unless otherwise noted.
 The behavior of blank values depends on the field.
 A header record at the start of the file is required.

Match Field

When importing some types of objects you can specify a match field, which is used to avoid
creating duplicates. The match field determine which property is used to match against
existing objects to avoid duplicates. For instance, when importing employees you generally
you would use the Login Name, but the Employee ID and Email are also options.

Objects

The following objects can be imported and exported in CSV format - click the links for a
detailed description of the CSV fields:

 Assets
 Asset Classes
 Asset Entries
 Bill Rates
 Customers
 Employees
 Employee Balances
 Groups
 Pay Rates
 Projects

http://en.wikipedia.org/wiki/Comma-separated_values


p228

© 2000-2023, Pacific Timesheet

 Project Groups
 Tasks
 Task Groups
 Timesheets

-o-
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Asset CSV Format
Asset Fields

Field Description Format

Name Asset name. When adding a new asset this field is required. This
value must be unique for all assets, regardless of the asset type.

Text (80 chars
max)

ID Asset ID. This field is not required, but if present and the value is
not blank then it must be unique for all assets, regardless of the
asset type.

Text (80 chars
max)

Descri
ption

A description of this asset. Text (255 chars
max)

Status Asset status. Possible value are:
Value Description
Active The asset is active and available for use.
Inactive The asset is not available for use, but can still be

optionally reported on.

Text

Type The asset type (name or ID). The asset type of the asset class
will be used if this is not specified. If no asset class specified then
this is required when adding a new asset and there are more than
one asset types defined. 

Text

Class The asset class (name or ID). This is optional, but if not specified
and you are creating a new asset you must then specify the Type
field.

Text

Units The unit of measurement (name or ID). Text

Unit
Cost

The cost per unit of measure for this asset. The cost is the
amount you paid for this asset.

Number

Unit
Price

The price per unit of measure for this asset. The price is the
amount you charge for this asset.

Number

Unit
Marku
p

The markup or margin percentage. Only applicable if the Unit
Price Flag is set to Markup or Margin.

Number

Unit
Price
Flag

If you are not specifying a fixed Unit Price you can have the
system compute it. Possible values are:
Value Description
Fixed Price The Unit Price is as entered.
Markup The Unit Price is computed as a percent markup of

the Unit Cost.
Margin The Unit Price is computed as a percent margin of

the Unit Cost.

Text

Decim
al
Digits

The number of decimal digits to allow when entering quantities of
this asset. If not specified then the default value of the Units will
be used.

Number
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Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this asset. Text (2000
chars max)

-o-
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Asset Class CSV Format
Asset Class Fields

Field Description Format

Name Asset class name. When adding a new asset this field is required.
This value must be unique for all asset classes, regardless of the
asset type.

Text (80 chars
max)

ID Asset class ID. This field is not required, but if present and the
value is not blank then it must be unique for all asset classes,
regardless of the asset type.

Text (80 chars
max)

Descri
ption

A description of this asset class. Text (255 chars
max)

Status Asset class status. Possible value are:
Value Description
Active The asset class is active and available for use.
Inactive The asset class is not available for use, but can still

be optionally reported on.

Text

Type The asset type (name or ID) for this asset class. If there are
multiple asset types defined then this field is required.

Text

-o-
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Asset Entry CSV Format
Asset Entry Fields

The following fields can be imported/exported. 

Note: When importing, the header field name must match the value below exactly in
order to be recognized.

Note: When exporting, you can combine fields using custom export field expressions.
See the Expression Fields topic for more information.

Field Description Format

Date The date this asset was used. Date

ID The asset entry ID.  This field is not
required, but if present and the value is not
blank then it must be unique for all asset
entries, regardless of the asset type. Note
that the system will automatically generate
this value when adding new entries if a
value is not provided. If a value is present
when importing then any existing entry
with a matching ID will be updated, rather
than a new entry being added.

Text (80 chars max)

Description A description for this asset entry. Text (255 chars max)

Asset The asset (name or ID) used for this entry.
If specified then the asset's class and units
will be assumed for this entry.

Text

Type The asset type (name or ID) for this entry.
The asset type of the asset will be used if
this is not specified. If no asset specified
then this is required when adding a new
asset entry and there are more than one
asset types defined. 

Text

Class The asset class (name or ID) for this entry.
This is optional and will be set to the value
for the Asset if not specified.

Text

Units The unit of measurement (name or ID) for
this entry. This is optional and will be set to
the value for the Asset if not specified.

Text

Quantity The number or quantity of units used for
this entry.

Number

Unit Cost The cost per unit of measure for this asset
entry. The cost is the amount you paid for
this asset. This is optional and will be set to
the value for the Asset if not specified.

Number

Total Cost The total cost for this asset entry. This is
optional and if not specified will be
computed as Quantity x Unit Cost.

Number

Unit Price The price per unit of measure for this asset.
The price is the amount you charge for this
asset. This is optional and will be set to the
value for the Asset if not specified.

Number
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Total Price The total price for this asset entry. This is
optional and if not specified will be
computed as Quantity x Unit Price.

Number

Employee The employee (name or ID) this asset entry
is to be associated with. If not specified
then this will default to the employee doing
the import when creating new entries.

Text

Reporting
Group

The reporting group (name or ID) this asset
entry is to be associated with. If not
specified then this will default to the
reporting group of the employee doing the
import when creating new entries.

Text

Customer The customer (name or ID) this asset entry
is to be associated with.

Text

Project
Group

The project group (name or ID) this asset
entry is to be associated with.

Text

Project The project (name or ID) this asset entry is
to be associated with.

Text

Task Group The task group (name or ID) this asset
entry is to be associated with.

Text

Task The task (name or ID) this asset entry is to
be associated with.

Text

Submitted A value of either Yes or No depending upon
whether this asset entry has been
submitted (locked).

Text

Submit Date If the entry is submitted then this will be
the date and time of the submit.

Date

Submitted
By

The employee (name or ID) who submitted
the entry.

Text

Approved A value of either Yes or No depending upon
whether this asset entry has been
approved.

Text

Approval
Date

If the entry is approved then this will be
the date and time of the approval.

Date

Approved By The employee (name or ID) who approved
the entry.

Text

Export Date If this entry has been marked as exported
then this will be the date and time of the
export. You can use this field to 'unmark'
entries that have been inadvertently
marked as exported by specifying a value
of 1/1/1970.

Date

Exported By The employee (name or ID) who marked
the entry as exported.

Text

Notes Notes about this asset entry. Text (2000 chars max)

-o-
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Bill Rates CSV Format
Bill Rates Fields

Field Description Format

Object The name of primary object that rates
depend on, for example "Employee". This is
optional if the Object ID field is supplied.

Text (80 chars max)

Object ID The ID of the primary object the rates
depend on, for example "222-99-5555".
This is optional if the Object field is
supplied.

Text (80 chars max)

Subobject The name of exceptioin object that rates
depend on, for example "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID is
optional if you are setting the default rate
for the object.

Text (80 chars max)

Subobject ID The ID of the exception object the rates
depend on, for example "Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default
rate for the object.

Text (80 chars max)

Bill Rate The rate for this object/subobject. The rate
can be either a numeric value, or the name
of a rate as defined in the System > Bill
Rate Options page.

Number/Text

-o-
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Customer CSV Format
Customer Fields

Field Description Format

Name Customer name. If this field is present in the CSV data then a
value is required, and is always required when adding new
customers.

Text (80 chars
max)

ID Customer ID. This field is not required, but if present and the
value is not blank then it must be unique for all customers.

Text (80 chars
max)

Descri
ption

A description of this customer. Text (255 chars
max)

Status Customer status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this customer. Text (2000
chars max)

-o-
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Employee CSV Format
Employee Fields

Field Description Format

Login Name Employee login name. If this field is present in the CSV data then
a value is required, and is always required when adding new
employees.

Text (80
chars
max)

Password Employee password. This field is not exported but can be
imported. Updating an employee's password through an import
creates an expired password - the employee will be asked to
enter a new one the next time they log in.

Text (40
chars
max)

First Name First name. Text (80
chars
max)

Last Name Last name. If this field is present in the CSV data then a value is
required, and is always required when adding new employees.

Text (80
chars
max)

ID Employee ID. This field is not required, but if present and the
value is not blank then it must be unique for all employees.

Text (80
chars
max)

Status Employee status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.
Locked Employee cannot log into system, but shows up on

reports, etc. by default. An employee can become
locked due to too many unsuccessful login attempts.

Text

Permission
Level

The default permission level, for example Employee. Text

Employee
Type

The type of employee. Text

Policy The policy for this employee. Text

Job Title Job title. Text (80
chars
max)

Reporting
Group

The name of the primary or reporting group. Text

First Day The first day of employment. Date

Last Day The last day of employment. Date

Scheduled
Work Days

The scheduled days of the week that are considered work. This is
formatted as a list of names of the days of the week separated by
spaces, for example "Mon Tue Wed Thu Fri". The name of the day
can be the standard abbreviation or the full name, as appropriate
for the language of the locale of the user doing the import.

Text

Scheduled
Hours

The number of hours the employee is scheduled to work each
week.

Number

Scheduled
Start

The time of day the employee is scheduled to start work or
"punch in".

Time
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Scheduled
Finish

The time of day the employee is scheduled to finish work or
"punch out".

Time

Email Email address. Text (80
chars
max)

Phone Phone number. Text (40
chars
max)

Mobile Mobile phone number. Text (40
chars
max)

Fax Fax number. Text (40
chars
max)

Timesheet
Template

The timesheet template for this employee. Text

Timesheet
Memory

This controls whether rows and hours are carried forward from
the previous timesheet to new timesheets. Possible values are:
Value Description
None None (or a blank value) indicates no

rows or hours will be carried forward.
Rows Timesheet rows will be carried forward

from previous timesheet.
Rows and Hours Timesheet rows and hours will be

carried forward from previous
timesheet.

Text

Punched In A "Yes"/"No" value indicating whether the employee is punched in
or not. This is a read-only value and will be ignored if imported.

Text

Locale Locale. The locale determines how dates and numbers are
formatted. Locale are specified using ISO codes, and possible
values are defined in the Locale Codes appendix.

Text (5
chars
max)

Time Zone Time zone. Time zones are specified using Olson IDs, and possible
values are defined in the Time Zone Codes appendix.

Text (40
chars
max)

Bill Rate The default bill rate. This can be a named rate, or a custom
numeric value.

Text or
Number

Pay Rate The default pay rate. This can be a named rate, or a custom
numeric value.

Text or
Number
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Groups The list of groups this employee is a member of. If a user belongs
to multiple groups then each group is separated by a carriage
return. If formatting an import file using Excel you can enter
multiple lines in a cell using ALT+ENTER (also called a "hard"
carriage return). 

Depending upon your integration needs, you may want to narrow
the scope of which groups are set in the import file.  By default, if
the Groups column is present, the user is removed from ALL
groups and placed in the group(s) specified in the import file.  If
you want to only set their permission groups and not alter
reporting groups or crews they are in, you can append the ":P"
suffix to the column header: "Groups:P". The following suffixes
can be used:

Suffix Description
Groups:P Takes the user out of all permission

groups (groups that do not have the
Reporting Group or Crew type checked)
and adds them to the groups specified
in the import file.  If no groups are
specified in the import file then they will
belong to no permission groups. This
will not remove the user from any
reporting or crew groups they may
currently be members of.

Groups:NC Takes the user out of any groups that
are not crew groups, and adds them to
the groups in the import file.  In other
words, this suffix will ensure the list of
crews a user is a member of will not be
changed.

Text

Notes Notes about this employee. Text
(2000
chars
max)

Approver The name of the primary timesheet approver for the employee.
The name can be a login name, employee ID, or full name (either
"first last" or "last, first" is accepted).

Text

Approver
Backup

The name of the backup timesheet approver for the employee.
The name can be in the form of a login name, employee ID, or
full name (either "first last" or "last, first" is accepted).

Text

-o-
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Employee Balances CSV Format
Employee Balances Fields

Field Description Format

Employee Employee login name. Either this field or
Employee ID must be specified when
importing.

Text (80 chars max)

Employee ID Employee ID. Either this field or Employee
must be specified when importing.

Text (80 chars max)

Balance Balance name. Either this field or Balance
ID must be specified when importing.

Text (80 chars max)

Balance ID Balance ID. Either this field or Balance
must be specified when importing.

Text (80 chars max)

Date When importing this is the date the Value
or Change should take effect. When
exporting this is the current date.

Date

Value The value of the balance, in hours. When
importing the balance will be set to this
value as of the specified Date. This field is
ignored when importing if Change is
specified. When exporting this is the
current balance.

Number

Change The number of hours to add or deduct from
the balance for the specified Date. This field
overrides any value in the Value field when
importing. This field is only applicable when
importing.

Number

Comment A comment about this change. This field is
only applicable when importing.

Text (255 chars max)

-o-
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Expense Entry CSV Format
Importing Expense Entry Data

You have the option to import employee company or personal credit card expense entry
data into the system. The first step is to prepare a data file that matches the following
specification in a .csv format. When importing expense entry data rows, you want to sort
each employee’s expense data by employee name, then date. During the import, the system
will dynamically create a new Expense Sheet ID for the employee’s expense entries being
imported.  

Note: When importing, the header field name must match the value below exactly in
order to be recognized.

Note: When exporting, you can combine fields using custom export field expressions.
See the Expression Fields topic for more information.

Field Description Format

Date The date this expense was incurred. Date

ID The expense entry ID.  This field is not
required, but if present and the value is not
blank then it must be unique for all expense
entries, regardless of the expense type. Note
that the system will automatically generate
this value when adding new entries if a value
is not provided. If a value is present when
importing then any existing entry with a
matching ID will be updated, rather than a
new entry being added.

Text (80 chars max)

Description A description for this expense entry. Text (255 chars max)

Expense The expense (name or ID) type used for this
entry. If specified then the expense's class
and units will be assumed for this entry.

Text

Type The expense type (name or ID) for this
entry. The expense type of the expense will
be used if this is not specified. If no expense
specified then this is required when adding a
new expense entry and there are more than
one expense types defined.

Text

Class The expense class (name or ID) for this
entry. This is optional and will be set to the
value for the Expense if not specified.

Text

Units The unit of measurement (name or ID) for
this entry. This is optional and will be set to
the value for the Expense if not specified.

Text

Quantity The number or quantity of units used for this
entry.

Number

Unit Amount The cost per unit of measure for this
expense entry. The cost is the amount you
paid for this expense. This is optional and
will be set to the value for the Expense if not
specified.

Number
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Amount The total cost for this expense entry. This is
optional and if not specified will be computed
as Quantity x Unit Cost.

Number

Unit Bill Amount The price per unit of measure for this
expense. The price is the amount you charge
for this expense. This is optional and will be
set to the value for the Expense if not
specified.

Number

Bill Amount The total price for this expense entry. This is
optional and if not specified will be computed
as Quantity x Unit Price.

Number

Employee The employee (name or ID) this expense
entry is to be associated with. If not
specified then this will default to the
employee doing the import when creating
new entries.

Text

Reporting Group The reporting group (name or ID) this
expense entry is to be associated with. If not
specified then this will default to the
reporting group of the employee doing the
import when creating new entries.

Text

Customer The customer (name or ID) this expense
entry is to be associated with.

Text

Project Group The project group (name or ID) this expense
entry is to be associated with.

Text

Project The project (name or ID) this expense entry
is to be associated with.

Text

Task Group The task group (name or ID) this expense
entry is to be associated with.

Text

Task The task (name or ID) this expense entry is
to be associated with.

Text

Notes Notes about this expense entry. Text (2000 chars max)

Sheet.ID The ID of the expense sheet. If present
when importing then it will be used to locate
an existing sheet and attach this entry to it.
If not found, and the system is generating
the ID, then an error will be generated.

Text (80 chars max)

Sheet.Start Date The start date of the expense sheet. If
present when importing, and there is no
Sheet.ID value, then it will be used to locate
an existing sheet and attach this entry to it.
If not found then a new sheet will be
created.

Date

Sheet.End Date The ending date of the expense sheet. Date

Sheet.Description The sheet description. Text (255 chars max)

Sheet.Notes Any extra notes entered for the sheet. Text (2000 chars max)

-o-
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Group CSV Format
Group Fields

Field Description Format

Name Group name. If this field is present in the CSV data then a value
is required, and is always required when adding new groups.

Text (80 chars
max)

ID Group ID. This field is not required, but if present and the value is
not blank then it must be unique for all groups.

Text (80 chars
max)

Descri
ption

A description of this group. Text (255 chars
max)

Status Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Type The type of group this is, where P = permission group, R =
reporting group and C = crew.  If a group is more than one type
then each type will be separated by a carriage return (also called
a "hard" carriage return in Excel, entered using ALT+ENTER). 
When importing into Pacific Timesheet you can separate values
with a  "hard" carriage return,  or you can use the semi-colon
character ';'.  Note that reporting group and crew can be renamed
on the System > General > Terminology page, but the values in
the CSV file, P, R and C, do not change.

Text

Emplo
yees

The list of employees that are members of this group. Multiple
employees have each value separated by a carriage return (also
called a "hard" carriage return in Excel, entered using
ALT+ENTER). The names can be in the form of a login name,
employee ID, or full name (either "first last" or "last, first" is
accepted).

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text
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Notes Notes about this group. Text (2000
chars max)

-o-
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Pay Rates CSV Format
Pay Rates Fields

Field Description Format

Object The name of primary object that rates
depend on, for example "Employee". This is
optional if the Object ID field is supplied.

Text (80 chars max)

Object ID The ID of the primary object the rates
depend on, for example "222-99-5555".
This is optional if the Object field is
supplied.

Text (80 chars max)

Subobject The name of exceptioin object that rates
depend on, for example "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID is
optional if you are setting the default rate
for the object.

Text (80 chars max)

Subobject ID The ID of the exception object the rates
depend on, for example "Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default
rate for the object.

Text (80 chars max)

Pay Rate The rate for this object/subobject. The rate
can be either a numeric value, or the name
of a rate as defined in the System >  Pay
Rate Options page.

Number/Text

-o-
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Project CSV Format
Project Fields

Field Description Format

Name Project name. If this field is present in the CSV data then a value
is required, and is always required when adding new projects.

Text (80 chars
max)

ID Project ID. This field is not required, but if present and the value
is not blank then it must be unique for all projects.

Text (80 chars
max)

Descript
ion

A description of this project. Text (255
chars max)

Status Project status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Planned
Start
Date

Planned project start date. Date

Planned
Finished
Date

Planned project finish or end date. Date

Planned
Work

Planned number of hours to complete this project. Number

Actual
Start
Date

Actual project start date. Date

Actual
Finished
Date

Actual project finish or end date. Date

Permissi
ons

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text
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Notes Notes about this project. Text (2000
chars max)

-o-
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Project Dashboard CSV Format
Project Dashboard Fields

You can import and export the configuration of your project dashboards very easily using
the CSV format specified here.

Note: When importing you can specify whether to add/update records to a project
dashboard, or to set the list of records to match exactly what is in the import file.  To do
this you use an import file directive of the form:

#project-dashboard:update

or

#project-dashboard:set

The directive must be the first line of the import file and must be the only text on that
line.  The import file header should immediately follow it.

When importing new dashboard items the Actual Work field will be updated for each new
item.  This can be time consuming for large systems so you may want to wait to do your
project dashboard imports during off-peak times if you have large import files (more than
100 records).

The following fields can be exported/imported:

Field Description Format

Position The position or row number of the
dashboard item, from 1.  This is optional
for importing - if you omit this column
then the position of each item will be
automatically computed based on the
order of the records in the import file.

Integer (from 1)

Project The name of the project for this
dashboard item. When importing
dashboard records either this or the
Project.ID value is required.

Text (80 chars max)

Project.ID The ID of the project for this dashboard
item. When importing dashboard records
either this or the Project (name) value is
required.

Text (80 chars max)

Task Group The name of the task group for this
dashboard item. Either this or the Task
Group.ID can be specified. Both Task
Group and Task are optional, but both
WBS levels cannot be blank (a
dashboard item cannot have a blank task
group and task).

Text (80 chars max)

Task Group.ID The ID of the task group for this
dashboard item. Either this or the Task
Group (name) can be specified. Both
Task Group and Task are optional, but
both WBS levels cannot be blank (a
dashboard item cannot have a blank task
group and task).

Text (80 chars max)
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Task The name of the task for this dashboard
item. Either this or the Task.ID can be
specified. Both Task Group and Task are
optional, but both WBS levels cannot be
blank (a dashboard item cannot have a
blank task group and task).

Text (80 chars max)

Task.ID The ID of the task for this dashboard
item. Either this or the Task (name) can
be specified. Both Task Group and Task
are optional, but both WBS levels cannot
be blank (a dashboard item cannot have
a blank task group and task).

Text (80 chars max)

Status The status or progress of this dashboard
item, e.g. "Started", or "On Hold". The
values for this can be configured by
editing any project dashboard and
clicking the "Options" link on that page.

Text (80 chars max)

Planned Start
Date

Planned dashboard item start date. Date

Planned Finished
Date

Planned dashboard item finish or end
date.

Date

Planned Work Planned number of hours/days to
complete this dashboard item. You can
specify whether the units are hours or
days from the Projects > Project Options
page.

Number

Actual Start Date Actual dashboard item start date. Date

Actual Finished
Date

Actual dashboard item finish or end date. Date

Actual Work The actual number of hours/days
recorded against this dashboard item.
This value is exported, but ignored on
import as the system automatically
updates this value nightly (or when you
choose 'Refresh' from the tools menu on
a project dashboard). You can specify
whether the units are hours or days from
the Projects > Project Options page.

Note that when importing a new
dashboard item this value will be
updated immediately.

Number

Percent
Complete

If Planned Work is non-blank and
non-zero then this value is computed as
100 * (Actual Work) / (Planned Work).
This value is exported, but ignored on
import as the system automatically
computes this value.

Number

Notes Notes about this dashboard item. Text (2000 chars max)

-o-
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Project Group CSV Format
Project Group Fields

Field Description Format

Name Project Group name. If this field is present in the CSV data then a
value is required, and is always required when adding new project
groups.

Text (80 chars
max)

ID Project Group ID. This field is not required, but if present and the
value is not blank then it must be unique for all project groups.

Text (80 chars
max)

Descri
ption

A description of this project group. Text (255 chars
max)

Status Project Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this project group. Text (2000
chars max)

-o-
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Task CSV Format
Task Fields

Field Description Format

Name Task name. If this field is present in the CSV data then a value is
required, and is always required when adding new tasks.

Text (80 chars
max)

ID Task ID. This field is not required, but if present and the value is
not blank then it must be unique for all tasks.

Text (80 chars
max)

Descript
ion

A description of this task. Text (255
chars max)

Status Task status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Planned
Start
Date

Planned project start date. Date

Planned
Finished
Date

Planned project finish or end date. Date

Planned
Estimat
ed
Work

Planned number of hours to complete this project. Number

Actual
Start
Date

Actual project start date. Date

Actual
Finished
Date

Actual project finish or end date. Date
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Permiss
ions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this task. Text (2000
chars max)

-o-
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Task Group CSV Format
Task Group Fields

Field Description Format

Name Task Group name. If this field is present in the CSV data then a
value is required, and is always required when adding new task
groups.

Text (80 chars
max)

ID Task Group ID. This field is not required, but if present and the
value is not blank then it must be unique for all task groups.

Text (80 chars
max)

Descri
ption

A description of this task group. Text (255 chars
max)

Status Task Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this task group. Text (2000
chars max)

-o-
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Timesheet CSV Format
Timesheet Fields

Timesheet data can be both exported and imported. The following fields are supported:

Note: When importing, the header field name must match the value below exactly in
order to be recognized.

Note: When exporting, you can combine fields using custom export field expressions.
See the Expression Fields topic for more information.

Field Description Format

Employee Employee login name. This field or
Employee.ID is required when importing.

Text

Employee.ID Employee ID. This field or Employee is
required when importing.

Text

Employee.Ty
pe

The type of employee, for example
Non-exempt or Exempt.

Text

Start Time entry start date and time. This field or
Date is required.  

Note that if the record is for a punch-out
you should specify the special character '*'
(without the quotes).  This will close any
current punch-in (or do nothing if not
punched in).  A punch-out record will not
update any other entry properites, such as
Project, etc. - any values in the punch-out
record will be ignored.

Date-Time

Date Time entry start date. You would use this
field instead of Start if you do not care
about the time of day of the time entry.
This field or Start is required.

Date

Finish Time entry finish date and time. This field
or Hours is required if adding a new time
entry.  

Note that if the record is for a punch-in you
should specify the special character '*'
(without the quotes). This will close any
previous punch-in, and start a new
punch-in.

Date-Time

Hours Time entry hours. This or Finish is required
if adding a new time entry.

Number

Type Time entry type, either Work or Leave. Text

Work Work hours. Number

Leave Leave hours. Number

Pay Code Pay code name or ID. Text

Pay Code.ID Pay code ID. Text

Reporting
Group

Reporting group name. Text
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Reporting
Group.ID

Reporting group ID. Text

Customer Customer name. Text

Customer.ID Customer ID. Text

Project
Group

Project group name. Text

Project
Group.ID

Project group ID. Text

Project Project name. Text

Project.ID Project ID. Text

Task Group Task group name. Text

Task
Group.ID

Task group ID. Text

Task Task name. Text

Task.ID Task ID. Text

Bill Rate Bill rate for this time entry. Number

Bill Amount Bill amount for this time entry, which is Bill
Rate x Hours.

Number

Pay Rate Pay rate for this time entry. Number

Pay Amount Pay amount for this time entry, which is
Pay Rate x Hours.

Number

Notes Time entry notes. Text (2000 chars max)

Regular
Time

Regular time hours. Number

Over Time Over time hours. Number

Double Time Double time hours. Number

Flex Time Flex-time hours. Number

Submitted Indicates whether this time entry has been
submitted (locked). Possible values are Yes
or No.

Text

Submit Date The date this time entry was submitted. Date

Submitted
By

Who submitted this time entry. Text

Approved Indicates whether this time entry has been
approved. Possible values are Yes or No.

Text

Approval
Date

The date this time entry was approved. Date

Approved By Who approved this time entry. Approver

Rejected Indicates whether this time entry has been
rejected by an approver. Possible values
are Yes or No.

Text

Reject Date The date this time entry was rejected. Date

Rejected By Who rejected this time entry. Text

Importing Timesheets

Importing timesheets is something we usually like to help customers with as it requires
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careful planning, including backing up the database beforehand so you can revert it if for
some reason the data is wrong. Typically, to get started, you would export a representative
set of timesheets and save it as a CSV file (from the Timesheets tab), then trim out the
unneeded columns. This can then be used as a template. Here are some important things to
know about the import data format:

1. You can use either the name of objects (e.g. the employee login name, the group name,
etc.), or the ID of the object, e.g. the employee id or the group id. 

2. At a minimum, you'll want the Employee (login name), Start and Hours columns. The
Start field needs the time of day if there is more than one time entry for a single day. This
is because the timesheet import will try to update an existing time entry, so if you have two
records for the same employee with the same start, the second one will just update the first
one. This avoids the danger of accidentally re-importing the same file twice and getting
duplicate time entries.

3. The date, time and number formats are in the locale of the person doing the import. Also,
the Start etc. fields are assumed to be in the time zone of the person doing the import. So if
you are importing data for people in time zones scattered around the globe you might have
to make some adjustments.

4. For time off or leave, you'll want to specify the appropriate pay code name or pay code
ID.

5. To mark the timesheet as locked or submitted, add the Submitted field or column, and
specify Yes for each timesheet entry. 

-o-

 



p257

© 2000-2023, Pacific Timesheet

Data Archival
Data Archival

Time entries, asset entries and other data that are entered in large amounts will generally
be kept by Pacific Timesheet for up to 7 years before being moved into archival storage. For
performance reasons, however, large systems that have over several million entries may
archive data sooner, such as after 6 or 5 years. Generally this will be transparent to you,
but you may see a message when running reports for date ranges several years back, such
as:

Data prior to 1/1/2009 has been archived...

In these cases you can still report on archived data by clicking the provided link to the
"Archive Settings" dialog and temporarily altering the report to target the archived data
table. This allows you to run all of your reports on older archived data for auditing purposes,
etc. 

Note that archived data older than 7 years may be purged (deleted) from the system in
order to prevent using up your allotted disk storage. You can contact your account
representative about extending this if you need to preserve archive data beyond 7 years.

-o-
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FAQ - Frequently Asked Questions
Administrative Topics

Q: How do I allow managers to edit their worker's timesheets? 

A: By default a manager cannot edit other employee timesheets, even if they are an
approver for them. To allow a manager to edit other employee timesheets do the following: 

1. Make sure the manager, let's call her "Sarah Manager", has either the Manager
permission level, or a permission level that allows timesheet editing. You can check an
employee's permission level from the Employees tab. You can check whether a
permission level has the timesheet editing permission from the System > Security
page. 

2. Go to the Employees > Groups page and create a new group. 
3. Assign all of the employees whose timesheets Sarah Manager needs to edit to this

group. 
4. Edit the permissions for this group and add Sarah Manager to the list as a Manager (or

any other appropriate permission level that allows timesheet editing).

When Sarah Manager logs into the application she should see a Timesheets tab, and should
be able to list and edit timesheets for all the employees in the new group.

-o-
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Appendix
 Locale Codes
 Time Zone Codes
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Locale Codes
ISO locale (language_country) codes:

Value Description
sq_AL Albanian (Albania)
ar_DZ Arabic (Algeria)
ar_BH Arabic (Bahrain)
ar_EG Arabic (Egypt)
ar_IQ Arabic (Iraq)
ar_JO Arabic (Jordan)
ar_KW Arabic (Kuwait)
ar_LB Arabic (Lebanon)
ar_LY Arabic (Libya)
ar_MA Arabic (Morocco)
ar_OM Arabic (Oman)
ar_QA Arabic (Qatar)
ar_SA Arabic (Saudi Arabia)
ar_SD Arabic (Sudan)
ar_SY Arabic (Syria)
ar_TN Arabic (Tunisia)
ar_AE Arabic (United Arab Emirates)
ar_YE Arabic (Yemen)
be_BY Belarusian (Belarus)
bg_BG Bulgarian (Bulgaria)
ca_ES Catalan (Spain)
zh_CN Chinese (China)
zh_HK Chinese (Hong Kong)
zh_TW Chinese (Taiwan)
hr_HR Croatian (Croatia)
cs_CZ Czech (Czech Republic)
da_DK Danish (Denmark)
nl_BE Dutch (Belgium)
nl_NL Dutch (Netherlands)
en_AU English (Australia)
en_CA English (Canada)
en_IN English (India)
en_IE English (Ireland)
en_NZ English (New Zealand)
en_ZA English (South Africa)
en_GB English (United Kingdom)
en_US English (United States)
et_EE Estonian (Estonia)
fi_FI Finnish (Finland)
fr_BE French (Belgium)
fr_CA French (Canada)
fr_FR French (France)
fr_LU French (Luxembourg)
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fr_CH French (Switzerland)
de_AT German (Austria)
de_DE German (Germany)
de_LU German (Luxembourg)
de_CH German (Switzerland)
el_GR Greek (Greece)
iw_IL Hebrew (Israel)
hi_IN Hindi (India)
hu_HU Hungarian (Hungary)
is_IS Icelandic (Iceland)
it_IT Italian (Italy)
it_CH Italian (Switzerland)
ja_JP Japanese (Japan)
ko_KR Korean (South Korea)
lv_LV Latvian (Latvia)
lt_LT Lithuanian (Lithuania)
mk_MK Macedonian (Macedonia)
no_NO Norwegian (Norway)
pl_PL Polish (Poland)
pt_BR Portuguese (Brazil)
pt_PT Portuguese (Portugal)
ro_RO Romanian (Romania)
ru_RU Russian (Russia)
sk_SK Slovak (Slovakia)
sl_SI Slovenian (Slovenia)
es_AR Spanish (Argentina)
es_BO Spanish (Bolivia)
es_CL Spanish (Chile)
es_CO Spanish (Colombia)
es_CR Spanish (Costa Rica)
es_DO Spanish (Dominican Republic)
es_EC Spanish (Ecuador)
es_SV Spanish (El Salvador)
es_GT Spanish (Guatemala)
es_HN Spanish (Honduras)
es_MX Spanish (Mexico)
es_NI Spanish (Nicaragua)
es_PA Spanish (Panama)
es_PY Spanish (Paraguay)
es_PE Spanish (Peru)
es_PR Spanish (Puerto Rico)
es_ES Spanish (Spain)
es_UY Spanish (Uruguay)
es_VE Spanish (Venezuela)
sv_SE Swedish (Sweden)
th_TH Thai (Thailand)
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th_TH Thai (Thailand,TH)
tr_TR Turkish (Turkey)
uk_UA Ukrainian (Ukraine)
vi_VN Vietnamese (Vietnam)

-o-
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Time Zone Codes
Standard (Olson ID) time zones codes:

Value Description
MIT (GMT-11:00) International Date Line W.
Pacific/Apia (GMT-11:00) Midway Island, Samoa
Pacific/Honolulu (GMT-10:00) Hawaii
America/Anchorage (GMT-09:00) Alaska
America/Los_Angeles (GMT-08:00) Pacific Time
America/Denver (GMT-07:00) Mountain Time
America/Phoenix (GMT-07:00) Arizona
America/Chicago (GMT-06:00) Central Time
America/Costa_Rica (GMT-06:00) Central America
America/Mexico_City (GMT-06:00) Mexico City
America/Tegucigalpa (GMT-06:00) La Paz
America/Winnipeg (GMT-06:00) Saskatchewan
America/Bogota (GMT-05:00) Bogota
America/Indianapolis (GMT-05:00) Indiana (East)
America/Montreal (GMT-05:00) Atlantic Time (Canada)
America/New_York (GMT-05:00) Eastern Time
America/Caracas (GMT-04:00) Caracas, La Paz
America/Santiago (GMT-04:00) Santiago
America/Thule (GMT-04:00) Greenland
America/St_Johns (GMT-03:30) Newfoundland
America/Buenos_Aires (GMT-03:00) Buenos Aires
America/Sao_Paulo (GMT-03:00) Brasilia
Atlantic/South_Georgia (GMT-02:00) Mid-Atlantic
Atlantic/Azores (GMT-01:00) Azores
Atlantic/Cape_Verde (GMT-01:00) Cape Verde Is.
Africa/Casablanca (GMT+00:00) Casablanca, Monrovia
Europe/Dublin (GMT+00:00) Greenwich Mean Time
Africa/Lagos (GMT+01:00) West Central Africa
Europe/Amsterdam (GMT+01:00) Amsterdam, Rome
Europe/Belgrade (GMT+01:00) Belgrade, Prague
Europe/Brussels (GMT+01:00) Brussels, Madrid
Europe/Warsaw (GMT+01:00) Sarajevo, Warsaw
Africa/Cairo (GMT+02:00) Cairo
Africa/Harare (GMT+02:00) Harare, Pretoria
Asia/Jerusalem (GMT+02:00) Jerusalem
Europe/Athens (GMT+02:00) Athens, Istanbul
Europe/Bucharest (GMT+02:00) Bucharest
Europe/Helsinki (GMT+02:00) Helsinki
Africa/Nairobi (GMT+03:00) Nairobi
Asia/Baghdad (GMT+03:00) Baghdad
Asia/Kuwait (GMT+03:00) Kuwait, Riyadh
Europe/Moscow (GMT+03:00) Moscow, St. Petersburg
Asia/Tehran (GMT+03:30) Tehran
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Asia/Baku (GMT+04:00) Baku, Tbilisi
Asia/Dubai (GMT+04:00) Abu Dhabi
Asia/Kabul (GMT+04:30) Kabul
Asia/Karachi (GMT+05:00) Islamabad, Karachi
Asia/Yekaterinburg (GMT+05:00) Ekaterinburg
Asia/Calcutta (GMT+05:30) Chennai, Kolkata
Asia/Katmandu (GMT+05:45) Kathmandu
Asia/Almaty (GMT+06:00) Almaty
Asia/Colombo (GMT+06:00) Sri Jayawardenepura
Asia/Dhaka (GMT+06:00) Astana, Dhaka
Asia/Rangoon (GMT+06:30) Rangoon
Asia/Bangkok (GMT+07:00) Bangkok, Hanoi
Asia/Krasnoyarsk (GMT+07:00) Krasnoyarsk
Asia/Hong_Kong (GMT+08:00) Beijing, Hong Kong
Asia/Irkutsk (GMT+08:00) Irkutsk
Asia/Kuala_Lumpur (GMT+08:00) Kuala Lumpur, Singapore
Asia/Taipei (GMT+08:00) Taipei
Australia/Perth (GMT+08:00) Perth
Asia/Seoul (GMT+09:00) Seoul
Asia/Tokyo (GMT+09:00) Osaka, Tokyo
Asia/Yakutsk (GMT+09:00) Yakutsk
Australia/Adelaide (GMT+09:30) Adelaide
Asia/Vladivostok (GMT+10:00) Vladivostok
Australia/Brisbane (GMT+10:00) Brisbane
Australia/Hobart (GMT+10:00) Hobart
Australia/Sydney (GMT+10:00) Canberra, Sydney
Pacific/Guam (GMT+10:00) Guam
Asia/Magadan (GMT+11:00) Magadan, Solomon Is.
Pacific/Auckland (GMT+12:00) Auckland
Pacific/Fiji (GMT+12:00) Fiji, Kamchatka
Pacific/Tongatapu (GMT+13:00) Nuku'alofa

-o-
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